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 Product Support

Product Support

If you need help with any aspect of your GE Digital Energy product, you can: 

• Access the GE Digital Energy Web site

• Search the GE Technical Support library

• Contact Technical Support

Access the GE Digital Energy Web site

The GE Digital Energy Web site provides fast access to technical information, such as 
manuals, release notes and knowledge base topics. 
Visit us on the Web at: http://www.gedigitalenergy.com/ 

Search GE Digital Energy technical support library 

This site serves as a document repository for post-sales requests. To get access to the 
Technical Support Web site, go to:
http://site.ge-energy.com/prod_serv/products/substation_automation/en/
tech_support_login.htm

Contact GE Digital Energy technical support  

GE Digital Energy Technical Support is open 24 hours a day, seven days a week for you to 
talk directly to a GE representative.
In the U.S. and Canada, call toll-free: 1 800-547-8629
International customers, please call: + 1 905-927-7070
Or e-mail to multilin.tech@ge.com

http://www.gedigitalenergy.com/
http://site.ge-energy.com/prod_serv/products/substation_automation/en/tech_support_login.htm
mailto:multilin.tech@ge.com
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PRODUCT SUPPORT

Have the following information ready to give to Customer Service:

• Ship to address (the address that the product is to be returned to)

• Bill to address (the address that the invoice is to be sent to)

• Contact name 

• Contact phone number 

• Contact fax number 

• Contact e-mail address 

• Product number / serial number

• Description of problem

The Customer Service centre provides you with a case number for your reference.

Product returns

A Return Merchandise Authorization (RMA) number must accompany all equipment being 
returned for repair, servicing, or for any other reason. Before you return a product, please 
contact GE Digital Energy to obtain an RMA number and instructions for return shipments. 
You are sent the RMA number and RMA documents via fax or e-mail. Once you receive the 
RMA documents, attach them to the outside of the shipping package and ship to GE Digital 
Energy.

NOTE

Product returns are not accepted unless accompanied by the Return Merchandise 
Authorization number.

Upgrade your D20MX processor firmware

The firmware of your D20MX Substation Controller can be upgraded to provide the latest 
functionality and improvements. 
Go to the D20MX Substation Controller web page at http://www.gedigitalenergy.com/app/
ViewFiles.aspx?prod=d20mx&type=7 to download the upgrade software.
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 About this Document

About this Document

Purpose

This manual provides information about installing, setting up, using and maintaining your 
D20MXTM Processor. This manual does not provide any procedures for configuring the 
software of the D20MX. 

Intended audience 

This manual is intended for use by field technicians and maintenance personnel who are 
responsible for the installation, upgrade, wiring and maintenance of SCADA equipment. 
This manual assumes that the user is experienced in: 

• Electrical utility applications

• Electrical wiring and safety procedures

• Related other manufacturers’ products, such as protective relays and 
communications equipment

Additional documentation 

For the most current version of the D20MX Hardware User's Manual, please download a 
copy from: http://www.gedigitalenergy.com/app/ViewFiles.aspx?prod=d20mx&type=3
For further information about the D20MX, refer to the following documents.

• SGConfigTM Online Help

• D20/D200 Installation and Operation Guide, 994-0078

• Application Configuration Guides and User Guides, available on the D20MX 
Documentation CD (GE part number 588-0075) or extracted zip file.

http://www.gedigitalenergy.com/app/ViewFiles.aspx?prod=d20mx&type=3
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How to use this manual 

This manual describes how to install the D20MX and get it up and running for the first time.
Procedures are provided for all component options available for the D20MX. The 
components included in your D20MX depend on what was ordered for your substation 
application. 
The software-related procedures in this manual are based on using a computer running 
Windows® 7. Some steps and dialog boxes may vary slightly if you are using another 
version of Windows.

Document conventions

The following typographic conventions are used throughout this manual:
Bold face is used for:

• Names of software program menus, editors, and dialog boxes; also for the names of 
menu commands, keyboard keys, icons and desktop shortcuts, and buttons and fields 
in editors and dialog boxes

• Names of hardware components

• User input that must be typed exactly

Italic face is used for:

• Emphasis

• Cross-references to sections, figures and tables within this manual and for titles of 
other documents

• File and directory names; examples of directory paths are generally given in the 
Windows format

• Placeholders for user input that is specific to the user. May also include angle brackets 
around the placeholder if the placeholder is already in italic text. For example, 
c:\<product>\product.def

• References to a parameter or field value shown
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Safety words and definitions

Before attempting to install or use the device, review all safety indicators in this document 
to help prevent injury, equipment damage or downtime.
The following safety and equipment symbols are used in this document:

Indicates a hazardous situation which, if not avoided, results in death or serious injury. 

Indicates a hazardous situation which, if not avoided, could result in death or serious 
injury. 

Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

Indicates practices that are not related to personal injury.
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Chapter 1: Before You Start

Before You Start

The D20MX Substation Gateway is a specialized computing platform which executes 
communications and energy management applications for monitoring and control of 
electrical substations. The D20MX is capable of consolidating data from multiple slave 
devices connected through communication channels (DCA: Data Collection Applications) 
and D20 Input / Output Modules in a single database. The D20MX can execute local logic, 
aggregate data, process data through one of multiple applications (DTA: Data Translation 
Applications) and report data upstream to master stations through different server 
protocols (DPA: Data Processing Applications). 
The new D20MX processor card is a pin-for-pin compatible replacement for all generations 
of the D20 SBC, providing the latest revisions of common D20 applications and 
performance enhancements to support NERC-compliant Cyber security. 
Before you begin installing and using the D20MX, review the information in this chapter, 
including the following topics:

• Safety precautions

• Regulatory compliance information 

• Product overview

• Product specifications

• Storage recommendations

Read and thoroughly understand this manual before installing and operating the unit. 
Save these instructions for later use and reference.

WARNING! Failure to observe the instructions in this manual may result in death or 
serious injury.

Safety precautions 

Follow all safety precautions and instructions in this manual.
Only qualified personnel should work on the D20MX. Maintenance personnel should be 
familiar with the technology and the hazards associated with electrical equipment.

• Never work alone.
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• Before performing visual inspections, tests, or maintenance on this equipment, isolate 
or disconnect all hazardous live circuits and sources of electric power. Assume that all 
circuits are live until they have been completely de-energized, tested, and tagged. Pay 
particular attention to the design of the power system. Consider all sources of power, 
including the possibility of back feed.

• Turn off all power supplying the equipment in which the D20MX is to be installed 
before installing and wiring the D20MX.

• Operate only from the power source specified on the installed power supply module.

• Beware of potential hazards and wear personal protective equipment.

• The successful operation of this equipment depends upon proper handling, 
installation, and operation. Neglecting fundamental installation requirements may 
lead to personal injury as well as damage to electrical equipment or other property.

• All AC voltage terminals are protected from accidental contact by a mechanical safety 
shield. 

• All electronic components within the D20MX are susceptible to damage from 
electrostatic discharge. To prevent damage when handling this product use approved 
static control procedures.

• Hazardous voltages can cause shock, burns or death. To prevent exposure to 
hazardous voltages, disconnect and lock out all power sources before servicing and 
removing components.

• If the D20MX is used in a manner not specified in this manual, the protection provided 
by the equipment may be impaired.

• Changes or modifications made to the unit not authorized by GE Digital Energy could 
void the warranty.

Warning symbols 
Table 1 explains the meaning of warning symbols that may appear on the D20MX.

Table 1: Warning symbols  

Symbol Description

The relevant circuit is direct current.

The relevant circuit is alternating current.

Caution:   Refer to the documentation for important operation and 
maintenance instructions. Failure to take or avoid specified actions could 
result in loss of data or physical damage. 

Warning:   Dangerous voltage constituting risk of electric shock is present 
within the unit. Failure to take or avoid specified actions could result in 
physical harm to the user. 

Earth/Ground Terminal

Protective Ground Terminal

Caution: Hot Surface

!
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Product overview

The D20 is a standalone remote terminal unit (RTU). It consists of a D20MX processor 
board, power supply, optional termination panels, and optional communications 
equipment in a 3U tall, 19-inch wide chassis. These components, combined with software 
applications running on the D20MX, form the D20 RTU System.
The D20 acts as a data concentrator and central processor. Field data gathered through 
the peripheral modules and external Intelligent Electronic Devices (IEDs) are stored in the 
system database and can be accessed by the application programs loaded on the D20.

Product design
The D20 design has horizontally mounted processor boards, with multiple boards in some 
versions.
The D20 is available in a Kit form, for self-assembly, and as factory-assembled RTUs.
Peripheral I/O boards operate independently of the main chassis and D20MX processor 
board. This means that you can:

• Use a D20 without direct connection to peripheral boards so that it acts as a master 
data concentrator to other RTUs. 

• Hot-swap the peripherals without powering down the main processor. For information 
on peripheral modules, see the D20/D200 Installation and Operations Guide (part 
number 994-0078); see section: Connections and Configuration.

Assembling a D20
Many add-on options are available for the D20 systems, to provide different operational 
performance and functions. Typically, the D20 systems consist of a Main Chassis with 
required Peripheral I/O boards.

Other components
To complete a basic D20 device, several other components are required:

• Peripheral I/O modules

• D.20 Link for communication between the main board and the peripherals

• Interposing Relay Panels, the need for which depends upon the load characteristics of 
the device that is controlled by the D20K or D20C control peripherals. If this rating 
exceeds the contact rating of the D20K or D20C control peripheral boards, then an 
Interposing Relay Panel is required. See “Interposing relays” on page 56.

When using bit-based synchronous protocols a Universal Protocol Converter (UPC) board is 
required to convert from byte to bit and back. The D20 communicates asynchronously 
over its serial ports.

NOTE

The jumper settings on the UPC are protocol-specific. See “Universal Protocol Converter” 
on page 57.

Redundant system configuration
If you are building a redundant system, you need additional cables to link the active and 
standby units. See “D20 Gateway system redundancy” on page 63.
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D20MX processor 

The D20MX is a single board computer built around a 667 MHz embedded PowerQUICC II 
Pro processor. The D20MX supports open standard cyber security features that allow 
interoperability in NERC CIP environments and introduces compliance to IEC standards; 
refer to Appendix A, Standards & Protection for the complete listing.
The D20MX can be retrofitted into any of the following three chassis:

• A D20 3U single-node horizontal slot VME chassis. 

• A D20 3U horizontal slot non-VME chassis. In a single-node VME chassis, this one 
processor module replaces the previous D20 M, M++, ME, and MEII CPU cards.

Due to aging printed circuit board assembly and mechanical constraints, only certain 
chassis from 2002 and onward can be used with a D20MX. This comprises the following 
chassis:

• D20 VME chassis 500-0280 Release 08 or higher, 

• D20 Non-VME chassis 500-0305 Release 18 or higher 

A solid partition between the Main processor bay and accessory bay prevents access to 
the harness from the fiber card to D20MX card (only applicable to the 526-3005LF fiber 
card version).

Security
The D20MX provides the following new security improvements over its predecessors:

• Centralized user authentication and authorization (RADIUS), including integration with 
Microsoft Servers using NPS

• Role Based Access Control (RBAC) keeping operator and engineering activities 
separated, logged and simple

• NERC compliant passwords, with strong complexity rules and one-way encrypted

• Full auditing including Syslog integration to enterprise systems 

• SFTP for secure network-based firmware upgrades and configuration file transfers 

• SSH for secure network access to WESMAINT II+. and the LogicLinx Executor. Refer to 
Appendix E: “Secure Connection for LogicLinx” on page 181 for details on securing 
network access to the LogicLinx Executor.

To take advantage of these improvements, refer to the WESMAINT II+ for the D20MX 
Configuration Guide (B014-1NCG) for details of these security features of the D20MX.

CyberArk A plug-in available from CyberArk Software Ltd. enables the D20MX to be integrated with 
the CyberArk Privileged Identity Management (PIM) Suite. In addition to centralized user 
authentication and authorization, integration with CyberArk, PIM provides a one-time 
password model for the D20MX. 
Contact CyberArk (http://cyberark.com) for details.

D20MX applications 
Table 2 lists the applications included in the D20MX firmware. 

NOTE

*   An Application ID containing an “N” (e.g., A009N) signifies a unique application definition 
for the D20MX. 
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†   The D20MX version of the application is based on this D20 classic application version. 
However, the D20MX version is not identical to the D20 classic version due to minor 
changes to improve the robustness and security of the original application.

‡   The version of B009 in SAN0002 is actually based on D20 classic application version 401 
but modified to be compatible with the version 310 application definition version.

Ф   The version of B021 in SAN002 is actually based on D20 classic application version 991 
but modified to be compatible with the version 912 application definition version.

Table 2:  D20MX applications

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description

Common Application Definitions

001 A009N 805 PG&E DPA for D20MX Pacific Gas and Electric (PG&E) data-processing 
application (DPA) for remote terminal units 
(RTUs).

001 A017N 131 Distributed Network 
Protocol V1.00 DCA for 
D20MX

Distributed Network 

Protocol (DNP) V1.0 Data Link Application. 
Required by the Quantum Meter Scanner DCA.

001 A018 120 Quantum Meter Scanner 
DCA

The Quantum Meter Scanner DCA obtains data 
from one or more Quantum Meters via the DNP 
interface. 

001 A023N 423 CDC Type I DPA for D20MX The CDC Type I DPA emulates a CDC Type I RTU

A026-1 322 Communication 
Watchdog DTA

Reports on the state of communications 
between the RTU and a remote device (Data 
Translation Application). 

A027N 832 SOE Logger DTA for D20MX The Sequence-of-Events Logger DTA processes 
sequence of events (SOEs) from any sub-set of 
the system digital input and/or analog input 
points.

A030 300 Accumulator Freeze DTA Detects system status point changes and 
system accumulator point freezes.

001 A033-5N 211 TEJAS V DPA for D20MX Emulates a remote terminal unit utilizing the 
(Valmet/Metso/Telvent) TEJAS V 
communication protocol.

A035 211 Analog Reference DTA Monitors analog input points and provides the 
system database with pseudo analog values 
that represent either correctly functioning 
analog input hardware (good reference value), 
or failed analog input hardware (bad reference 
value).

001 A036N 421 ProLogic Executor DTA for 
D20MX

Provides user programmable soft logic 
automation functionality.

001 A041-1 116 Proportional Integral 
Derivative Control DTA               

The Proportional, Integral and Derivative (PID) 
DTA uses the generally-accepted industry 
standard for control of closed loop processes. 

A048 210 Status Combination DTA Provides one ore more DI points, each of which 
provides an event-driven logical OR of a set of 
mapped system DI points.

A059-0N 911 Modbus DCA for D20MX Acts as a data concentrator for one or more 
Sub-Remote Units (SRUs) using the MODBUS 
communication protocol (RTU & ASCII modes).

A064N 110 Tap Position Indication 
DTA

 Translates a digital input point from a range of 
status points into an analog input value.

A065N 202 CL&P DTA The China Light and Power DTA performs 
miscellaneous functions as follows: Julian day/
year download, Raise/lower operations, RTS 
time synchronization.

A074N 120 PML 3710 DCA Enables the D20MX to communicate with PML 
3710 ACM power meters.
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A068N 311 Modbus DPA Capable of communicating with one or more 
master stations using the MODBUS protocol 
(RTU & ASCII modes).

A078N 610 SEL Gateway DCA for 
D20MX

A sub-master within a SCADA system, 
controlling SEL relay equipment using SEL's 
ASCII character-based relay protocol

A083-0 342 Calculator DTA Convenient and flexible soft logic utility that 
can perform applications such as substation 
level interlocking, feeder interlocking, and 
converting digital inputs to control outputs for 
driving a map board

A088-0 203 Substation Maintenance 
DTA 

Allows status and analog input values to be 
suppressed for maintenance purposes.

A098-0N 701 Courier DCA Enables communication with Courier SRUs 
(predominantly GEC K-Bus protection relays).

A101-0N 906 IEC 870-5-101 DPA for 
D20MX

Communicate with one or more hosts using the 
IEC 60870-5-101/104 (T101) protocol. Has the 
ability to function as several distinct IEC 60870-
5-101/104 RTUs. Supports the unbalanced 
version of the data link.

A104-0N 124 Alarm Grouping DTA for 
the D20MX

Provides DI points each representing a group 
alarm. The group alarm is generated when the 
number of DI points in the alarm state exceed 
the group threshold value.

001 A113N 301 PSR DCA for D20MX Programmable Synchrocheck Relay (PSR) DCA 
acts as a data concentrator for several remote 
PSRs. The DCA and remote PSRs function as a 
remote synchronous closure controller. 

A118 103 Failover DTA Allows configurable combination of control 
requests to result in a failover or switchover of 
a redundant system.

A121-0 200 Automatic Frequency 
Selection DTA

Provides AI points each derived from an 
Automatic Selection Method (ASM). An ASM 
selects the highest priority valid frequency 
measurement from a group of AI points.

A123-0 111 NGC General DTA Generates control lockout indications, digital 
input suppression or unsupression indications, 
and control active indications.

A131-0 132 MODBUS TCP/IP DCA Provides an interface to Sub-Remote Units 
(SRUs) using the MODBUS protocol over the 
TCP/IP communication layer.

A135-0 110 MODBUS TCP/IP DPA Provides communications with one or more 
master station using the MODBUS protocol 
over TCP/IP communication layer.

A161-0 302 Secondary Master Trip/
Close DTA

Translates control requests into conventional 
trip/close operations in conjunction with 
secondary control operations to be used as a 
Secondary Master Trip or Close.

A162-0 146 Internet Statistics Display Utilizes the WESMAINT II+ application menu in 
order to display DNP/Internet protocol and IEC 
60870-5-104 statistics.

A184-0 120 General Alarm DTA Takes several alarms and groups them 
together under one General Alarm.

001 A185-0N 303 W18979 DPA for D20MX Emulates the Landis & Gyr 8979 RTU. 
Communicates with multiple master stations, 
over redundant communication lines. 

A186-0 213 Western Power 
Distribution (WPD) DTA

Calculates power from monitored voltage, 
current, and phase angle. Also, performs time 
integrated analog averaging, relative to the top 
of the hour.

A193-0 302 Top of the Hour Analog 
Averaging DTA

Performs time integrated analog averaging, 
relative to the top of the hour.

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description
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001 A194-0N 101 Cooper 2179 DCA Monitors and controls Cooper devices using 
the Cooper 2179 protocol.

A195-0 110 Redundant I/O DTA Provides I/O point redundancy.

001 A199-0N 106 HR6000/XA-21 (DPA) for 
D20MX

Communicates with one or more hosts using 
the Harris HR6000/XA-21 protocol, emulating 
several HR6000/XA-21 LRUs. Supports multiple 
communication ports, multiple LRUs per 
communication port, and redundant porting. 

B003 751 D.20 Peripheral Link DCA The D.20 Peripheral Link is responsible for 
surveillance and control of digital and analog 
values in the D.20 I/O peripherals.

B008-1 311 System Point Database Maintains the database of system points in the 
RTU.

B012N 201 IRIG-B DCA for D20MX Provides Universal Time Coordination (UTC) 
using the IRIG-B pulse frame, as specified by 
IRIG Standard 200-04 September 2004 Edition.

B013N 560 DNP V3.00 Data Link Provides services for software applications to 
send and receive messages using the 
Distributed Network Protocol (DNP) V3.00 Data 
Link protocol and the DNP V3.00 Transport 
Functions

B014-1N 520 WESMAINT II+ for D20MX RTU maintenance facility. 

B015N 530 Bridgeman Allows applications to communicate with other 
peer applications. Automatically routing 
messages to the destination application. 
Intended to work within layered software 
architectures. Provides the routing functions of 
a network layer, but does not add a network 
layer header to outgoing messages. 

B023N 770 DNP V3.00 DCA The Distributed Network Protocol V3.00 DCA 
acts as the master to one or more remote 
devices using the DNP V3.00 protocol.

B034N 203 Redundant Monitor for 
D20MX

Monitors CCU states and initiates failover. Also, 
receives command requests to perform 
database synchronization, switchover and 
failover.

B045-0 101 D20AC WESMAINT II+ 
Display Screens

Provides D20AC WESMAINT II+ displays

B052-0N 351 DNP Internet Data Link for 
D20MX

DNP V3.00 data link over internet

B058-0N 231 IEC 870-5 Data Link for 
D20MX

FT 1.2 primary data link configuration

B060-0 210 IEC 870-5-101 DCA Acts as a master (primary) communication 
device, initiating data exchanges. It is capable 
of sending control commands to the remote 
devices, and processing data autonomously 
collected by the data link layer. 

B071-0 200 WESMAINT File Upload Uploads files via the WESMAINT port as S 
records or using ZMODEM.

B080-0 214 IEC 60870-5-103 DCA Monitors and controls devices using the IEC 
60870-5-103 protocol.

002 B082-0N 311 LogicLinx Executor WARP 
for D20MX (Ethernet 
capable)

The LogicLinx executor is responsible for 
executing PLC programs written using the 
LogicLinx PLC (IEC 1131-3 compliant) editor.

B085N 130 IEC Balanced Data Link Provides services to send and receive 
messages using the IEC 60870-5 FT 1.2 
Balanced Protocol over point-to-point links, 
with support for a dial-up modem. Works with 
one user in point-to-point configurations, or 
multiple users in dial-up configurations. 

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description
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Table 3 provides the License Group legend.

Table 3: D20MX license group

NOTE

The license group is an option in the D20MX order code. Refer to Table 10 and Table 11 for 
details. Ordering a D20MX with a particular license group option enables all applications in 
that group to run on the D20MX. 

Table 4 lists the embedded images included in the D20MX firmware.
The Version Image column indicates the image versions in the SAN0001 and SAN0002 
files.

Table 4: D20MX embedded images

B086-0 131 IEC 60870-5-104 Data Link Provides a service to reliably transfer IEC 
60870-5-101 Application Service Data Units 
(ASDU) over a TCP/IP network. Implements this 
service using the transport layer interface 
protocol IEC 60870-5-104. 

B099-0 113 SNTP Client DTA The Simple Network Time Protocol (SNTP) client 
application provides reasonably accurate and 
reliable time synchronization.

B100-0 141 Internet Protocol Stack Configuration of the LAN

B119-1N 103 LAN Redundancy Manager Provides health and active pseudo DI points for 
LAN Ports, as well as default gateway 
monitoring and advanced routing 
configuration.

B148-0 104 Time Zone and DST 
Settings DTA

The Time Zone and DST (Daylight Saving Time) 
provides a time zone and DST information to 
other applications.

SAN0001 Applications

B009 401 Mailbox DTA System point conversion application.

B021N 993 DNP V3.00 DPA for D20MX The Distributed Network Protocol (DNP) DPA 
enables master stations to retrieve and modify 
local data using the DNP V3.00 Application 
Layer Protocol.

SAN0002 Applications

B009 310‡ Mailbox DTA Same application as used in SAN0001 except it 
allows you to avoid manually correcting some 
configuration warnings after transferring D20 
firmware containing B009 versions less than or 
equal to 310.

B021N 912 Ф DNP V3.00 DPA for D20MX Same application as used in SAN0001 except it 
allows you to avoid manually correcting some 
configuration warnings after transferring D20 
firmware containing B021 versions less than or 
equal to 912.

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description

LIcense Group Group Description

001 D2X Classic Applications

002 Advanced Automation Applications

Image 
ID

Image Name Description Version 
Image

S032 D20S Peripheral Board (supports B003) D20S Peripheral Board Code 303

S033 D20A Peripheral Board (supports B003) D20A Peripheral Board Code 301

S034 D20K Peripheral Board (supports B003) D20K Peripheral Board Code 306

S035 D20C Peripheral Board (supports B003) D20C Peripheral Board Code 307

S055-0 D20AC Peripheral Board (supports B003) D20AC Peripheral Board Code 108
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Firmware/FPGA versions
Refer to D20MX Release Notes (MIS-0095) available on the D20MX Documentation CD (GE 
part number 588-0075).

D20 device

D20 chassis
The D20 chassis is available in two versions:

• Standard single slot chassis with one horizontal Eurocard slot for mounting the 
D20ME/ME II board for the non-VME compatible version.

• Full VME-equipped chassis with five horizontal expansion slots for VME compatible 
printed circuit boards.

The D20 has a 3U horizontal slot chassis for 19" rack mounting. There are two types of 
chassis; see Table 5.

Table 5: D20 chassis types

D20 chassis 
compatibility

See Appendix Appendix G, Product Combinations on page 201, for the possible matching of 
main processor board and Ethernet card combinations with Chassis types.

D20 non-VME The D20 non-VME single-slot chassis consists of the following:

• D20MX processor board

• Modem slots

• Power supply with switch and fuses; see Figure 1.

Chassis Type Part # Description

D20 non-VME

(1 slot horizontal)

500-0305 Single Slot MX Chassis with backplane, external power 
connections, and 7 serial I/O ports

D20 VME

(5 slot horizontal) 

500-0280 MX Chassis with 5 card VME backplane
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Figure 1: D20 non-VME chassis - power supply switch and fuses 

This chassis contains the WESTERM D20M+ SS termination panel, which is attached 
directly to the back of the assembly; see Figure 2.

Figure 2: D20 non-VME backplane 

D20 non-VME Chassis

Power Supply Switch

Power Supply Fuses

D20 Non-VME Chassis

Power Supply 
Connector Block

WESTERM D20M+ 
SS Termination Panel
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D20 VME The D20 VME-compatible chassis (see Figure 3) can support one D20MX main board. When 
using the D20MX in a VME chassis, the 0 V ground wire must be used. 

Figure 3: D20 VME chassis - power supply switch and fuses 

This chassis (see Figure 4) contains the WESTERM D20M+ termination panel that is 
mounted separately on the D20 chassis. The VME chassis kit includes a VME bus 
backplane, called the WESTERM D20VME. The VME bus backplane connects to the 
termination panel using a ribbon cable from Slot 1 on the bus backplane. 

Figure 4: D20 VME chassis - VME bus backplane and D20M+ termination panel 

D20 VME Chassis

Power Supply Switch

Power Supply Fuses

D20 VME Chassis

WESTERM D20VME - 
VME Bus Backplane

WESTERM D20M+ 
Termination Panel
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D20 power supply
The chassis-mounted power supply modules are switch-mode converters that provide 
output power for the D20MX processor board, VME cards, modems and D20 Peripheral I/O 
modules, as required. A redundant power supply can be installed to provide fail-over 
protection to ensure continuous power to the D20.
If you have an extended system with more than five peripherals, the chassis-mounted D20 
power supply is not adequate. In this case, you need to install an external power supply.
The available power supplies are:

• Standard chassis-mounted; see Table 6

• Auxiliary; see Table 7

• Redundant power supplies; see Table 8

Other power supplies are available for specific requirements. Contact GE Digital Energy for 
details.

Table 6: Standard chassis-mounted power supplies

Table 7: Auxiliary power supplies - rack mounted

Table 8: Redundant power supplies

Over-current protection: Ensure your D20 power input is externally protected for over-
current; otherwise damage to the D20MX may occur. The required fuse rating depends on 
the power consumption of your system.

The D20 available power supplies, listed in Table 6 are equipped with two field replaceable 
fuses.; see Figure 5.

GE part number Input Output

580-2004 20 to 60 V DC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 24 V DC, 3 A

580-2005 20 to 60 V DC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 48 V DC, 1.5 A

580-2006 100 to 300 V DC or 85 to 264 V AC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 24 V DC, 3 A

580-2007 100 to 300 V DC or 85 to 264 V AC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 48 V DC, 1.5 A

GE part number Input Output Mounting

521-0103 20 to 60 VDC 24 VDC, 75 W Rack mounted

521-0104 100 to 300 VDC 24 VDC, 75 W Rack mounted

521-0105 90 to 250 VAC 24 VDC, 75 W Rack mounted

521-0106 100 to 350 VDC 48 VDC, 120 W Rack mounted

521-0107 90 to 250 VAC 48 VDC, 120 W Rack mounted

GE part number Input Output Mounting

580-0719 110 VAC or 125 VDC 24 VDC

580-0741 220 VAC or 48 VDC 48VDC

580-0789 110 VAC or 48 VDC 48 VDC

510-0241 115 VAC + 15% or  
30 to 60 VDC

48 VDC, 2.5 A Rack mounted

510-0242 115 VAC + 15% or  
40 to 144 VDC

48 VDC, 2.5 A Rack mounted
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Figure 5: D20 - Location of field-replaceable fuses 

Field-replaceable fuses for the standard chassis-mounted Power Supplies are listed in 
Table 9. These are the standard factory-installed fuses, unless otherwise specified. Always 
replace with the same type and values of fuse.

Table 9: Field-replaceable fuses

Modems
D20 modems (can be purchased separately) for communications to a host computer or to 
other IEDs. 
For example, WESDAC 202/V.23 is a 1200-baud Bell 202 or CCITT V.23 standard modem 
designed for 300 to 1200 baud asynchronous operation on unconditioned lines and 
supports the majority of SCADA/EMS applications. The 3U (GE part number 520-0120) 
vertical mount configuration in the D20 chassis and the 19 inch rack mount (GE part 
number 520-0090) version are currently not supported.
Third-party modems can be used to meet specific requirements. These modems are 
connected to the D20 via standard RS-232 connections. Contact GE Digital Energy for 
more information on options.

NOTE

If using a dial-up modem or high speed leased line modem, you must ensure the D20MX 
port baud rate does not exceed the speed of the modem to modem link.

Power Supply Fuse Fuse Function Replacement Fuse
(¼inch by 1 ¼ inch Time Delay)

580 - 2004 F1 +DC Input 12 A / 250 V

F2 -DC Input 12 A / 250 V

580 - 2005 F1 +DC Input 12 A / 250 V

F2 -DC Input 12 A / 250 V

580 - 2006 F1 Line/+DC Input 4 A / 250 V

F2 Neutral/-DC Input 4 A / 250 V

580 - 2007 F1 Line/+DC Input 4 A / 250 V

F2 Neutral/-DC Input 4 A / 250 V

Field-replaceable
fuses
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NOTE

If using a switched-carrier modem on a port, and retries have increased after upgrading 
from a D20ME to a D20MX, ensure Receive Squelch (also called DCD Wait, DCD Delay, 
Receive Inhibit Time, or DCD to RX Enable Time) is configured in the serial application that 
uses the port. Refer to the configuration guide of the serial application for further details. 

WESTERM D20M+ termination panel
Three methods may be used to mount the WESTERM D20M+ termination panel.

Method 1 With the standard chassis the WESTERM D20M+ termination panel (see Figure 6) is 
mounted separately into the 19" standard rack on a 2U mounting plate. 

Figure 6: WESTERM D20M+ termination panel - back view - connections 

Method 2 With the MX chassis the WESTERM D20M+ termination panel (see Figure 7) is mounted 
behind the WESTERM D20VME bus backplane. This leaves more room on the rack for multi-
node installations.

D.20 Link ports

Power termination block Ribbon cable connector from the 
WESTERM D20VME bus backplane
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Figure 7: WESTERM D20M+ termination panel - MX chassis side view - connections 

Method 3 For the D20MX processor there is also an option to use an extended bracket for chassis 
mounting. 

 

Ribbon cable

WESTERM D20M+ 
termination panel

WESTERM D20 VME bus backplane

Front

Back

D20
Ribbon cable connecting to 
additional rack-mounted 
SYSTEM D20M+
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Ordering guides

The latest ordering guides are available on the GE Digital Energy website:
http://www.gedigitalenergy.com/multilin/energy/catalog/D20MX.htm

You can select the required options from the available Product Option items. The Order 
Code automatically updates as each option is selected.
The ordering guides are available in the following tables:

• “D20 - D20MX order codes” on page 31

• “D20MX upgrade kits order guide” on page 32
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D20 - D20MX substation controller ordering guide

Table 10: D20 - D20MX order codes

NOTE

The 19" Rack Mounted Serial IO Westerm Panel included with the Serial Expansion options 
must be installed directly below the D20 chassis.

D20MX CPU Options D20MX -* * * * * * * * * * U U *

(A) - D20MX non-VME, dual 10/100/1000BASE-TX Ethernet Ports (front access) A

(C) - D20MX non-VME dual 100BASE-FX ST Ethernet Ports (front access) C

(G) - D20MX non-VME, dual 100BASE-FX Ethernet Ports (rear access) G

D20MX Power Supply D20MX -* * * * * * * * * * U U *

(A) - D20 Power Supply, 20-60VDC Input, 24V ISO Output A

(B) - D20 Power Supply, 20-60VDC Input, 48V ISO Output B

(C) - D20 Power Supply, 100-300VDC/85-264VAC Input, 24V ISO Output C

(D) - D20 Power Supply, 100-300VDC/85-264VAC Input, 48V ISO Output D

D20MX Modem slots 1, 2 & 3 D20MX -* * * * * * * * * * U U *

(U) - Empty slot with cover plate U U U

(C) - Telenetics 14400 baud modem 2-wire dial up C C C

(D) - Telenetics 14400 baud modem 4-wire leased line D D D

(E) - D20MX dual 100BASE-FX ST Media Interface Card E

(F) - D20MX dual 100 BASE-FX LC Media Interface Card F

D20MX Serial Termination Panel Options D20MX -* * * * * * * * * * U U *

(A) - 19" Rack Mount Serial IO Westerm Panel A

(B) - D20 Chassis Mounted Serial IO Westerm Panel B

(C) - D20 Chassis Mounted Serial IO Westerm Panel w/Extended Bracket C

D20MX Firmware Options D20MX -* * * * * * * * * * U U *

(**) -D20MX firmware (Refer to the GE Digital Energy online store for available 
firmware options)

* *

D20MX D2X CLASSIC Applications License D20MX -* * * * * * * * * * U U *

(U) - Not required U

(A) - D2X CLASSIC APPLICATIONS A

D20MX ADVANCED AUTOMATION Applications License D20MX -* * * * * * * * * * U U *

(U) - Not required U

(B) - ADVANCED AUTOMATION APPLICATIONS B

FUTURE Feature D20MX -* * * * * * * * * * U U *

(U) - Not required U

FUTURE Feature D20MX -* * * * * * * * * * U U *

(U) - Not required U

D20MX Serial Expansion D20MX -* * * * * * * * * * U U *

(U) - Not required U

(A) - 7 additional ports (14 ports total. 1x 19" Rack Mount Serial IO Westerm 
Panel included). See Note below.

A

(B) - 14 additional ports (21 ports total. 2x 19" Rack Mount Serial IO Westerm 
Panel included). See Note below.

B

(C) - 21 additional ports (28 ports total. 3x 19" Rack Mount Serial IO Westerm 
Panel included). See Note below.

C
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D20MX upgrade kits
Table 11 provides the available D20MX upgrade kits and spare kit (D20MX CPU only) Order 
Guide. Order the SGConfig Setup Software DVD (GE part number 588-0082) if required.

Table 11: D20MX upgrade kits order guide

NOTE

The Serial IO Westerm panel is not included with Serial Expansion in the kits. 

D20MX Kit Type D20MXK -* * * * * * * U U *

(A) - Upgrade Kit for D20 Horizontal chassis A

(D) - Upgrade Kit for D20 Horizontal chassis - Single Slot D

(C) - D20MX CPU only C

(E) - Serial Expansion only for D20 Horizontal chassis E

D20MX CPU Options D20MXK -* * * * * * * U U *

(U) - Not required U

(A) - D20MX non-VME, dual 10/100/1000BASE-TX Ethernet Ports (front access) A

(C) - D20MX non-VME dual 100BASE-FX-ST Ethernet Ports (front access) C

(G) - D20MX non-VME, dual 100BASE-FX Ethernet Ports (rear access) G

D20MX Media Interface Card Options D20MXK -* * * * * * * U U *

(U) - Not required U

(E) - D20MX dual 100BASE-FX ST Media Interface Card E

(F) - D20MX dual 100 BASE-FX LC Media Interface Card F

D20MX Firmware Options D20MXK -* * * * * * * U U *

(**) -D20MX firmware (Refer to the GE Digital Energy online store for available firmware 
options)

* *

D20MX D2X CLASSIC Applications License D20MXK -* * * * * * * U U *

(U) - Not required U

(A) - D2X CLASSIC APPLICATIONS A

D20MX ADVANCED AUTOMATION Applications License D20MXK -* * * * * * * U U *

(U) - Not required U

(B) - ADVANCED AUTOMATION APPLICATIONS B

FUTURE Feature D20MXK -* * * * * * * U U *

(U) - Not required U

FUTURE Feature D20MXK -* * * * * * * U U *

(U) - Not required

D20MX Serial Expansion D20MXK -* * * * * * * U U *

(U) - Not required U

(A) - 7 additional ports (14 ports total) A

(B) - 14 additional ports (21 ports total) B

(C) - 21 additional ports (28 ports total) C
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Specifications

The D20MX adheres to the following system, communications, electrical, physical and 
environmental specifications. Additional Standards and Protection are listed in Appendix B, 
Standards & Protection.

Processor

Communications

Electrical (D20 
horizontal chassis)

Processor 667 MHz embedded PowerQUICC II Pro

Memory 1024 MB of 266 MHz DDR2 RAM with ECC

16 MB NVRAM for persistent event storage

Storage 8 MB boot flash

256 MB firmware flash

Operating system VxWorks

LED indicators System status: Power, Ready

Ethernet port status: Link and Activity status per port

Power supply: Power

IRIG: Flashes when active.

Network connections Dual redundant Ethernet interface

Twisted Pair

10/100/1000BaseT (Isolated RJ-45 connector)

100BaseFX (Fiber Optic: 1300 nm, 50/125 µm, 62.5/125 µm multi-mode 
duplex fiber cable, ST connectors)

Serial communications D.20 Link, 2 channels

Data rate: 250 kbps

Surge protected to ±2000 V peak

RS-232, 7 channels

5-signal (TXD, RXD, RTS#, CTS#, DCD#) DTE ports

Data rate: independently-selectable; refer to the application configuration 
guides.

Maintenance Port RS-232, 1 channel/ 2 ports

2-signal (TXD, RXD)

Data rate: 9600 (or 19200 bps)

Rated power supplies AC-DC 100 to 240 V AC (±10%) 143 W output maximum

Minimum/Maximum AC voltage: 90 V AC / 265 V AC

100 to 300 V DC (±10%) 143 W output maximum

Minimum/Maximum DC voltage: 88 V DC / 330 V DC

DC-DC 20 to 55 V DC (±10%) 135 W maximum

Minimum/Maximum DC voltage: 18 V DC / 60 V DC

Peak inrush current at 
25 °C on cold start

AC-DC 50 A, max at 230 V AC

DC-DC 50 A, max at 230 V AC

Rated frequency 
(AC-DC)

50/60 Hz nominal (47 to 63 Hz)
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Physical (D20 
horizontal chassis)

Environmental

Software

Overall height 40.34 mm (1.588 in.)

Width 261.87 mm (10.31 in.)

Depth 160 mm (6.3 in.)

D20MX weight 0.7 kg (1.65 lb)

Fiber card weight 0.2 kg (0.35 lb)

Battery shipping 
restrictions

The D20MX does not contain a battery and is therefore not affected by 
US DOT or ICAO shipping restrictions.

Material/Finish Galvannealed steel with black power coat

Kit package Length:   49.5 cm (19.5 in.)

Width:     34.3 cm (13.5 in.)

Height:    15.2 cm (6 in.)

Weight:   2.54 kg (5.6 lb)

Operating temperature 0°C to +70°C

Note: Do not operate the D20MX above 60°C for extended periods of 
time as this shortens the life of the super capacitor and reduces the 
backup time of the real time clock.

Humidity rating 5% to 95% relative humidity, non-condensing 

Environmental rating Ingress protection: IP30 (IEC 60529)

Installation / 
overvoltage category

CAT II (2)

Pollution degree 2

Use Indoor use only

Operating altitude Maximum altitude 3000 m [9480 feet] above sea level

MTBF (MIL-HDBK-217): 
D20MX processor board

Non-VME with 10/100/1000BASE-TX copper: 449,616 hours at 40°C

Non-VME with 100BASE-FX fiber optic: 265,657 hours at 40°C

Configuration Performed using SGConfig 8.5 and higher
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Storage recommendations

Storage conditions 
Always store the D20MX in an environment compatible with operating conditions. 
Recommended environmental conditions for storage are:

• Temperature: -40 °C to +85 °C

• Relative humidity: 5% to 95%, non-condensing

• Maximum altitude: 12192 m [40,000 feet] above sea level

NOTE

Do not store the D20MX above 60°C for extended periods of time as this shortens the life of 
the super capacitor and reduces the backup time of the real time clock.

When powered off, the D20MX real time clock remains active for 14 days at -40°C to 60°C, 
and greater than one month at 25°C. Information in the NVRAM remains stored indefinitely 
since flash memory is used.
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D20MX Substation Controller

Chapter 2: Installing the D20 
Substation Controller

Installing the D20 Substation Controller

This chapter covers the following topics:

• Required tools and materials

• Installation procedure - D20 Substation Controller

• Rack installation

• D20 chassis layouts

Required tools and materials

Before beginning the installation procedures, have the following tools and equipment 
available:

• Flathead screwdriver with 0.6 x 3.5 mm blade (for terminal block wiring)

• #2 Phillips screwdriver (for rack mounting the unit)

• Wire cutters (for field wiring)

• Wire strippers (for field wiring)

• Wire crimping tool (for field wiring)

• Tie-wraps (for organizing wiring and cables)

• Multimeter (for testing voltages and I/O points)

• Needle nose pliers (for setting jumpers, for example)

• PROM puller (only required if you are going to be upgrading or installing PROMs in the 
field)

• Labelling device to label cables and wires

Installation procedure - D20 Substation Controller

To install the D20 Substation Controller:

1. Unpack the system components and report any damage. 

1.1. Carefully remove the D20 Substation Controller from its packaging.
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1.2. Open the product package and check that the following items have been 
delivered:

– Chassis

– Main processor board

– Power supply

– WESMAINT maintenance port cable

– Software loaded into the D20MX Substation Controller, See “Configuring 
the Software” on page 75.

– Termination panel: Based on the order code will be either be; 19" Rack 
mount, D20 Chassis Rear Mount or D20 Chassis Rear Mount Extended.

– Modems (options for the Main Chassis kit).

1.3. Visually inspect the unit to ensure it has not sustained any visible damage 
during transit. If there are visible signs of damage, report it immediately to the 
carrier. Contact GE Digital Energy Technical Support to return the D20 
Substation Controller; see section: “Product returns” on page 10.

1.4. Verify that you have received all items. GE parts include a unique number, 
typically in the format XXX-XXXX, that can be used as a reference.

2. Mount the D20 Substation Controller.

3. Perform all field wiring connections and jumper settings. See section: “Connecting to 
Devices and Networks” on page 53.

4. Connect the power supply to the D20 chassis. 

5. Power-up the D20 Substation Controller and check for normal operation. See section: 
“Powering-up and Testing a D20 Substation Controller” on page 69.

Some testing requires that code and configuration files have been downloaded to the 
D20 Substation Controller.

6. Start using the D20MX’s tools and utilities to configure and monitor the operation of 
the D20MX. See “Using the D20MX Substation Controller” on page 107.

Rack installation

Rack spacing for free 
airflow

When mounting multiple D20s in a rack (or if mounting a D20 in a rack with other 
equipment) verify that there is at least one rack unit (RU) of space above and below the D20 
to allow for cooling airflow (1 RU = 1.75 inches).

D20 chassis layouts

Your D20 Substation Controller can comprise one of three D20 chassis layouts; see 
“Installation procedure - D20 Substation Controller” on page 37.
The D20 non-VME chassis front panel layouts for the D20MX upgrade kits comprise:

• A D20 containing a D20MX with front Ethernet connectors; see Figure 8.

• A D20 containing a D20MX with front Fiber Optic connectors; see Figure 9.

• A D20 containing a D20MX with rear Fiber Optic connectors; see Figure 10.
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Figure 8: D20 chassis front panel - D20MX with Ethernet connectors 

Figure 9: D20 chassis front panel - D20MX with front fiber optic connectors 
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Figure 10: D20 chassis front panel - D20MX with rear fiber optic connectors 
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Retrofitting the D20MX in an Existing D20 Chassis

This chapter covers the following topics:

• Required tools and materials

• Retrofit procedure - D20MX processor into a D20

• Unpacking and inspecting the D20MX 

• D20 chassis layouts

• Connecting the power supply to the D20MX

• Grounding theD20MX

The D20MX processor board can be installed in an existing D20 device to replace D20ME 
D20M++, or D20MEII processor boards. If a D20 is being retrofitted, the following limitations 
exist:

• You cannot install multiple D20MX processor boards in a single D20. If more than 
seven serial ports are required, you must purchase a Serial Expansion kit. See section: 
“D20MX upgrade kits” on page 32.

• The D20MX supports 100BASE-FX instead of 10BASE-FL. If you are using any other 
devices in your system, and you are limited to 10BASE-FL, you must purchase a 
100BASE-FX to 10BASE-FL media converter.

The D20MX can be installed in a VME chassis or a non-VME chassis.
See section: “D20MX upgrade kits” on page 32 for a list of available upgrade kits and the 
parts provided within each kit. 

Required tools and materials

Before beginning the installation procedures, have the following tools and equipment 
available:

• Appropriate device cables for D.20 connections (GE part number 977-0089)

• For D20MX Non-VME with Dual 10/100/1000Base-TX (part number 526-3001): CAT5 
network cables for RJ-45 Ethernet connections (GE part number 977-0280 or 
equivalent)
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• For D20MX Non-VME with Dual 100Base-FX (part number 526-3003) and D20MX Non-
VME with Dual 100Base-FX Fiber Optic Card (part number 526-3005): multi-mode 
duplex fiber cable - ST connectors.

• Flathead screwdriver with 0.6 mm by 3.5 mm blade (for terminal block wiring)

• #1 Phillips screwdriver (for panel or DIN rail mounting the unit)

• #2 Phillips screwdriver (for rack mounting the unit)

• Needle-nose pliers

• Wire cutters

• Wire strippers

• Approved network settings for the device

• Windows-based PC with any Windows-based terminal emulation software and Web 
browser software installed

• 12 AWG wire (minimum) for protective earth

• 2 ring connectors, Panduit part number PV10-14R for 12 AWG [3.3 mm²] wire for 
protective earth terminal

Retrofit procedure - D20MX processor into a D20

To retrofit the VME chassis and the non-VME chassis:

1. Unpack the system components and report any damage. See section: “Unpacking and 
inspecting the D20MX” on page 50.

2. Ensure that you are sufficiently grounded to prevent ESD damage to the D20MX or 
other components. See section: “Grounding the D20MX” on page 52. 

3. Remove the D20MX from its static-protective packaging. Set the packaging aside and 
save it for future reuse. 

NOTE

The D20MX must be placed on an anti-static surface while not installed in the chassis. 

Handle the D20MX with care, since SMT components are located on the bottom side.

4. Switch the power off for the D20 chassis.

5. Prepare an ESD safe work area and ensure you are sufficiently grounded.

6. Remove the D20ME, D20M++, or D20ME II module.

7. Remove the D20EME module and D20EME Media Interface Card.

8. Remove the filler plate below the D20MX processor and the blanking faceplate above 
the D20MX processor.
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9. If the D20MX is rear fiber access type, install the Media Interface Card in Modem slot 1: 

9.1. Move a previously installed modem to Modem slot 2.

9.2. Install the D20MX Media Interface Card in Modem slot 1. Ensure that the cable 
is not pinched. See Figure 11, “Cable to fiber optic daughter card”. 

Figure 11: Cable to fiber optic daughter card 

10. If the D20MX is being installed in a VME chassis, connect the 0V+GND cable (GE part 
number 975-1239):

10.1. Remove the original 0V cable from the 0V terminal on the backplane; see 
Figure 12.

Figure 12: D20 - remove original 0 V cable 

P1 connector on Fiber 
optic daughter card

J3 and J4 connectors 
on D20MX PCB

Cable

D20 Chassis - view 
through top panel
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10.2. Insert the piggy-back connector of 975-1239 to the 0V terminal; see Figure 13.

Figure 13: D20 - install 975-1239 

10.3. Re-install the original 0V cable to the 975-1239 piggy back terminal; see 
Figure 14.

Figure 14: D20 - re-install original 0 V cable 
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10.4. Route the 975-1239 cable to exit at the top of the chassis; add cable ties to 
secure the wire bundle; see Figure 15.

Figure 15: D20 - route from 0 V terminal up to top 

10.5. Route the 975-1239 cable over the rear extension bracket, behind the 
Termination Panel PCBA, and connect to the Termination Panel.

See Figure 16.

Figure 16: D20 - connect to TB2-8 and TB2-9 
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10.6. Insert the ferrule (with two wires) end of 975-1239 into position 9 of TB2 and 
tighten the screw terminal.

10.7. Insert the Green wire with stripped end of 975-1239 into position 8 of TB2 and 
tighten the screw terminal.

11. If the D20MX requires Serial Expansion, install the Serial Expansion processor:

11.1. Use a Torx #T8 screw driver and a 5mm nut driver to remove the 2 screws with 
nyloc nuts at the PCM site on the D20MX.

NOTE

The PCB assemblies include small sensitive electronic components. Take care when 
removing and installing screws and nuts near to these components.

11.2. Remove the PMC filler plate from the D20MX faceplate; see Figure 17.

Figure 17: Remove PMC filler plate 

11.3. Remove the D20MX Serial Expansion Processor from its static-protective 
packaging and locate the hardware kit (2 stand-offs and 4 screws) attached to 
the packaging. 
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11.4. Install the two stand-offs to the D20MX Serial Expansion Processor with the 2 
screws supplied; see Figure 18.

NOTE

The 2 remaining screws will be required to secure the Serial Expansion 
Processor to the D20MX.

Figure 18: Serial expansion processor with stand-offs 

11.5. Align the 2 PMC connectors and the center alignment pin on the SE Processor 
with the D20MX.

11.6. Support the front of the SE Processor and firmly mate the SE Processor to the 
D20MX; see Figure 19.

NOTE

The PCB assemblies have SMT components mounted on both sides of the 
assembly and caution must be taken when resting on table surface and during 
the installation process.

Figure 19: Serial expansion processor - install on D20MX processor 

11.7. Install the Torx #T8 screws and 5mm nyloc nuts removed in step 11.1. The 
screws are inserted from the bottom of the D20MX and the nuts are secured on 
top of the SE Processor.

NOTE

The PCB assemblies include small sensitive electronic components. Take care when 
removing and installing screws and nuts near to these components.

11.8. Install the 2 remaining screws from the kit into the stand-offs at the front of the 
PMC. The screws are inserted from the bottom of the D20MX.

11.9. Inspect the PMC connectors and confirm they are fully seated.

11.10. Install the PMC filler plate removed in step 11.2.
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12. Install the D20MX in Processor slot 1 and tighten the front panel retaining screws to 
3.5 in-lbs to secure the D20MX to the chassis.

13. If the D20MX requires Serial Expansion, install the Serial Expansion auxiliary cards:

13.1. Confirm that all levers on the 40 pin connectors (both on the Processor and 
Auxiliary card) are in the open position.

13.2. Orient the interconnect cable with pin 1 (indicated by the blue marker) to the 
right. The connector at the top will have the locating feature facing upwards. 
Insert top connector into the Auxiliary card.

13.3. Install Serial Expansion Auxiliary card into the appropriate Processor slot with 
the appropriate interconnect cable length.

13.3.1. Use the PCB handles on the SE Auxiliary card to hold the assembly 
firmly and align with the card guide rails in the chassis. 

NOTE

Ensure the card properly aligns with the rails for a smooth installation. A slight 
angle will cause the card to catch on the rails and jam.

13.3.2. Use the bottom handle to push and the inner handle to guide the PCB 
assembly.

13.3.3. Once fully inserted, push on both handle to fully seat the PCB assembly 
into the backplane

13.4. Install the lose connector of the interconnect cable into the appropriate header 
on the SE Processor.

13.5. Repeat step 13 for additional Serial Expansion Auxiliary card using table below

Depending on the Upgrade kit options selected; 1, 2, or 3 auxiliary cards can be 
installed in the D20 system. Figure 20 shows the Serial Expansion processor 
header designations.

Figure 20: Serial expansion processor - header designations 

14. Install the lower filler plate (GE part number 953-1015) below the D20MX processor.

15. Install the upper blanking faceplate (GE part number 953-1035) above the D20MX 
processor.

NOTE

The rubber pads on the inside surface of the blanking faceplate must align with the 
PCB handles on the SE Auxiliary card.

SE Auxiliary 
card

Processor slot Cable length SE Processor 
header

SGConfig port 
name

1 3 3 inches P1 CB1 to CB7

2 4 5 inches P2 CC1 to CC7

3 5 5 inches P3 CD1 to CD7

P1

P2

P3

P4
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16. Install the ferrite clamp included in the package to the power inlet cable:

16.1. Ensure that you are sufficiently grounded to prevent ESD damage to the 
D20MX or other components.

16.2. Remove ferrite clamp (GE part number 460-0073) from the package; handle 
with care as the magnetic material is fragile. 

16.3. Pass the power cable through the channel, approximately 15 cm (6 inches) 
from the connector on the chassis.

16.4. Loop the power cable one more time around and through the core; see 
Figure 21. 

Figure 21: Open ferrite clamp

16.5.  15.5. Close the core and snap the halves together; see Figure 22. 

Figure 22: Closed ferrite clamp

16.6.  15.6. Visually inspect the installation and confirm that the assembly has 
completely latched and that the power cable is not pinched. Also check that 
none of the power cable connections have come loose during the installation 
process. 

17. Connect the power to the D20MX. Refer to section: “Connecting the power supply to a 
D20MX” on page 51.

18. Connect ground to the D20MX. Refer to section: “Grounding the D20MX” on page 52.
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Unpacking and inspecting the D20MX 

To unpack and inspect the D20MX:

1. Unpack the system components and report any damage. 

2. Carefully remove the D20MX from its packaging.

3. Open the product package and check that the following items have been delivered:

– D20MX unit (GE part number 526-3001, or 526-3003, or 526-3005)

– For 526-3005LF only:
– D20MX to Fiber Card Harness (975-1236)
– D20MX 100BASE-FX Rear LC FO Card (part number 526-3103LF) or D20MX 

100BASE-FX Rear ST FO Card (part number 526-3104LF)

– Lower filler plate (part number 953-1015)

– Blank plate for D20MX install (part number 953-1014)

– 0 V wire cable (part number 975-1237)

– For 526-3005LF installed in 500-0280 only:

– Termination Panel, D20MX extended mounting (952-2087)

– GE Digital Energy Product Documentation CD (GE part number 581-0002)

– GE Digital Energy D20MX Documentation CD (GE part number 588-0075 VXX)

4. Visually inspect the unit to ensure it has not sustained any visible damage during 
transit. If there are visible signs of damage, report it immediately to the carrier.

5. Verify that you have received all items. GE parts include a unique number, typically in 
the format XXX-XXXX, that can be used as a reference.

D20 chassis layouts

Installation of the D20MX can be performed with one of three D20 chassis layouts; see 
“D20 chassis layouts” on page 38.
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Connecting the power supply to a D20MX

The D20MX processor board is supplied power through the WESTERM D20M+ SS 
backplane. Power connections to the backplane are made on connector block TB1.
For the WESTERM D20M+ SS and WESTERM D20M+ (see Figure 23, “WESTERM D20M+SS: 
power supply connections”) the power supply connections:

• 1 and 2 are used for input power connections based on the D20 power supply

• 4 and 5 can be used as a switched auxiliary power supply source

• 7 and 8 can be used externally for status wetting, contact wetting and/or 
miscellaneous power connections, if applicable.

Figure 23: WESTERM D20M+SS: power supply connections 

14 AWG 
(green)
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Grounding the D20MX

Surge and noise suppression components used on the D20MX are designed to prevent 
nuisance operation and damage to internal components. To ensure correct protective 
operation, the earth ground wire (14AWG green wire) on the D20 chassis must be 
connected to a low impedance ground rail of a secondary cabinet or rack.
When making ground connections, ensure that all surfaces that are used for grounding 
are free of dirt, residue and corrosion.

An electrical surge or ESD event can damage the D20MX processor. To prevent damage to 
the D20MX, connect the earth ground to the signal ground on the terminal block (TB2) 
located on the WESTERM Termination Panel. The earth ground terminal is position 8 on TB2 
and the signal ground terminal is position 9 on TB2. For example, see the VME WESTERM 
Termination board in Figure 24, “VME WESTERM termination panel - earth ground and 
signal ground connection”. In cases where two wires are required to be connected to a 
single terminal, a two-wire ferrule should be used.

Figure 24: VME WESTERM termination panel - earth ground and signal ground 
connection 
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Connecting to Devices and Networks

This chapter provides guidelines for making physical connections between the D20 and 
substation and network devices.

Cabling overview

All physical connections are made to the connectors on the rear backplane of the D20 
chassis or to the front on the D20MX processor module.

D20MX front panel connectors
The D20MX front panel can have one of the following layouts: 

• Ethernet connectors (RJ45); see Figure 25.

• Front access Fiber optic connectors (ST); see Figure 26.

• Rear access Fiber optic connectors on a fiber optic daughter card; see Figure 27. The 
optic daughter card can be either a D20MX dual 100 BASE-FX ST Media Interface Card 
or a D20MX dual 100 BASE-FX LC Media Interface Card.

For a description of the operational status LEDs and port status LEDs, see “D20MX 
processor front panel LEDs ” on page 107.

Figure 25: D20MX front panel with Ethernet connectors 
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Figure 26: D20MX front panel with front access fiber optic connectors 

The D20MX can be used with an ST connector Fiber Optic card or an LC connector Fiber 
Optic card.

Figure 27: D20MX front panel and fiber optic card with rear access fiber optic 
connectors 
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General cabling requirements
Table 12 lists the cables required to connect to the D20MX:

Table 12: Connection cables

To provide higher EMC immunity and maintain CE Mark radiated emission compliance, the 
serial cables used for permanent serial and D.20 Link connections must comply with the 
following requirements:

• Cables must be shielded

• D-type connector covers must provide EMC shielding (e.g. metallized plastic or die cast 
metal covers).

Serial

Seven serial communications ports are brought out to the backplane connector P2. These 
serial ports are five-signal (TXD, RXD, RTS#, CTS#, DCD#) DTE serial ports, compliant to 
ANSI/TIA-232 and TIA/EIA-694 specifications and are hosted by UARTs.
The D20MX is tested with all 7 serial ports running at 19200 baud with 20% CPU utilization. 
Refer to application configuration guides for supported baud rates and for data bits.

To avoid burning out the WESTERM or D20MX mainboard when directly connecting a rear-
panel serial port on one D20MX chassis to another rear-panel serial port on any type of 
D20 chassis, jumper the WESTERM of both chassis' to not provide a power connection to 
pin 4. Refer to the appropriate WESTERM module layout for jumper settings.

D.20 Link

Communications between the D20 and the D20 peripheral I/O modules are carried over a 
high-speed, high-level data link control (HDLC) protocol called the D.20 Link. The D.20 Link 
has the following features:

• RS-485 serial link, half duplex, 250 kbps

• D.20 frame using HDLC protocol format with Manchester encoding

• Supports up to 38 D20 I/O peripheral modules in a standard configuration

Media options:

• RS-485, 24 AWG twisted pair, for applications up to 330 meters

• Multi-Mode Glass Fiber (GFO), up to 2 km

• Plastic Fiber (PFO), up to 60 meters

Media Designation Cabling Connector

Serial RS-232 Shielded DB-9 female

D.20 Link RS-485 
2 wire

Shielded DB-9 female

Twisted Pair Ethernet
(GE part number 526-3001 only)

10/100/1000BASE-T UTP (Unshielded Twisted 
Pair) – CAT 5 or better

RJ-45

Fiber optic
(GE part number 526-3003 and 
526-3005LF only)

100BASE-FX 1300 nm, 50/125 μm and 
62.5/125 μm multimode 
duplex fiber cable

ST-style 
connectors
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If you are using the D20 as a Master Data Concentrator, then the D.20 Link connectors are 
not used.
The D.20 Link can also be used to supply power to peripherals on smaller D20 horizontal 
slot chassis systems. Power supply to the WESDAC/WESTERM peripheral pairings is 
through the WESTERM boards. For details, see the D20/D200 Installation and Operations 
Guide (part number 994-0078); see section: Connections and Configuration.

Second D.20 link
Redundant D.20 communication channels are available on all peripherals. Daughter 
boards are required to support this functionality:

• Part number: 540-0207, for the A, S and K boards

• Part number: 540-0209 for the C board

D.20 communications interface
Use the D.20 Communication Interface module when you require one-to-one 
communication links with peripherals.

D.20 splitter
Use the D.20 Splitter when you require one-to-four communication links with peripherals, 
especially if peripherals are clustered in different areas of the substation.

D.20 RS-485 interface
The D.20 RS-485 Interface provides the repeater function, which can only be implemented 
on the D.20 Communications Interface.

GFO and PFO adaptors
Glass Fiber Optic (GFO) and Plastic Fiber Optic (PFO) adaptors are used to provide either 
glass or plastic fiber optical cable extensions to the D.20 Link. These allow interference free 
links to peripherals that are sited at a remote distance from the main D20 installation.

Extended power
When power requirements for multiple peripherals exceed the base system limitations, use 
the D.20 DC Interface module.

D.20 DC interface
The D.20 DC Interface module is used:

• As power input for additional peripherals on a D.20 Link

Interposing relays
The required rating of the relays on the K and C boards is determined by the loading 
characteristics of the device that the boards control.
If the load rating of the controlled device exceeds the K or C board relay rating, then you 
need an Interposing Relay panel.
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Universal Protocol Converter
A Universal Protocol Converter (UPC) is required when the D20 has to communicate with a 
device that uses a synchronous communications format. The function of the UPC is to 
convert between the D20's asynchronous format, and the device's synchronous format.

Peripherals
Peripheral I/O modules are intelligent modules containing an on-board microprocessor. 
They are configured as slaves to the D20MX processor board. In this way, specific I/O 
processing is distributed throughout the RTU to the appropriate I/O module.
There are five types of I/O peripherals:

• D20A analog input

• D20S digital inputs

• D20K digital output

• D20C combination input/output

• D20AC alternating current analog input

Optional high-voltage peripherals are also available.
The D20MX is only compatible with certain peripheral common code (i.e., pcommon) 
versions as defined in Table 13.

Table 13: Peripherals compatible with the D20MX 

For further information on I/O peripherals, see the D20/D200 Installation and Operations 
Guide (part number 994-0078); see section: Connections and Configuration.

I/O peripheral PCOMMON version compatibility PERFPAL version compatibility

D20C P022 - PCOMMON2:
• 3.05, 3.00 are compatible
• 2.21 and earlier are NOT compatible

PERFPAL 3 1.2 with OLD Base setting is 
compatible
PERFC 00 with NEW Base setting is 
compatible

D20A, D20S and 
D20K

P010 - PCOMMON:
• 3.06, 3.05, 3.01, 3.00 are compatible
• 2.21 and earlier are NOT compatible

PERFPAL 1 1.5 with OLD Base setting is 
compatible
PERFASK 00 with NEW Base setting is 
compatible

D20AC P087 - pBOOT 1.04, 1.03, 1.02 are 
compatible

-
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Twisted-pair Ethernet (for 526-3001 only)

The10/100/1000BASE-T variant of the D20MX can connect to one or two networks through 
two twisted-pair Ethernet connections. In redundant LAN mode this causes the two 
Ethernet connections to use the same MAC address. Port 1 is the primary port and Port 2 is 
the secondary port. When the system detects a signal on Port 1, Ethernet traffic takes 
place on Port 1. When the system detects loss of signal on Port 1, Ethernet traffic takes 
place on port 2.
All RJ-45 connectors have the same signal definition. However, the twisted-pair Ethernet 
ports are auto MDI/MDIX and can support a straight-through or crossover cable.

NOTE

The D20MX does not require Ethernet switches to use Spanning Tree Protocol (STP), but for 
switches configured to use STP, you must configure the switch ports that are connected to 
the D20MX as edge ports.

To connect the D20MX 
to network devices

Plug network cables into the D20MX twisted-pair Ethernet ports.

NOTE

If the D20MX is deployed in the presence of strong RF energy in the 110 MHz - 125 MHz 
band, such as airport ILS localizers or aviation radio transmitters, it is recommended that 
shielded twisted-pair Ethernet cables be used.

Table 14: Ethernet RJ-45 connector signal definitions

Table 15: Ethernet crossover cable (RJ-45) pin out

Position Function Signal Flow Color

1 RX+ IN White w/ Orange

2 RX- IN Orange

3 TX+ OUT White w/ Green

4 P1+ - Blue

5 P1- - White w/ Blue

6 TX- OUT Green

7 P2+ - White w/ Brown

8 P2- - Brown

Shield - -

D20MX Switch/Hub

Name Pin Pin Name

TX_D1+ 1 3 RX_D2+

TX_D1- 2 6 RX_D2-

RX_D2+ 3 1 TX_D1+

RX_D2- 4 2 TX_D1-

BI_D3+ 5 7 BI_D4+

BI_D3- 6 8 BI_D4-

BI_D4+ 7 4 BI_D3+

BI_D4- 8 5 BI_D3-
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Table 16: Ethernet straight-through cable (RJ-45) pin 0ut

Fiber optic Ethernet (for 526-3003 and 526-3005LF 
only) 

The 100BASE-FX variant of the D20MX (GE part numbers 526-3003 and 526-3005) can 
connect to one or two networks through two fiber-optic Ethernet connections. 
The data rate on each port is 100 Mbps.

NOTE

You must enable Far End Fault Indication (FEFI) or Loss Link Alert (LLA) in connected 
external devices for proper redundant operation.

NOTE

External switches must have Spanning Tree Protocol port settings configured to edge for 
proper operation of 100Base-FX connected ports.

You can use the following glass optical fiber (GOF) cabling with the D20MX:

• 50/125 μm core/cladding multi-mode (gradient index) cable

• 62.5/125 μm core cladding multi-mode (gradient index) cable

• 100/140 μm core/cladding multi-mode (gradient index) cable

• 200 m core Hard-Clad Silica (HCS) multi-mode (step index) cable

You can use the following fiber optic terminations for D20MX cabling:

• ST Connectors (with 526-3003 and 526-3005LF + 526-3104LF fiber card)

• LC connectors (with 526-3005LF + 526-3103LF fiber card)

When calculating cable length, consider the following optical power levels:

• Glass optical fiber transmitter power is –19.0 ± 2 dBm

• Glass optical fiber receiver sensitivity is typically –25.4 dBm

This product contains components rated as Class 1 Laser Products.

D20MX PC

Name Pin Pin Name

TX_D1+ 1 1 RX_D2+

TX_D1- 2 2 RX_D2-

RX_D2+ 3 3 TX_D1+

RX_D2- 4 4 TX_D1-

BI_D3+ 5 5 BI_D4+

BI_D3- 6 6 BI_D4-

BI_D4+ 7 7 BI_D3+

BI_D4- 8 8 BI_D3-
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LAN redundancy

Both twisted-pair and fiber optic Ethernet options provide two LAN redundancy schemes 
called redundant LAN and dual LAN.
The redundant LAN scheme provides automated fail over between two Ethernet network 
connections (TX1/RX1 and TX2/RX2) that share a single MAC address.
When the primary port (that is, port 1) receives no signal, or detects a fault signal from the 
remote link partner, the D20MX switches to the secondary port (that is, port 2) if it has a 
valid link. The D20MX reverts to the primary port if the primary link is restored or no signal 
is present on the secondary port. 
With the dual LAN scheme, each port has a unique MAC, IP address and subnet. Each 
remote device participating in a dual LAN scheme must have a primary IP address 
reachable through the LAN A subnet of the D20MX and a secondary IP address reachable 
through the LAN B subnet of the D20MX. D20MX client applications fail over to the remote 
device's secondary IP address when they detect a failure to communicate with the remote 
device's primary IP address. D20MX server applications accept communications from the 
remote device's primary or secondary IP address. 
To configure a system for redundant LAN operation, enable only LAN A in the device 
properties of the D20MX. To configure a system for redundant LAN operation with an Alias 
IP, enable both LAN A and LAN B in the device properties of the D20MX and set the 
“Redundancy” field in the B119-1N LAN Redundancy Manager > LRM Configuration table 
to “Redundant LAN”. An Alias IP allows the D20MX to communicate with devices using the 
dual LAN scheme and devices using the redundant LAN scheme, simultaneously.
To configure a system for dual LAN operation, enable both LAN A and LAN B in the device 
properties of the D20MX and set the “Redundancy” field in B119-1N LAN Redundancy 
Manager > LRM Configuration table to “Dual LAN”. The D20MX device properties and the 
B119-1N LAN Redundancy Manager configuration may be configured through SGConfig 
8.1 and higher.

IP addresses

The D20MX assigns IP configuration to its LAN A and optionally LAN B interface according 
to the rules defined in Table 17. 
In a standalone system, the D20MX assigns the LAN A and LAN B IP addresses exactly as 
you configured them in SGConfig. 
In a redundant system, the D20MX assigns the LAN A and LAN B IP addresses of the Active 
CCU exactly as you configured them in SGConfig. 
However, in other modes, the CCU assigns derived IP addresses as indicated in Table 17. 
For a description of the modes, refer to Table 19. The D20MX assigns the subnet mask of 
the derived IP addresses as the subnet mask configured in the LAN A or LAN B 
configuration.

Table 17: D20MX IP address assignment

CCU Redundant 
System

Mode LAN A IP Configuration LAN B IP Configuration (If 
Configured)

CCU A Standalone Active, Debug 
or Disabled

IP Address: LAN A IP 
Address
Mask: LAN A Subnet Mask 
(e.g 192.168.1.1 / 
255.255.255.0)

IP Address: LAN B IP 
Address 
Mask: Configured LAN B 
Subnet Mask (e.g. 
192.168.2.1 / 255.255.255.0)

CCU A Redundant Active

CCU B Redundant Active
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You may override or disable the derived IP address by defining a host with the desired IP 
address. Use an IP address of 0.0.0.0 to disable the derived IP address. Define the host in 
the SGConfig tool > D20MX Device Wizard > Define the LAN properties for this project 
screen (see Figure 28 for an example). 

NOTE

When transferring a redundant D20 in a ConfigPro or SGConfig project configuration to a 
D20MX ensure the new D20MX standby IP addresses do not conflict with other devices in 
the project. If they do, you may disable the standby IP addresses or reassign them as 
described in the previous paragraph. If there are any conflicts, the WESMAINT error log of 
the D20MX will log warnings such as the following:

 1 ROOT N0: W001: IP of RDT1 same as CCUB
where RDT1 is the host name of the device with a conflicting IP address.

Figure 28: SGConfig - example of overriding derived IP address by defining a hostname 

Each host consists of a host name and host address. Construct the host name by replacing 
the last two characters of the D20MX Host Name with a two character suffix that matches 
the derived IP address you wish to override or disable. The suffix conventions are shown in 
Table 18. The D20MX Host Name appears in the D20MX Device Wizard as shown in 
Figure 29.

CCU A Redundant Standby, 
Debug or 
Disabled.

Derived IP Address: LAN A 
IP Address + 1 
Mask: LAN A subnet mask 
(e.g. 192.168.1.2 / 
255.255.255.0)

Derived IP Address: LAN B 
IP Address + 1 
Mask: LAN B subnet mask 
(e.g. 192.168.2.2 / 
255.255.255.0) 

CCU B Redundant Standby, 
Debug or 
Disabled.

Derived IP Address: LAN A 
IP Address + 2 
Mask: LAN A subnet mask 
(e.g. 192.168.1.3 / 
255.255.255.0)

Derived IP Address: LAN B 
IP Address + 2 
Mask: LAN B subnet mask 
(e.g. 192.168.2.3 / 
255.255.255.0)

CCU A/B Redundant or 
Standalone

Service Mode Not enabled Not enabled

CCU Redundant 
System

Mode LAN A IP Configuration LAN B IP Configuration (If 
Configured)
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Figure 29: SGConfig - Host name shown in the LAN Settings 

Table 18: Host name suffix conventions

The D20MX can be in one of five modes as defined in Table 19. You can find the current 
mode of the D20MX by navigating to the SHELL in WESMAINT II+ and typing the 
command el.

Table 19: System mode definitions

HostName Suffix IP Address Corresponds To... Example

AA CCU A, LAN A FAC_DEFAA

AB CCU A, LAN B FAC_DEFAB

BA CCU B, LAN A FAC_DEFBA

BB CCU B, LAN B FAC_DEFBB

Mode Description Partial “el” output

Active D20MX applications are operational. Active CCU       YES

Standby D20MX applications are not operational but are 
ready to take over on a switchover command or 
a failover.

Standby CCU      YES

Disabled D20MX applications have been suspended due 
to an error. You must type el /r and boot in the 
SHELL to clear this error.

Disabled         YES

Debug D20MX boot sequence has been interrupted by 
pressing CTRL-E. Put the CCU into this mode in 
order to recover a system that has a corrupted 
configuration or code image. 

Redundant CCU    NO 
Standby CCU      NO 
Active CCU       NO 
Service Mode     NO 
Sys Service Mode NO 
Disabled         NO

Service Mode D20MX configuration has been corrupted or is in 
the process of receiving a new configuration. To 
recover the system, you must download a 
configuration serially.

Service Mode     YES
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RS-232

The RS-232 port on the D20MX is used to access the WESMAINT II+ facility and to transfer 
code and configuration data to the D20MX. You can use a VT100-compatible terminal or 
terminal emulation program to directly access the WESMAINT II+ facility. SGConfig's 
Terminal Emulator is an example of a suitable terminal emulation program.
For convenience the RS-232 port (COM0) is connected to the D20MX front panel and to the 
rear panel. Only one port can be connected to at a single time, since both connectors are 
internally connected to a single UART. 
The D20MX can be ordered from the factory with either 9600 or 19200 bps. To change the 
baud rate of the RS-232 port to 19200, type JBAUD 19200 in the D20M SHELL. To change 
the baud rate to 9600 type JBAUD 9600 in the D20M SHELL.

Only a single connection at one time can be made to either the front panel RS-232 port or 
to the rear panel WESMAINT port.  
Connecting to both the front panel RS-232 port and the rear panel WESMAINT port at the 
same time potentially results in faulty system operation and damage to the D20MX and 
the connected computer.

NOTE

JBAUD requires that you login as a user whose “Monitor Access Level” is Read/Write (i.e., 
Administrator role). 

Non-responsive 
RS-232 port

In the event that the D20MX RS-232 port appears non-responsive, type Ctrl-Q. This non-
responsive condition might occur if your computer goes into sleep mode and then wakes 
up while still connected to the D20MX RS-232 port.

Use only a NULL modem cable (GE Digital Energy part number 977-0529) when you are 
connecting to the D20MX front-panel RS-232 connector. Use of a WESMAINT cable does 
not allow communication to the D20MX.

Use only a standard WESMAINT cable (GE Digital Energy part number 977-0300) when 
connecting to the rear panel COM0 connector. Use of a NULL modem cable causes 
permanent damage to the D20MX and PC.

D20 Gateway system redundancy

A redundant D20 setup allows a secondary D20 to automatically take over operations 
from a paired D20 unit that has failed.
D20 equipment redundancy requires:

• Two D20 units and 

• One or two RS-232 switch panels. 

NOTE

The quiescent current of the +12 V power supply input on the RS-232 Switch Panel is 15 
mA. The maximum power requirement on the +12 V input during operation is 230 mA.

Through a toggle switch on the RS-232 Switch Panel, you designate one of the CCUs as the 
Active unit. If the Active unit hardware or software fails, the Active CCU is automatically 
switched offline, and the Standby unit is switched through to the field equipment (i.e., it is 
made Active).
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The RS-232 Switch Panel is not equipped with EMI protection circuitry. If the connection 
length exceeds 3m, a Serial Surge Protection Panel (GE item number 540-0249) or 
equivalent protection device should be installed.
Figure 30 shows a redundant D20 system, with CCU A active.

Figure 30: Redundant D20 system with CCU A active

If the Active CCU fails:

• The Standby CCU detects the failure through the inter-CCU communications link.

• The Standby CCU commands the RS-232 Switch Panel to switch over all serial 
connections.

• The RS-232 Switch Panel switches all serial field connections to the Standby CCU, 
which now becomes the Active CCU.

If CCU A fails, CCU B becomes active. See Figure 31, “Redundant D20 system - If CCU A 
fails”.

Figure 31: Redundant D20 system - If CCU A fails
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Figure 32: RS-232 Switch panel

A pair of LEDs marked CCU A and CCU B indicate which of the D20 units is currently active. 
If the hardware or software of the active unit fails, it is automatically switched offline and 
serial connections to the field are transferred to the standby unit. A toggle switch on the 
RS-232 switch panel can be used to switch the D20 devices between active and standby 
modes. 

Failover sequence
If the active D20 unit fails, the following actions occur:

1. The standby D20 unit detects the failure through the lack of a heartbeat signal on the 
ping cable or through a status change on the watchdog cable.

2. The standby D20 unit attempts to pull the RS-232 switch panel to assume the active 
state.

3. The RS-232 switch panel transfers all serial field connections to the standby D20, 
which then becomes the active D20.

Required components
To implement a redundant D20 system, you need the components: listed in Table 20.

Table 20: Redundant D20 system - required components

NOTE

Pins 4 on switch panel connectors J2 through J9 are tied together and to the panel’s power 
supply. Any loading from field devices on these pins, loads the RS-232 panel power supply 
and should be taken into consideration when sizing power supplies.

Active/Standby Sw itch

Power Indicator LEDs

CCU Indicator LEDs

CCU A

CCU B

PWR A

PWR B

Component Function Part Number

RS-232 Switch Panel Communications switch. 517-0247

Power Supply Power supply to power the RS-232 switch panel.
Input: 85 – 264 V AC or 90 – 350 V DC.

580-0046

Watchdog Cable 
Assembly

Connects D20 A to the RS-232 switch panel. 977-0160

Connects D20 B to the RS-232 switch panel. 977-0160

Ping Cable Assembly Links both D20 units to facilitate a heartbeat message 
that determines the status of the active unit.

977-0122

RS-232 Serial Cable Connects the D20 to the RS-232 switch panel which is 
then connected to external field devices.

977-0121

Power/SysFail Cable Connects the RS-232 switch panel to D20 external power 
supply.

970-0161

Ground Cable Provides a ground connection for the RS-232 switch panel. 970-0182
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To set up a redundant 
system

It is recommended that you install and configure one standalone D20 unit to ensure that 
your configuration is valid and that device communications are operating properly. Once 
this is done, proceed with the installation of the redundant system.

1. Mount the D20 devices in a rack and connect power and ground.

2. Mount the RS-232 switch panel.

3. Plug the connector of watchdog cable A (GE part number 977-0160) to serial 
connector COM 6 on the first D20 (CCU A).

4. Connect the bare leads of watchdog cable A to TB1 (position 1 and 6-8) on the RS-232 
switch panel.

5. Plug the connector of watchdog cable B (GE part number 977-0160) to serial 
connector COM 6 on the second D20 (CCU B). 

6. Connect the bare leads of watchdog cable B to TB1 (position 11 and 14-16) on the RS-
232 switch panel.

7. Connect one end of the ping cable to the first D20 and the other end to the second 
D20. This ping cable must be connected to the same serial port number on both units.

8. Use standard RS-232 cables (GE part number 977-0121) to connect the D20 serial 
communication ports to the serial ports on the RS-232 switch panel. P1 through P8 are 
connected to the first D20, P9 through P16 are connected to the second D20. 
Connections from the switch panel to both D20 units should be made in the same 
order. For example, if P1 is connected to port 3 on the first D20, P9 should also be 
connected to port 3 on the second D20.

NOTE

At least one RS232 cable (GE part number 977-0121) from each D20MX MUST be 
connected to the switch panel to enable proper switch over operation. Failure to do so 
may result in the D20MX entering the “disabled” mode during a failover.

9. Connect field devices to J1 through J8 on the RS-232 switch panel.

RS-232 switch panel operation
The RS2-32 switch panel has two sets of indicator LEDs:

• PWR A/PWR B: When lit , power and communications are received from the connected 
units. Normally, both LEDs are lit .

• CCU A/CCU B: Normally, one LED is lit , indicating which unit is active.

The active/standby switch on the front of the RS-232 switch panel is used to:

• Restore a previously failed unit to active status once it has been repaired.

• Manually force a unit to active status so that routine maintenance can be performed 
on the other unit.

To manually operate 
the RS-232 switch 

panel

1. Pull the active/standby switch straight out to release it from the locked position.

2. Switch it up to make unit A active or down to make unit B active.
The CCU A/CCU B LED indicator indicates which unit has been activated.

Redundancy wiring diagrams
Figure 33 illustrates how to wire the D20MX units and RS-232 switch panels to enable 
system redundancy:

NOTE

The D20MX watchdog (control) port, heartbeat (ping) port, and serial port assignments are 
software configurable. Refer to the D2x Configuration Guides.
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Figure 33: Redundancy wiring - single RS-232 switch panel
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D20MX Substation Controller

Chapter 5: Powering-up and Testing 
a D20 Substation Controller

Powering-up and Testing a D20 Substation Controller

Once you have made all field wiring and communication connections and have completed 
the necessary hardware configuration, the next step is to power-up the D20MX and verify 
that it is functioning properly.
Use this chapter to prepare for and correctly perform the power-up and other tests. This 
chapter includes:

• What is needed to test: WESMAINT II+ facility, SHELL and SGConfig

• How to power-up the D20MX and conduct the BOOT Test: Power On Self-Test

• How to carry out a redundant system test

NOTE

Before any of the tests and procedures in this section can be performed, a valid 
configuration file must be loaded into the D20MX NVRAM. 
If you have replaced the main board of the D20MX, then you need to restore the 
configuration file so that diagnostic tests can be performed.
If this power-up and test procedure reveals that your D20MX is not functioning properly 
due to software malfunction, then you need to download code and configuration files.
See the SGConfig online help.

Required for testing

The system components that are required for configuring and testing the D20MX are:

• WESMAINT II+ facility

• SHELL

• SGConfig application

To prevent burning out the main processor board, make two important checks before 
switching on the D20MX:

• Check that the external power supply input level is correct for the Power Supply fitted 
to the chassis. See section: “D20 power supply” on page 26.

• If you have 125 V DC or 110V AC input, then jumpers Z22 and Z23 on the WESTERM 
D20M+: 517 - 0225 or 517 - 0224 must be jumpered 2 - 3.
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Accessing WESMAINT II+ using a terminal
You can use a VT100-compatible terminal or a terminal emulation program to directly 
access the WESMAINT II+ facility. SGConfig's Terminal Emulator is an example of a suitable 
terminal emulation program.

NOTE

For further information about using WESMAINT II+ software to perform any of the test 
procedures in this section, refer to the WESMAINT II+ User’s Guide.

Terminal Emulation
Microsoft Windows™ HyperTerminal can be used for terminal emulation but it is NOT 
recommended because code and configuration file download times are considerably 
increased. 

TIP

The program Tera Term for Microsoft Windows™ does not have these limitations and is 
therefore recommended as a terminal emulation program. It can be downloaded from the 
Internet. 

SHELL
The SHELL is a debugging and diagnostics tool that is accessible as a menu selection in 
WESMAINT II+, or from a basic login prompt if WESMAINT II+ is not available.

The approved method of using the diagnostic tools of the SHELL is through the front RS232 
port. 

Power up and test steps

To power up and test the D20MX:

1. “Set up a PC to act as a WESMAINTII+ terminal”. See page 71.

2. “Power up the D20MX” on page 71. See page 71.

Result: The D20MX automatically runs the Online Start-up test. See “Automatic on-line 
start-up test” on page 71.

3. “Test for redundancy”. See page 72.

4. “Check that fail-over is functioning correctly”. See page 73.

5. “Check that switch-over is functioning correctly”. See page 73.

6. “Verify either hardware or software switch-over”. See page 74.
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Set up a PC to act as a WESMAINTII+ terminal

To set up a PC to act 
as a WESMAINT II+ 

terminal.

1. Open the VT100 compatible terminal emulation software you are going to use.

2. Verify (or set) terminal communications settings as follows:

Result: The terminal emulator settings are now configured.

Power up the D20MX

To power up the 
D20MX

1. Check that all field wiring, grounding wires and fuses are in place and secure on your 
D20 system.

2. Turn the chassis-mounted Power Supply switch to ON.

Result: The unit is powered-up.

3. On start-up, inspect the D20MX LED indicators on the front panel. 

Result: The RDY LED is flashing. 

Automatic on-line start-up test

The D20MX automatically boots up when the power is switched on. Internal processes 
perform a series of routines. Self-diagnostic tests are performed followed by the spawning 
of all the software applications that reside in the unit's memory.
The self-diagnostic tests generate PASS or FAIL messages that can be viewed in your 
terminal emulator WESMAINT II+ screen. You can also see the results of the application 
spawning process.
Pass/Fail tests are carried out on the:

• User RAM

• NVRAM

• FLASH memory

• Root process

The self-diagnostics also return measures for:

• SDRAM size

• Bus Speeds

• CPU Core Speed

The NVRAM CRC test verifies that the configuration header is valid. If this fails, then the 
D20MX starts with a minimal set of applications that allow the system to be restored. 

Setting Value

Data Rate Baud rate of the D20MX (9600 or 19200 bps - See “RS-232” on 
page 63 to change)

Data Bits 8

Stop Bits 1

Parity None

Flow Control Xon/Xoff (software)

Connector Settings COM1 or COM2, as required by the computer you are using
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Code and configuration files
If the code and configuration files compiled for your specific system are already 
downloaded, then you can login straightaway to WESMAINT II+ for powering-up and 
testing.
If your system-specific code and configuration files are not downloaded, then you need to 
power-up with the default configuration. You can then login to the SHELL, download your 
system-specific files and restart the D20MX for testing.
For details, see the SGConfig online help. 

Further testing
For further specific testing, log in to WESMAINT II+. See the WESMAINT II+ Users Guide and 
WESMAINT user guides for specific applications.

Test for redundancy

If you have a D20 redundant system, you must test that:

• CCU A and CCU B are communicating

• Fail-over is functioning correctly.

To check that CCU A and CCU B are communicating once you have powered-up the 
Primary and Secondary units:

1. On the front of the RS-232 Panel, check that CCU A LED is illuminated, which shows 
that CCU A is Active.

NOTE

Both the PWR A and PWR B LEDs should be illuminated.

2. Connect a NULL modem cable (GE Energy part number 977-0529) to the RS-232 
connector on the front panel of the active D20MX. 

3. Attach the other end of the cable to the serial communications port of the PC or 
terminal.

4. Login to WESMAINT II+ through the emulator you are using.

Result: The WESMAINT Main Menu appears.

5. Check to see that STNDBY appears at the top-left of this WESMAINT screen.

Results: If this text shows, then the Primary and Secondary CCU are communicating.

If this text does not show, then the Primary and Secondary are not communicating.

NOTE

STNDBY appears on the Active CCU WESMAINT Main Menu display approximately one 
minute after power-up of the two units. Wait for this message to appear before following 
the next procedure.
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Check that fail-over is functioning correctly

To check that fail-over is functioning correctly for the event of hardware failure:

1. On the front of the RS-232 Panel, check that CCU A LED is illuminated, which shows 
that CCU A is Active.

NOTE

Both the PWR A and PWR B LEDs should be illuminated. 

2. To simulate hardware failure, switch off the Active D20MX at the main power switch 
on the front of the unit.

Result: If the RS-232 is functioning correctly, then it switches over to the Standby unit 
and the CCU B LED illuminates and the CCU A LED goes off.

Check that switch-over is functioning correctly

To check that switch-over is functioning correctly for the event of software failure:

1. On the front of the RS-232 Panel, check that CCU A LED is illuminated, which shows 
that CCU A is Active.

NOTE

Both the PWR A and PWR B LEDs should be illuminated.

2. Connect a NULL modem cable (GE Energy part number 977-0529) to the RS-232 
connector on the front panel of the D20MX designated as CCU A.

3. Attach the other end of the cable to the serial communications port of the PC or 
terminal.

4. Login to WESMAINT II+ on CCU A using your terminal emulator.

Result: The WESMAINT Main Menu appears.

5. Select Main Menu > System Functions and press ENTER.

Result: The WESMAINT Function Menu appears.

6. Select SWITCH-OVER on the Function Menu and press ENTER.

Result: A password prompt appears.

7. Enter your password and press ENTER. The default password is control.

Result: The CCU Switch-Over display appears.

8. Press Ctrl-V to begin switch-over.

Result: A confirmation message appears: Confirm Yes/No.

9. Type Yes and press ENTER.

Result: Fail over occurs
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Verify either hardware or software switch-over

To verify either hardware or software switch-over.

1. Connect a NULL modem cable (GE Energy part number 977-0529) to the RS-232 
connector on the front panel of the D20MX designated as CCU B, which was originally 
the Standby unit.

2. Attach the other end of the cable to the serial communications port of the PC or 
terminal. 

3. Login to WESMAINT II+ through the emulator you are using.

Result: The WESMAINT Main Menu appears.

4. If you can login to WESMAINT II+, this indicates that CCU B is the Active CCU.

Results: Fail over has occurred.

NOTE

If the previously Active A CCU powers-up after a fail-over from CCU A to CCU B, then 
STNDBY appears at top left when you login to WESMAINT II+ on CCU B. This can take 
up to a minute to occur.

NOTE

If you cannot login to WESMAINT II+ on a CCU, then the unit is most likely powered down. 
Verify that the RDY LED is flashing and verify that the serial cable is connected correctly.



D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL GE INFORMATION 75

D20MX Substation Controller

Chapter 6: Configuring the Software

Configuring the Software

This chapter provides:

• An introduction to the software components used in the D20MX

• Customer service shell access

• D20MX User Accounts

• How to download image files to the Flash memory on your D20MX module on your 
system using a serial or network connection

• How to download a Hardware Support Package to the D20MX

• How to transfer D20 configurations to the D20MX

• How to update D20 configurations to use the D20MX firmware definition

• Software (feature) licensing

• How to configure serial expansion

Introduction to the D20MX software

The D20MX main processor board requires four valid files to be loaded:

• An operating system image file, called “vxWorks”, which resides in the file system on 
Flash memory

• An application image file, called “appl.out”, which resides in the file system on Flash 
memory

• A configuration file which resides in the NVRAM

• A Hardware Support Package (HSP) file, called “hsp.tar”, that resides in the file system 
on Flash memory.

Use this section to load the above files into your RTU system.

Image file terms The following terms are used throughout this chapter of the manual when referring to the 
image files:

• Collectively the files vxWorks and appl.out are to be referred to as “image files”

• vxWorks refers to the “operating system image file”

• appl.out refers to the “application image file”
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Hardware Support 
Package

The HSP is a collection of low level firmware files that provide boot loading support and 
low level hardware functionality defined by Field-Programmable Gate Array (FPGA) 
configuration information. The boot loading support consists of the JMON and Bootrom 
files. The HSP also includes an Emergency Recovery Image (ERI) that runs only during the 
HSP upgrade procedure to program the FPGAs.
There are two HSP files with the V1.5x release: one for each of the baud rates supported by 
the console port of the D20MX (i.e., 9600 and 19200 baud). The name of the HSP file 
indicates the baud rate of the console port and the version of the release. For example: 
hsp_v140_9600.tar is the v1.40 HSP release for a 9600 baud console port.

Customer service shell access

In certain cases, GE customer service may require access to a low-level shell called the “C” 
shell in the D20MX in order to troubleshoot a problem. The “C” shell is accessible from the 
D20M shell by typing c. To leave the shell, type exit .
The “C” shell can only be accessed from an RS232 port of the D20MX, and it must be 
enabled by a user whose “Monitor Access Level” is Read/Write (i.e., Administrator role). 
Once the “C” shell is enabled, only a user whose “Monitor Access Level” is Maintenance (i.e., 
Engineer role) or Read/Write is able to access the “C” shell.
“C” shell access is enabled by typing eds in the D20M shell. The eds command takes a 
parameter which defines how many seconds that a user is allowed to enter the “C” shell. 
Until the eds timer expires, a user with appropriate access is allowed to enter or re-enter 
the “C” shell as many times as required. After the eds timer expires, entry to the “C” shell is 
no longer allowed. If the parameter is not specified, the default timeout is 300 seconds 
(5 minutes).
A user log is generated each time a user runs the eds command or enters the “C” shell.

D20MX user accounts 

The D20MX supports the following types of user accounts:

• Remote and local user accounts

• Factory default user account

• System default user account

Remote and local user accounts
The D20MX supports remote and local user accounts. Use remote user accounts whenever 
possible to increase the level of security and to decrease user administration effort. To 
implement remote user accounts, the D20MX uses Remote Authentication Dial-In User 
Service (RADIUS) with CHAP, EAP-TTLS and PEAP authentication methods. Refer to the 
B014-1NCG WESMAINT II+ for the D20MX Configuration Guide for details on how to 
configure the D20MX to use RADIUS.
When RADIUS is used, your RADIUS server provides a role ID to the D20MX. The role ID 
defines which commands and displays the user is allowed to access while logged in to the 
D20MX. To allow your RADIUS server to provide a role ID, configure your RADIUS server to 
use the GE vendor profile that is common to many Multilin products. Refer to the B014-
1NCG WESMAINT II+ for the D20MX Configuration Guide for details on how to configure 
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your RADIUS server and the D20MX with the GE vendor profile. Also refer to Appendix A, 
Default Role-Based Access Control Model for the default role based access control model 
provided with the D20MX default configurations.
In the event all configured RADIUS servers are down or if RADIUS is not configured, the 
D20MX authenticates the user against the local configuration and password file. Local 
users are created with a default password of changeme. Use the passwd command from 
the D20MX SHELL prompt to change the default password to a strong password as soon 
as possible after downloading the configuration.   Refer to the B014-1NCG WESMAINT II+ 
for the D20MX Configuration Guide for details on how to configure local user accounts and 
change the password of a user. 

Factory default user account 
The factory default configurations for the D20MX come with one default user account with:
•  username: admin
•  password: changeme
Replace this account or change the password for this account as soon as possible. Refer to 
the B014-1NCG WESMAINT II+ for the D20MX Configuration Guide for details on how to 
modify user accounts and how to change the password of a user. 

System default user account
The D20MX configuration can be defaulted by pressing CTRL-F on a terminal connected 
over the front RS232 port during startup. In addition, if the D20MX detects a corrupt 
configuration on startup, it generates a system default configuration. The system default 
configuration comes with one user account:
• username: recover
• password: system
Login with this username and synchronize a configuration to the D20MX over the front 
RS232 port. 

NOTE

The D20MX can only be accessed over the front RS232 port with the system default 
configuration.

If you synchronize a configuration with any of the following errors:

• There are no usernames configured in the B014 User table,

• The B014 User table is disabled, or

• The B014 application definition does not match the firmware version, 

then the applications do not start and you only have serial access in debug mode.
Login with the system default username over the front RS232 port and synchronize a 
correct configuration.

Download image files to the D20MX

When to download
Instances where you may need to download an operating system or application image file 
to your D20MX:

• When a new version of the operating system or application image has been released.

• If the D20MX has performed self-diagnostics and determined that the application 
image file is either missing or corrupted.



78 GE INFORMATION D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL

CHAPTER 6: CONFIGURING THE SOFTWARE

• After maintenance or replacement work that has deleted the application file.

Prerequisites for image download
The following items must be available before an application or operating system image file 
can be loaded into a D20MX over a serial or network link:

• Windows PC with SGConfig version 8.1 and higher software.

• The application firmware file, preferably located on a local hard drive.
This file is to be named: appl.out.

• The operating system image file, preferably located on a local hard drive.
This file is to be named: vxWorks.

• The D20MX module must be installed into a D20 chassis, ready to power-up.

Prerequisite for image 
download over a 

serial link

The following item must be available before an application and operating system image 
file can be loaded into a D20MX over a serial link:

• A NULL modem cable (GE Energy part number 977-0529) connecting the RS-232 
connector on the front panel of the D20MX to the serial communications port of a PC 
or terminal. 

Prerequisite for image 
download over a 

network link

The following items must be available before an application and operating system image 
file can be loaded into a D20MX over the network:

• An Ethernet switch and appropriate Ethernet patch cables to connect your PC's 
Network Adapter and the D20MX's Ethernet port 1 to the switch.

• The D20MX contains a configuration file with LAN enabled and an IP address that 
matches the one configured in SGConfig.

• The PC's Network Adapter is configured with an IP address on the same network as 
the IP address of the D20MX.

Download software over a serial connection
To download software to the D20MX:

1. Set up Tera Term on a PC. See section: “Set up Tera Term on a PC” on page 78.

2. Download application image file to the D20MX over a serial connection. See section: 
“Download image files to the D20MX over a serial link” on page 79.

This comprises:

– Application files

– Operating system files

Set up Tera Term on a 
PC

To set up the Tera Term on a PC:

1. Connect a NULL modem cable (GE Energy part number 977-0529) from the RS-232 
connector on the front panel of the D20MX to the serial communications port of the 
PC or terminal.

2. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

3. Open a project containing a D20MX device.

Result: The project's Main Page appears.

4. Click on a D20MX device.

Result: The ribbon changes to include the Communications group.
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5. Click Configure ribbon group > Communications > Connect drop-down list > Tera 
Term.

Result: Tera Term: New connection dialog appears

6. Click Serial and select the communications port on your PC from the Port drop-down 
list. 

7. Click OK.

Result: Tera Term: New connection dialog closes

Result: The Tera Term VT window appears

8. Select Setup > Serial port…

Result: Tera Term: Serial port setup dialog appears

9. Verify (or set) terminal communication settings as follows:

10. Click OK.

Result: The Tera Term settings are now configured.

Download image files 
to the D20MX over a 

serial link

Note:   For a redundant system, download image files to the standby D20MX first. Then 
switch-over and download image files to the new standby D20MX.
To download application and operating system image files to a D20MX module:

1. Restart the D20MX.

Result: The startup messages appear.

2. When the message “Press Ctrl-E to enter debug mode” appears, press Ctrl-E within 3 
seconds.

Result: The login dialog appears.

3. Log in:

– For User: type a username that has Maintenance or Read/Write Access and press 
Enter, 

– For Password: type the password and press Enter. 

Result: The D20M> prompt appears.

4. Optional: Speed-up communications to shorten download time.

Type Baud 115200 and press Enter.

Note: Select 57600 or 38400 if communications errors have occurred previously. Such 
errors can occur due to the presence of ambient EMI, a long cable length, a PC with 
communication limitations due to CPU speed or when using some serial to USB 
adapters. 

Result: The D20MX is now communicating at 115,200 baud.

4.1. Select Setup > Serial port…
Result: Tera Term: Serial port setup dialog appears.

4.2. Select 115,200 from the Baud Rate drop-down list. 

Setting Value

Port: COM1 or COM2, or as required by the computer you are using.

Baud Rate baud rate of the D20MX (9600 or 19200 bps)
See “RS-232” on page 63 if you need to change the baud rate.

Data 8 bit

Parity none

Stop 1 bit

Flow Control Xon/Xoff

Transmit delay 0 msec/char; 0 msec/line
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4.3. Click OK.
Result: Tera Term main window appears and is communicating at 115,200 
baud.

5. Download the application image file:

5.1. Press Enter to verify that communication is active. 
Result: The D20M> prompt appears if the connection is active.

5.2. Type rz and press Enter to put the D20MX into the state where it is ready to 
receive the downloadable code file

5.3. Click File > Transfer > ZMODEM > Send from menu bar
Result: A dialog box opens, prompting you to locate the appl.out file that you 
wish to download.

5.4. Select the correct file, and click Open to start the transfer

NOTE

Do not press any keys on keyboard and do not move the Tera Term window 
during download.
Result: The file transfer may take from less than 10 to over 30 minutes, 
depending on communication speed selected. 
When complete, the D20M> prompt appears.

6. Download the operating system image file

6.1. Press Enter to verify that communication is active. 
Result: The D20M> prompt returns if connection is active

6.2. Type rz and press Enter to put the D20MX into the state where it is ready to 
receive the downloadable code file.

6.3. Click File > ZMODEM > Send from menu bar.
Result: A dialog box appears, prompting you to locate the vxWorks file that you 
wish to download.

6.4. Select the correct file, and click Open to start the transfer

NOTE

Do not press any keys on keyboard and do not move the Tera Term window 
during download.
Result: The file transfer may take from less than 10 to over 30 minutes, 
depending on communication speed selected. 
When complete, the D20M> prompt appears.

7. Type al 0 to ensure the autologout timer does not interrupt the copy to flash.

8. Type cf to copy the image files to flash.

Result: The copy may take a few minutes to complete. When complete, the D20M> 
prompt appears.

9. Type el /r to ensure that log is clear.

10. Type boot to restart device.

Result: The image file load is completed.

The flash memory of the D20MX now has the new application and operating system 
image file loaded.

Configuration File 
Download

You can use standard SGConfig procedures to download a configuration file over the serial 
port.

Download image files over a network connection

Procedure To download application and operating system image files to the D20MX over a network 
connection:
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NOTE

In the event that you have selected dialog checkbox “Do not show this message again”, 
some of the following steps do not appear. Accordingly, ignore the affected steps.

1. Connect Ethernet port 1 of the D20MX to the Ethernet switch using the appropriate 
Ethernet patch cable. 

2. Connect the PC's network adapter to the Ethernet switch using the appropriate 
Ethernet patch cable.

3. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

4. Open a project containing the target D20MX device.

Result: The project's Main Page appears. 

5. Click on the D20MX device.

Result: The Communications group appears in the ribbon.

6. Click Configure ribbon group > Communications > Options.

Result: D2x Device Communication Options dialog appears

7. Click Interface tab > Connection Type > iSCS LAN and select the Preferred LAN you 
wish to use, either LAN A or LAN B. This is most likely to be LAN A. 

8. Click OK.

Result: D2x Device Communication Options dialog closes.

9. Click Edit ribbon group > Properties.

Result: The D20MX Device Wizard appears

10. Click Next .

Result: The Project LAN properties appear.

11. Click Next .

Result: The hardware and other properties appear for the device.

12. Click Processor tab > Code Image sub-tab. 

13. Click the button with the ellipsis (…).

Result: The Select Flash image file dialog appears.

14. Navigate to the folder containing the appl.out file and vxWorks file. 

15. Select the appl.out file and click Open.

Result: The full pathname of the appl.out file appears in the Flash Image File box.

Note: To transfer the operating system image, simply ensure that a vxWorks file exists 
in the same folder as the selected appl.out file. SGConfig automatically transfers both 
files to the D20MX even though you only selected the appl.out file. 

16. Click Next . 

17. Click Finish.

Result: The project's Main Page appears with the D20MX device selected.

18. Click the ribbon Configure group > Configuration > Generate.

19. Confirm that there are zero errors in the Device Log.

20. Click the ribbon Communications group > Firmware transfer.

Result: Warning message appears and confirmation to continue is requested.

21. Acknowledge the warning and click Yes to continue or No to abort the operation.
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Result: If Yes is selected, then refer to the following table. If No is selected, the 
operation is aborted.

22. Choose one of the following options:

– If the default standby IP address is not the correct one, click the Standby IP 
address checkbox and in the associated IP address field, enter the IP address of 
the standby unit.  
Tip:   Click Help for information on how to determine the Standby IP address.

– Click the Active IP address checkbox. 

23. Click OK.

Result: A login dialog appears.

24. Enter a User Name that has Maintenance or Read/Write access. Enter the associated 
Password.

Result: The firmware transfer takes place. A dialog indicating the transfer and reboot is 
taking place is presented. The unit is rebooted once the transfer finishes. Once the 
reboot completes, the dialog disappears. The whole operation can take up to 8 
minutes.

The flash memory of the D20MX now has the new application and operating system 
image file loaded.

25. If the D20MX was configured for device redundancy, you may switch over the D20MX 
and repeat the above steps for the other unit.

Configuration file 
download

You can use standard SGConfig procedures to download a configuration file over the 
network.

Firmware integrity
The D20MX firmware uses a Firmware Integrity checking mechanism. This mechanism 
consists of a Primary and Secondary storage system, internal to the D20MX, for the 
firmware files and an MD5 checksum on the individual firmware files.
Two D20M Shell commands: commit and revert copy the firmware files from the Primary 
storage to the Secondary (commit), or from the Secondary to the Primary (revert).
The D20MX determines which set of files (Primary or Secondary storage) to use when 
starting up by:

1. Testing the integrity of the D20MX firmware files in the Primary storage. 

2. If the integrity check of the Primary storage files is valid, the D20MX starts up with the 
Primary storage files.

3. If the integrity check of the Primary storage files fails, the D20MX tests the integrity of 
the firmware files in the Secondary.

4. If the integrity of the Secondary storage files is valid, the D20MX starts up with 
Secondary storage files.

5. If the integrity of the Secondary storage files fails, the D20MX defaults to the Boot 
ROM command prompt. 

Possible Result if Yes is Selected When to expect this result Go to step

Select Target IP Address dialog 
appears

If the D20MX is configured for device 
redundancy.

22

Login dialog appears If the D20MX is not configured for device 
redundancy.

24
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Committing new firmware
After new firmware has been downloaded (either via serial or network connection), and the 
D20MX has restarted and is operating correctly, the firmware must be “committed” to the 
secondary storage.

Once the new firmware is committed, you cannot revert to the old version of the firmware; 
see Section: “Reverting to old firmware” on page 83.

To commit new firmware:

1. Login as a user that has Maintenance or Read/Write access privileges.

2. Enter the D20M Shell.

3. Enter the commit command. 

Result: A prompt appears to confirm copying the firmware from Primary to Secondary.

4. Enter yes to confirm the copy operation. If anything else is entered, the command is 
canceled.

Result: The firmware copy operation begins. Both 'vxworks' and 'appl.out' are copied.

This operation takes approximately 3 minutes.

DO NOT shut off the power to the D20MX while the copy operation is in progress. If power 
to the D20MX is disrupted, during the copy operation, the firmware is likely to be corrupted.

If the D20MX is configured for device redundancy, perform this procedure on the standby 
unit. Then if desired, switch over and perform this on the other unit.

Reverting to old firmware
A previously committed version of the firmware (i.e., old firmware) may be recovered from 
secondary storage.
This feature is intended to be used if, after downloading a new version of the firmware, an 
issue is identified and you wish to recover the previous version of the firmware. A revert is 
only possible if the new firmware has not been committed; see Section: “Committing new 
firmware” on page 82.
To revert the firmware:

1. Login as a user that has Maintenance or Read/Write access privileges.

2. Enter the D20M Shell.

3. Enter the revert command 

Result: A prompt appears to confirm copying the firmware from Secondary to Primary.

4. Enter yes to confirm the copy operation. If anything else is entered, the command is 
canceled.

Result: The firmware copy operation begins. Both 'vxworks' and 'appl.out' are copied.

This operation takes approximately 3 minutes.

DO NOT shut off the power to the D20MX while the copy operation is in progress. If power 
to the D20MX is disrupted, during the copy operation, the firmware is likely to be corrupted.

5. Once the copy operation has completed, enter the boot command to restart the 
D20MX with the reverted firmware.
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Download Hardware Support Package to the D20MX

When to download
Instances where you may need to download an HSP to your D20MX:

• When a new version of the D20MX firmware and HSP is released. In this case, make 
sure you upgrade the firmware first.

• After upgrading the firmware and HSP, you may decide to downgrade to the previous 
release. In this case, downgrade the HSP first.

Prerequisites for HSP download
The following items must be available before an HSP file can be loaded into a D20MX:

• Windows PC with SGConfig version 8.2 and higher software.

• D20MX Documentation CD (part number 588-0075 V1.5x) in either of the following 
formats:

– Physical CD media, or

– Zip file

• A NULL modem cable (GE part number 977-0529) connecting the RS-232 connector 
on the front panel of the D20MX to the serial communications port of the PC.

In addition, the following additional prerequisites must be met:

• You have local access to the D20MX because the last step of the procedure may 
involve power cycling the D20MX.

• You have taken precautions to ensure power will not be interrupted while you are 
running this procedure.

• You have allocated about 1 hour to perform the whole operation.

Prerequisites for HSP download over a network link
The following items must be available before an HSP file can be transferred into a D20MX 
over the network:

• An Ethernet switch and appropriate Ethernet patch cables to connect your PC's 
Network Adapter and the D20MX's Ethernet port 1 to the switch.

• The D20MX contains a configuration file with LAN enabled and an IP address that 
matches the one configured in SGConfig.

• The PC's Network Adapter is configured with an IP address on the same network as 
the IP address of the D20MX.

Download HSP over a serial connection
To download an HSP file to the D20MX over a serial connection:

1. Stage HSP file for SGConfig. See section: “Stage HSP File for SGConfig” on page 85

2. Set up Tera Term on a PC. See section: “Set up Tera Term on a PC” on page 78. 

3. Stage HSP file for serial transfer. See section: “Stage HSP File for Serial Transfer” on 
page 86

4. Transfer HSP file to the D20MX over a serial connection. See section: “Transfer HSP file 
to the D20MX over a serial link” on page 87

5. Apply HSP. See section: “Apply HSP” on page 89.
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6. If the D20MX is configured for device redundancy, you may switch over the D20MX 
and repeat the previous two steps for the other unit.

Download HSP over a network connection
To download an HSP file to the D20MX over a network connection:

1. Stage HSP file for SGConfig. See section “Stage HSP File for SGConfig” on page 85.

2. Transfer HSP file over a network connection. See section “Transfer HSP over a network 
connection” on page 88

3. Apply HSP. See section “Apply HSP” on page 89.

4. If the D20MX is configured for device redundancy, you may switch over the D20MX 
and repeat the previous 2 steps for the other unit.

Stage HSP File for SGConfig
1. Press the Windows Key  and E at the same time

Result: The Windows Explorer window appears.

2. Navigate to a folder to which you have write permissions.

Result: The content of the folder is displayed.

3. Click the New folder button in Windows Explorer

Result: A new folder is created with the name “New folder” and the cursor is positioned 
to allow renaming of the folder.

4. Rename the folder (e.g., D20MX). This folder is called the staging folder in the 
remaining steps of this procedure.

Result: The folder is renamed.

5. Do either of the following:
– Insert the D20MX Documentation CD into the computer's DVD/CD drive, or
– Extract then CD zip file on to the root of your C: drive and double click the 

readme.html file under the ISO-Image sub-folder, which is nested two levels 
deep into the extracted folder.

Result: The Documentation CD home page appears in your default Web Browser.

Alternate result for “Insert the D20MX Documentation CD”: The home page does 
not appear in your default Web Browser. In this case, navigate to the CD in 
Windows Explorer, and double-click the readme.html file on the root of the CD.

6. Click on the link named D20MX Firmware Files.

Result: The Firmware Files folder is displayed. It contains folders named HSP, 
SAN0001.15X and SAN0002.15X.

7. Using Windows Explorer, navigate to the SAN0001.15X sub-folder under the Firmware 
Files folder and copy/paste the files as shown in the following table. 

To copy a file, select it and press Ctrl-C. To paste a file, click on the Windows Explorer 
window showing the staging folder created in step 4 and press Ctrl-V.

Result: The Windows Explorer window showing the staging folder is displaying the files 
shown in the above table.

Navigate to folder on D20MX Documentation CD 
or Folder extracted from Zip File

Copy/Paste the following files to the 
staging folder created in step 4

Firmware Files\SAN0001.15X appl.out
VxWorks
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8. If you are upgrading the HSP, decide which baud rate you want COM0 to operate at, 
and copy/paste one of the files as shown in the following table.

Result: The Windows Explorer window showing the staging folder is displaying one of 
the tar files shown above.

9. If you are downgrading the HSP, refer to the README.TXT file in the Firmware 
Files\HSP\Archive folder to determine which HSP version was used in the original 
firmware version. Then, copy/paste the corresponding file as shown in the following 
table. 

Result: The Windows Explorer window showing the staging folder is displaying one of 
the tar files shown above.

10. Start SGConfig, 

Result: The Welcome to SGConfig screen appears. 

11. Open the project containing the configuration of the target D20MX device. 

Result: The project's Main Page appears. 

12. Select the target D20MX device and click the ribbon Configure group > Configuration 
> Hardware. 

Result: The D20MX Device Wizard appears 

13. Click Processor tab > Code Image sub-tab. Click the button with the ellipsis (…). 

Result: The Select Flash image file dialog appears.

14. Navigate to the staging folder created in step 4. Select the appl.out file and click Open. 

Result: The full pathname of the appl.out file appears in the Flash Image File box. 

15. Click OK. 

Result: The project's Main Page appears with the D20MX device selected.

16. Generate the device configuration:

16.1. Click the Project tab for the D20MX device configuration.

16.2. Click the D20MX device.

16.3. Click the ribbon Configure group > Configuration > Generate.

Stage HSP File for Serial Transfer
1. Press the Windows Key  and E at the same time.

Result: The Windows Explorer window appears.

2. Navigate to a folder to which you have write permissions.

Result: The content of the folder is displayed.

3. Click the New folder button in Windows Explorer

Result: A new folder is created with the name “New folder” and the cursor is positioned 
to allow renaming of the folder.

4. Rename the folder (e.g., D20MXHSP). This folder is called the staging folder in the 
remaining steps of this procedure. 

If the desired baud 
rate for COM0 is ...

Navigate to folder on D20MX 
Documentation CD or Folder 
extracted from Zip File

Copy/Paste the following file to the 
staging folder created in step 4

19200 Firmware Files\HSP hsp_v15X_19200.tar

9600 Firmware Files\HSP hsp_v15X_9600.tar

Navigate to folder on D20MX Documentation CD 
or folder extracted from Zip file ...

Copy/Paste the following files to the 
staging folder created in step 4

Firmware Files\HSP\Archive hsp_v1XX_19200.tar or 
hsp_V1XX_9600.tar
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NOTE

Do not use the code image folder that you would select from SGConfig to contain 
appl.out for a firmware transfer.

Result: The folder is renamed.

5. Do either of the following:

– Insert the D20MX Documentation CD into the computer's DVD/CD drive, or

– Extract the D20MX Documentation CD zip file on to the root of your C: drive and 
double click the readme.html file under the ISO-Image sub-folder, which is 
nested two levels deep into the extracted folder.

Result: The Documentation CD home page appears in your default Web Browser.

Alternate result for “Insert the D20MX Documentation CD”: The home page does 
not appear in your default Web Browser. In this case, navigate to the CD in 
Windows Explorer, and double-click the readme.html file on the root of the CD.

6. Click on the link named D20MX Firmware Files.

Result: The Firmware Files folder is displayed. It contains folders named HSP, 
SAN0001.15X and SAN0002.15X.

7. Using Windows Explorer, navigate to the SAN0001.15X sub-folder under the Firmware 
Files folder. If you are upgrading the HSP, decide which baud rate you want COM0 to 
operate at, and copy/paste one of the files as shown in the following table. To copy a 
file, select it and press Ctrl-C. To paste a file, click on the Windows Explorer window 
showing the staging folder created in step 4 and press Ctrl-V.

Result: The Windows Explorer window showing the staging folder is displaying one of 
the tar files shown above.

8. If you are downgrading the HSP, refer to the README.TXT file in the Firmware 
Files\HSP\Archive folder to determine which HSP version was used in the original 
firmware version. Then, copy/paste the corresponding file as shown in the following 
table. 

9. Rename the file copied in one of the previous two steps to hsp.tar. 

Result: The Windows Explorer window showing the staging folder is displaying the 
hsp.tar file.

Transfer HSP file to the D20MX over a serial link
To transfer an HSP file to a D20MX module: 

1. Restart the D20MX. (If this is a redundant system, restart only the standby D20MX).

Result: The startup messages appear. 

2. When the message “Press Ctrl-E to enter debug mode” appears, press Ctrl-E within 3 
seconds.

Result: The login dialog appears. 

If the desired baud 
rate for COM0 is ...

Navigate to folder on D20MX 
Documentation CD or Folder 
extracted from Zip File

Copy/Paste the following file to the 
staging folder created in step 4

19200 Firmware Files\HSP hsp_v140_19200.tar

9600 Firmware Files\HSP hsp_v140_9600.tar

Navigate to folder on D20MX Documentation CD 
or folder extracted from Zip file ...

Copy/Paste the following files to the 
staging folder created in step 4

Firmware Files\HSP\Archive hsp_v1XX_19200.tar or 
hsp_V1XX_9600.tar
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3. Log in: 

– For User: type a username that has Maintenance or Read/Write Access and press 
Enter. 

– For Password: type the password and press Enter. 

Result: The D20M> prompt appears. 

4. Optional: Speed-up communications to shorten download time

Type Baud 115200 and press Enter.

NOTE

Select 57600 or 38400 if communications errors have occurred previously. Such errors 
can occur due to the presence of ambient EMI, a long cable length, a PC with 
communication limitations due to CPU speed or when using some serial to USB 
adapters. 

Result: The D20MX is now communicating at 115,200 baud. 

4.1. Select Setup > Serial port… 
Result: Tera Term: Serial port setup dialog appears. 

4.2. Select 115,200 from the Baud Rate drop-down list. 

4.3. Click OK.
Result: TeraTerm main window appears and is communicating at 115,200 
baud. 

5. Transfer the HSP file: 

5.1. Press Enter to verify that communication is active. 
Result: The D20M> prompt appears if the connection is active. 

5.2.  Type rz and press Enter to put the D20MX into the state where it is ready to 
receive the downloadable code file 

5.3. Click File > Transfer > ZMODEM > Send from menu bar. 
Result: A dialog box opens, prompting you to locate the hsp.tar file that you 
wish to download.

5.4. Select the hsp.tar file from the folder created in step 4 of “Stage HSP File for 
Serial Transfer”, and click Open to start the transfer.

NOTE

Do not press any keys on keyboard and do not move the TeraTerm window 
during download.

Result: The file transfer may take from less than 10 to over 30 minutes, depending on 
communication speed selected. When complete, the D20M> prompt appears. 

6. Optional: If you had changed the baud rate prior to the transfer, change the baud rate 
back to the original baud rate.

If the original baud rate was 9600, type Baud 9600 and press Enter.

If the original baud rate was 19200, type Baud 19200 and press Enter.

Result: The D20MX is now communicating at 9600 or 19200 baud. 

6.1. Select Setup > Serial port… 
Result: TeraTerm: Serial port setup dialog appears. 

6.2. Select 9600 or 19200 from the Baud Rate drop-down list. 

6.3. Click OK.
Result: TeraTerm main window appears and is communicating at 9600 or 
19200 baud. 

7. Close the TeraTerm window.
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Transfer HSP over a network connection
To transfer an HSP file to the D20MX over a network connection: 

1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Open the project containing the configuration of the target D20MX device. 

Result: The project's Main Page appears. 

3. Click on the D20MX device. 

Result: The Communications group appears in the ribbon. 

4. Change the communication options to enable LAN communication with the D20MX. 
Click the SGConfig ribbon Configure group > Communications > Options.

Result: The D2x Device Communication Options dialog box opens.

5. Click the Interface tab the in the Connection Type group select iSCS LAN, then select 
the Preferred LAN you wish to use, either LAN A or LAN B. This will most likely be LAN A.

Result: The iSCS LAN option is selected.

6. Click OK to close the D2x Device Communication Options dialog box

Result: The dialog box is closed and the SGConfig ribbon Configure group > 
Communications > Firmware transfer pick list is now active.

7. Click the Configure group > Communications > Firmware transfer > HSP transfer. 

Result: A dialog displaying a warning appears.

8. Read the warning then click Yes to continue or No to abort the operation.

Result: If Yes is selected, then refer to the following table. If No is selected, the 
operation is aborted.

9. Ensure the Standby IP checkbox is checked and if not, check it . In the associated IP 
address field, ensure the IP address of the standby unit address is displayed and if 
not, enter it .

TIP

Click Help for information on how to determine the Standby IP address. 

10. Click OK. 

Result: A login dialog appears. 

11. Enter the User Name and Password of an account having SHELL access level of 
Maintenance or higher and click Login. 

Result: The Login dialog box closes, and the Transferring HSP dialog box opens. The 
HSP transfer takes place. When the transfer is complete, the Transferring HSP dialog 
box closes, and the HSP Transferred successfully dialog box opens.

12. Click OK to close the HSP Transferred successfully dialog box.

Result: The dialog box closes.

Possible Result if Yes is Selected When to expect this result Go to step

Select Target IP Address dialog 
appears

If the D20MX is configured for device 
redundancy

step 10

Login dialog appears If the D20MX is configured for standalone 
operation

step 12
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Apply HSP
1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Open the project containing the configuration of the target D20MX device. 

Result: The project's Main Page appears. 

3. Change the communication options to enable serial communication with the D20MX.

3.1. Click the SGConfig ribbon Configure group > Communications > Options.
Result: The D2x Device Communication Options dialog box opens. 

3.2. Click the Interface tab; in the Connection Type group select Direct Serial. If 
necessary, select the Communication Port , and in the Port Setting tab, select 
the Baud Rate as follows: 

Result: The Direct Serial option is selected. 

3.3. Click OK to close D2x Device Communication Options dialog box
Result: The dialog box closes.

4. Click the SGConfig ribbon Configure group > Communications > Connect to open the 
terminal emulator.

Result: The Terminal Emulator tab appears. 

5. If WESMAINT is running, press Enter to get the WESMAINT login screen. 

Result: The WESMAINT login screen appears

6. Enter a User Name and Password of a user account having SHELL access level of 
Maintenance or higher.

7. If WESMAINT is running, navigate to the D20MX SHELL using the WESMAINT menu 
items 2 followed by 3. Wait for the countdown, then press Enter several times.

Result: The D20M> prompt appears

8. Apply the HSP by clicking the SGConfig ribbon Configure group > Actions > Apply HSP.

Result: A dialog box displaying a warning opens. 

9. Read the warning then click Yes to close the warning dialog box.

Result: The warning dialog box closes and the Applying HSP dialog box opens.

10. The terminal emulator screen shows the progress of the HSP update.

11. This process can take 5 minutes to 1/2 hour to apply the HSP depending on which 
components are updated.

12. When complete, there are two possibilities

– An Information dialog box asks you to toggle the power switch on the D20MX. If 
so, perform the following steps:

12.1. Click OK to close the information dialog box.
Result: The dialog box closes.

12.2. Toggle the power switch on the D20MX.
Result: The D20MX restarts with the new JMON, Bootrom and FPGA.

– An information dialog indicates the operation is complete. If so, just click OK to 
close the information dialog box.

13. Close the SGConfig Terminal Emulator.

Baud Rate When to set this baud rate

The baud rate of the D20MX console port which is either 
9600 or 19200 baud and can be changed with the JBAUD 
command.

If the D20MX is configured 
for device redundancy

The baud rate configured for COM0 in WESMAINT If the D20MX is configured 
for standalone operation
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Transfer D20/D200 configurations to the D20MX 

Use this information to transfer existing D20 and D200 device configurations to the D20MX 
using either ConfigPro or SGConfig.

Transferring a multi-processor D200 only transfers the application configurations on the 
first processor.
This is manually resolved by moving applications from other processors to the first 
processor using the SGConfig device editing functions BEFORE converting the device to a 
D20MX in the instructions below.

NOTE

The word “transfer” is used within the context of this guide to mean that the device 
configuration files are moved and modified, in order to work properly on a D20 with a 
D20MX processor.

Transfer existing D20 or D200 configurations to the D20MX

Prerequisites Before you can transfer a D20 or D200 device configuration, the following components 
must be present:

• SGConfig installed on the configuration computer. The minimum SGConfig version 
supported is 8.1.

• D20MX Documentation CD (part number 588-0075 VXX) in either of the following 
formats:

– Physical CD media, or 

– Zip file

• D20 or D200 Configuration has been migrated to SGConfig with the Migration Wizard 
(Refer to the Migration Wizard screencast). 

Note: The Migration Wizard supports ConfigPro 2.0 and higher configurations.

• To save time, you may upgrade the firmware definition of your D20 or D200 
Configuration to SAN0001 or SAN0002 in ConfigProTM 5.03 or higher. If you choose 
this option and are updating a:

– D20 device configuration, perform the steps in section:

“Updating a D20 configuration to use the D20MX firmware definition with 
ConfigPro” on page 97.

– D200 device configuration, perform the steps in the following sections:

1. “Updating a D200 configuration to use the D20MX firmware definition with 
ConfigPro” on page 100.

2. “Updating a D20 configuration to use the D20MX firmware definition with 
ConfigPro” on page 97.

• A NULL modem cable (GE part number 977-0529) connecting the RS-232 connector 
on the front panel of the D20MX to the serial communications port of the 
configuration computer.
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Procedure To transfer a D20 or D200 device configuration to the D20MX:

NOTE

In the event that you have selected dialog checkbox “Do not show this message 
again”, some of the following steps do not appear. Accordingly, ignore the affected 
steps. 

1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Choose the D20MX Factory Default Configuration file, D20MX01-XX.7zip or D20MX02-
XX.7zip. based on the following criteria:

– If transferring a configuration containing B009 versions greater than 310 and 
B021 versions greater than 912 use the file D20MX01-XX.7zip

– If transferring a configuration containing B009 versions less than or equal to 310 
and B021 versions less than or equal to 912, use the file D20MX02-XX.7zip. 

3. If the D20MX01-XX or D20MX02-XX default configuration has already been imported, 
go to step 4 to open the default configuration. Otherwise perform these sub-steps:

3.1. Click GE button > Archive > Project > Restore.
Result: The Restore Project Details window appears.

3.2. Click … .
Result: The Select a File window appears.

3.3. Navigate to the DVD/CD drive or the ISO Image sub-folder nested two levels 
into the folder extracted from the D20MX Documentation CD zip file. Then 
navigate to Configuration Files > SGConfig.
Result: The two files D20MX01-XX.zip and D20MX02-XX.zip appear in the dialog. 

3.4. Select the appropriate file based on your decision in step 2. 

3.5. Click OK. 
Result: On completion a pop-up message appears (e.g., Project D20MX01-XX 
has been restored). 

3.6. Click OK.

4. Open the SGConfig project containing the D20 or D200 device.:

4.1. Click the GE button.

4.2. Click the required SGConfig project in the Recent Projects list or select the 
Open Project menu item.

5. Make a backup copy of the original D20 or D200 device configuration:

5.1. Click the Project tab of the original D20 or D200 device configuration. 

5.2. Click the D20 or D200 device.

5.3. Click the ribbon Configure group > Edit > Copy.

5.4. Click a blank area on the page onto which the copy is to be placed. 

5.5. Click the ribbon Configure group > Edit > Paste.
Result: The Copying device window appears. 
Result: Once completed a new device named COPY_OF_<original device 
name> or <original device name>_COPY appears. 

6. Change the device type to D20MX.

6.1. Click the Project tab of the original D20 or D200 device configuration.

6.2. Click the D20 or D200 device.

6.3. Click the ribbon Configure group > Configuration > Hardware > Processor > 
Change Type.
Result: The Change Device dialog appears.
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6.4. Select the D20MX type and click OK.
Result: A dialog is displayed indicating that the device type has been changed 
successfully.

6.5. Click OK.
Result: The device is now displayed as a D20MX.

7. Select a D20MX processor from the D20MX Device Wizard: 

7.1. Click the Project tab of the original D20 or D200 device configuration. 

7.2. Click the D20MX device.

7.3. Click the ribbon Configure group > Edit > Properties.

7.4. Click Next until the Processor tab appears.

7.5. Click the Processor tab > General sub-tab.

7.6. From the Part Number field, click Select .
Result: The Select a Processor Card window appears.

7.7. Select one of the three D20MX processor type part numbers (526-3001, 526-
3003 or 526-3005). 

7.8. Click OK, Next , and Finish.
Result: The D20MX Device Wizard closes.

8. Import the firmware definition from the factory default configuration (if you had opted 
to upgrade the firmware in ConfigPro, then this step is not necessary):

8.1. Click the Project tab of the original D20 or D200 device configuration.

8.2. Click anywhere on the main page of the project to deselect the device.

8.3. Click the ribbon Configure group > Miscellaneous > Firmware Library.
Result: The Firmware Library window appears with the firmware definition 
selected.

8.4. Select Import .
Result: The Firmware Import window appears.

8.5. From the Project Name drop down list, select D20MX01-XX or D20MX02-XX 
based on the decision taken in step 2.
Result: The SAN0001 or SAN0002 firmware appears in the Firmware Available 
list.

8.6. Click OK.
Result: The Firmware Library window reappears with the SAN0001 or SAN0002 
firmware in the list.

8.7. Click Close.
Result: The Firmware Library window closes.

9. Apply the firmware definition from the factory default configuration (if you had opted 
to upgrade the firmware in ConfigPro, then this step is not necessary).

9.1. Click the Project tab of the original D20 or D200 device configuration.

9.2. Click the D20MX device.

9.3. Click the ribbon Configure group > Edit > Properties.
Result: The D20MX Device Wizard Basic Settings window appears.

9.4. Click Next until the Processor tab appears.

9.5. Click the Firmware sub tab and Select .

9.6. Select either SAN0001/XX or SAN0002/XX as per the decision taken in step 2. 
Result: The Changing Device dialog appears. After some time it closes and the 
D20MX Device Wizard appears.
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9.7. Click Finish.
Result: The D20MX Device Wizard closes.

10. Import the RADIUS roles from the D20MX default configuration into the D20MX device:

10.1. Double-click the D20MX device.
Result: The Application List popup appears.

10.2. Double-click the WESMAINT II+ application.
Result: The WESMAINT II+ table icon set appears.

10.3. Right-click the RADIUS Role Table icon and select Import .
Result: The Select source directory dialog appears.

10.4. Navigate to the DVD/CD drive or the ISO Image sub-folder nested two levels 
into the folder extracted from the D20MX Documentation CD zip file. Then 
navigate to Configuration Files > DefaultTableSettings > B014-1 Wesmaint 
II+.
Result: The file B014RADR.CSV appears in the dialog.

10.5. Select the file named B014RADR.CSV, and click Open.
Result: The WESMAINT II+ table icon set re-appears.

10.6. Double-click the RADIUS Role Table icon.
Result: The RADIUS Role Table editor appears.

10.7. Compare the first column of the Access Flags sub-table (RADIUS Role Table > 
Application Control) to the following figure to confirm that the import was 
successful: 

10.8. Click OK, OK and Close.
Result: The WESMAINT II+ table editor closes.

11. If the D20 configuration being transferred is LAN-based, import the LAN Redundancy 
Manager point descriptors:

11.1. Click the Project tab of the original D20 or D200 device configuration.
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11.2. Double-click the D20MX device.
Result: The Application List popup appears.

11.3. Double-click the System Point Database application.
Result: The System Point Database Properties dialog appears.

11.4. Select LAN Redundancy Manager and click Descriptors.
Result: The Point Descriptors dialog appears.

11.5. Click on the Import button. 
Result: The Import Point Descriptors dialog appears.

11.6. Click OK.
Result: The Browse For Folder dialog appears.

11.7. Navigate to the DVD/CD drive or the ISO Image sub-folder nested two levels 
into the folder extracted from the D20MX Documentation CD zip file. Then 
navigate to Configuration Files > DefaultPointDescriptions > B119-1N LAN 
Redundancy Manager and click OK.
Result: The Point Descriptors dialog appears.

11.8. Confirm the point descriptors are as shown below.

11.9. Click OK, OK and Close.
Result: The main project window appears.

12. Optionally, update the RADIUS and SYSLOG settings in B014-1N (WESMAINT II+): 

12.1. Click the Project tab of the original D20 or D200 device configuration.

12.2. Double-click the D20MX device.
Result: The Application List popup appears.

12.3. Double-click the WESMAINT II+ application.
Result: The WESMAINT II+ table icon set appears.

12.4. Update the new tables: Remote RADIUS Servers Table, Remote Syslog Servers 
Table, TLS Auth Info Table, TLS CA Info Table, First PEM File Table, Second PEM 
File Table and Login Warning Banner Table, referring to the B014-1NCG 
WESMAINT II+ configuration guide.

13. If the configuration being transferred is LAN-based, generate the iSCS Configuration 
for the Project: 

13.1.  Click the Project tab of the original D20 or D200 device configuration.

13.2. Click: the D20MX device.



96 GE INFORMATION D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL

CHAPTER 6: CONFIGURING THE SOFTWARE

13.3.  Click the ribbon Configure group > iSCS > Generate. 

13.4. Confirm that there are zero errors in the Device Log; any Warnings are 
acceptable. 

14. If the configuration being transferred is not LAN-based, generate the configuration for 
the device:

14.1. Click the Project tab of the original D20 or D200 device configuration.

14.2. Click the D20MX device. 

14.3. Click the ribbon Configure group > Configuration > Generate.

14.4. Confirm that there are zero errors in the Device Log; any Warnings are 
acceptable.

15. Review warnings:

15.1. Click the Project tab of the original D20 or D200 device configuration.

15.2. Click the D20MX device.

15.3. Click the ribbon Configure group > Draw > select Output Window.
Result: The Device Log window appears.

15.4. Review all warnings and make corrections as needed, reviewing the backup 
copy to retrieve values that may have been replaced with default values during 
the transfer.

16.  Transfer the new configuration to the D20MX:

16.1. Click the Project tab of the original D20 or D200 device configuration 

16.2. Click: the D20MX device. 

16.3. Click the ribbon Configure group > Communications > Options.
Result: The Device Communication Options widow appears.

16.4. Click Interface tab > Connection Type. 

16.5. Select Direct Serial and change the Communications Port to the serial port 
that is connected to the D20MX. 
Result: The Communications Options window shows that Connection Type is 
set to Direct Serial and the Communications Port is set to the serial port 
connected to the D20MX. 

16.6. Click the Port Settings tab and set the Baud Rate to the baud rate of the 
D20MX (9600 or 19200 bps - see “RS-232” on page 63 if you need to change the 
baud rate), and select the Software Transmit and Software Receive 
checkboxes. Then click OK. 
Result: The D2x Device Communications Options dialog closes. 

16.7. Physically connect the PC's serial port using the RS232 NULL modem cable to 
either the front serial port of the: 

– Standby D20MX, if the D20MX is configured for device redundancy, or 

– Standalone D20MX, if the D20MX is configured for standalone operation. 

16.8. Click the Configure ribbon group > Communications group > Connect . 
Result: The Terminal Emulator window opens. 

16.9. Login to the D20MX using the username admin and password changeme. 
Result: The D20M> prompt appears. 

16.10. Click the Configure ribbon group > Actions> Sync To. 
Result: The Downloading Configuration File dialog appears showing the 
progress of the download. At the conclusion, a Confirm dialog appears with 
three buttons: Boot, Verify and Exit. 

16.11. Click Boot . 
Result: The D20MX reboots with the new configuration. 
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NOTE

All users that existed in the transferred D20/D200 configuration now have the default 
password: changeme. Change these passwords using the passwd command in the D20MX 
Shell. Refer to the WESMAINT II+ for D20MX Configuration Guide B014- 0NCG for details of 
this command.

NOTE

If the D20MX was configured for device redundancy, once the sync to operation is 
complete, the standby unit reboots and comes up again as standby with the new 
configuration. If desired, switch over and synchronize the new configuration to the other 
unit through the “Switch Over” and “Database Sync” functions available in the WESMAINT 
System Functions menu. Refer to the WESMAINT II+ for D20MX User's Guide B014-0NUG 
for details on these functions.

NOTE

When transferring a redundant D20/D200, ensure the new D20MX standby IP addresses 
do not conflict with other devices in the project or the secondary IP addresses described in 
the next note. If they do, you may disable the standby IP addresses or reassign them as 
described in “IP addresses” on page 60. If there are any conflicts, the WESMAINT error log 
of the D20MX will log warnings such as the following:

1 ROOT N0: W001: IP of RDT1 same as CCUB
Where RDT1 is the host name of the device with a conflicting IP address.

NOTE

When transferring a D200 configuration that contained network applications on node 2+:

1. Enter the node 2+ IP addresses of the original D200 configuration into the Hosts tab 
found in the LAN Properties under the D20 Device properties in SGConfig or the Project 
properties of ConfigPro.

2. Use the B119-1 LAN Redundancy Manager to create secondary IP addresses for the 
node 2+ IP addresses by referencing the host names created in the previous step. (See 
"B119-1NCG LAN Redundancy Manager for the D20MX" for further information).

3. In the network application (e.g., DNP3 Data Link) transferred from node 2+, change the 
Local Host Name field to contain the secondary host name. Refer to the configuration 
guides: "B052-0NCG DNP V3.00 Internet Data Link" or "B086-0CG IEC 60870-5-104 
Data Link" for further details. 

4. It is not necessary to enter the secondary host name for the MODBUS TCP/IP DPA 
A131-0.

5. If you are transferring the MODBUS TCP/IP DCA A135-0 from node 2+, then you need 
to ensure the IEDs accept the main IP address of the D20MX.

Updating a D20 configuration to use the D20MX firmware definition 
with ConfigPro

Use this information to update the firmware definition of an existing D20 device to the 
D20MX firmware definition. The result is a device archive that you can migrate into 
SGConfig for the purpose of transferring the D20 configuration to the D20MX. 

Prerequisites Before you can update the firmware definition of a D20 device configuration, the following 
components must be present:

• ConfigPro 5.03 or higher installed on the configuration computer.

Note: If you are using a ConfigPro version older than 5.03, skip this procedure and 
migrate your ConfigPro project archives directly into SGConfig. Then follow the 
procedure in section: “Transfer D20/D200 configurations to the D20MX” on page 91.

• D20MX Documentation CD (part no. 588-0075 VXX) in either of the following formats:

– Physical CD media, or 

– Zip file



98 GE INFORMATION D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL

CHAPTER 6: CONFIGURING THE SOFTWARE

Procedure To update a D20 or D200 device configuration to the D20MX:

1. Press the Windows Key  and E at the same time. 

Result: The Windows Explorer window appears.

2. Navigate to a folder to which you have write permissions.

Result: The content of the folder appears.

3. Click the New folder button in Windows Explorer

Result: A new folder is created with the name “New folder” and the cursor is positioned 
to allow renaming of the folder.

4. Rename the folder to D20MXVXX.

Result: The folder is renamed to D20MXVXX.

5. Access the D20MX Documentation CD files by either:

5.1. Insert the D20MX Documentation CD in to the computer’s DVD/CD drive, or

5.2. Extract the D20MX Documentation CD zip file on to the root of your C: drive and 
double click the readme.html file under the ISO-Image sub-folder, which is 
nested two levels deep into the extracted folder.

Result: The Documentation CD home page appears in your default Web Browser.

Result: Alternately for step 5.1, the home page does not appear in your default Web 
Browser. In this case, navigate to the CD in Windows Explorer, and double-click the 
readme.html file on the root of the CD.

6. Under the D20MX Factory Default Configuration Files section, click on the link 
named ConfigPro.

Result: The Factory Default Configuration Files folder appears.

7. Using Windows Explorer, copy/paste the files as shown in the following table. To copy 
a file, select it and press Ctrl-C. To paste a file, click on the Windows Explorer window 
showing the new D20MXVXX folder and press Ctrl-V.

Result: The files shown in the above table appear in the new D20MXVXX folder of the 
Windows Explorer window.

8. Start Config Pro 5.03 or higher.

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left.

9. Choose the D20MX Factory Default Configuration file, MX01-XX.zip or MX02-XX.zip. 
based on the following criteria:

– If transferring a configuration containing B009 versions greater than 310 and 
B021 versions greater than 912 use the file MX01-XX.zip

– If transferring a configuration containing B009 versions less than or equal to 310 
and B021 versions less than or equal to 912, use the file MX02-XX.zip.

10. If the MX01-XX or MX02-XX default configuration has already been imported, go to 
step 18. Otherwise, select from the menu bar Project > Archive Project > Restore.

Result: The Restore Project from ZIP File dialog appears

11. Under the Select Source Project ZIP File area, click the document icon.

Result: The Select a Project ZIP file to Restore dialog appears.

12. Navigate to the new D20MXVXX folder.

Result: The two files MX01-XX.zip and MX02-XX.zip appear in the dialog.

Navigate to folder on D20MX Documentation CD or 
Folder extracted from the Zip File

Copy/Paste the following files to the 
new folder D20MXVXX

MX01-XX.zip MX01-XX.zip

MX02-XX.zip MX02-XX.zip
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13. Select the appropriate file based on your decision made in the second step and click 
the Select button.

Result: The Restore Project from ZIP File dialog appears with the selected file showing 
under the Select Source Project ZIP File area.

14. Under the “Restore To” area, click the folder icon.

Result: The Select the Destination Project Directory dialog appears.

15. Navigate to your ConfigPro project folder on a hard drive of the configuration 
computer. The project folder is typically named C:\WESDATA.

Result: The contents of the project folder are displayed, and the file named 
WPL400.DB is selected.

16. Click the Select button.

Result: The Restore Project from ZIP File dialog reappears with the Project Directory set 
to the folder you selected in the previous step.

17. Change the Project Name if desired and click OK.

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left . The new D20MX factory default project appears in the tree view.

18. Double-click on the D20MX factory default project.

Result: The Main Page of the D20MX factory default project appears with the FAC_DEF 
device placed on the page.

19. Double-click the FAC_DEF device.

Result: The Missing Applications! dialog appears.

20. Click the Install button.

Result: The Select the Source Application Definition Directory dialog appears.

21. Navigate to the DVD/CD drive > DEFNS > APPLDEF.

Result: The contents of the APPLDEF folder appears with the file DAL100.DB selected. 

22. Click Select .

Result: Messages are displayed about the application definitions being extracted to 
the configuration computer, and finally the Data Collection Applications of the 
FAC_DEF device appear.

23. Close the device configuration by clicking on the door icon.

Result: The Main Page of the D20MX factory default project appears with the FAC_DEF 
device appearing on the page.

24. Click from the menu bar, Device > Firmware.

Result: The Firmware Library dialog appears. 

25. Depending on which factory default project you chose in step 9, select either 
SAN0001/XX or SAN0002/XX.

26. Click Copy.

Result: The Firmware Information dialog appears.

27. In the “Copy To” area select the Project Directory and Project Name of the project you 
want to transfer to the D20MX.

Result: The “Copy To” area contains the Project Directory and Project Name of the 
project you want to transfer to the D20MX.

28. Click OK, Close and the door icon

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left . 

29. Make a backup copy of your project.

29.1. Select from the menu bar, Project > Copy Project .
Result: The Copy Project dialog appears.
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29.2. In the “From” area, navigate to the folder and select the project you want to 
transfer to the D20MX.

29.3. In the “To” area, enter a new unique name for the project.

29.4. Click OK.
Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left. 

30. On the tree view displayed to the left, navigate to the copied project and double-click 
on the project name.

Result: The main window of the copied project appears.

31. Right-click on the D20 device you want to transfer and select Properties.

Result: The D20 Device Properties window appears.

32. Click the Processor tab and the Firmware tab. Then click Select .

Result: The Select a Firmware Type dialog appears. Depending on which factory 
default project you chose in the second step, either SAN0001 or SAN0002 appears.

33. Select whichever of SAN0001 or SAN0002 appears and click OK and OK.

Result: A confirmation dialog appears asking if you want to make a backup copy now.

34. Click No because you have already made a backup.

Result: Messages appear indicating the upgrade is in progress. Messages appear in 
the Device Log indicating the results of the upgrade. The D20 device appears with a 
red dot.

35. Review all warnings and make corrections as needed, reviewing the original copy to 
retrieve values that may have been replaced with default values during the upgrade

36. Right-click on the device and click Generate.

Result: The device appears without a red dot.

37. Right-click on the device and click Archive > Save.

Result: The Save Device to ZIP File dialog appears.

38. In the “Save To” area, click the folder icon.

Result: A dialog appears with the title “Select a directory in which to save the project”.

39. Navigate to a folder on your PC where you would like to save the device archive and 
click Select and OK.

40. Close ConfigPro.

41. Migrate the D20 Device Archive into SGConfig using the Migration Wizard (Refer to the 
Migration Wizard screencast).

Updating a D200 configuration to use the D20MX firmware 
definition with ConfigPro

Use this information to update the firmware definition of an existing D200 device to the 
D20MX firmware definition. The result is a device archive that you can migrate into 
SGConfig for the purpose of transferring the D200 configuration to the D20MX. 

Prerequisites Before you can update the firmware definition of a D200 device configuration, the 
following components must be present

• ConfigPro 5.03 or higher installed on the configuration computer.

• D20MX Documentation CD (part no. 588-0075 VXX) in either of the following formats:

– Physical CD media, or 

– Zip file
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Procedure

Migrating a multi-processor D200 only transfers the application configurations on the first 
processor.
This is manually resolved by moving applications from other processors to the first 
processor using the ConfigPro device editing functions BEFORE converting the device to a 
D20 in the instructions below. 
Single and multi-processor D200 devices must first be changed into D20 devices before 
the D20MX firmware definition can be selected. 
To change a D200 device into a D20 device perform the following steps:

1. Start ConfigPro 5.03 or higher.

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left .

2. Make a backup copy of the project you want to transfer to the D20MX.

2.1. Select from the menu, Project > Copy Project .
Result: The Copy Project dialog appears.

2.2. In the “From” area, navigate to the folder and select the project you want to 
transfer to the D20MX.

2.3. In the “To” area, enter a new unique name for the project.

2.4. Click OK.
Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left. 

3. On the tree view displayed to the left, navigate to the project and double-click on the 
project name.

Result: The main window of the copied project appears 

4. Right-click on the D20 device you want to transfer and select Tools > Change. 

Result: The Change Device window appears.

5. Select type D20 and click OK.

6. Follow the steps in section: “Updating a D20 configuration to use the D20MX firmware 
definition with ConfigPro” on page 97. 

Software (feature) licensing

The D20MX application image file contains all the applications currently available for the 
D20MX. Some of these applications are licensed and are not available until they are 
unlocked.
These licensed applications are in groups, called application groups, and are identified by 
a license code.
Currently application groups 001 and 002 are available. Future releases of the application 
image file will provide more groups.
Use the D20M Shell command:

• swlic-report to view the list of application groups.

• swlic-list to view the applications in each group.
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Enable trial period An application group may be temporarily enabled for a 30-day trial period.
To enable a trial, use the command swlic-trial -id 001 to enable application group 001. 
For example:

D20M> swlic-trial -id 001 
Trial license for '001' will be valid until 2013-03-18 (30 days)

Are you sure you want to enable the trial license for '001' [y/N] : y 
INFO : Trial License  '001' enabled until 2013-03-18

NOTE

The D20MX must be rebooted for the trial period to take effect

View the license 
status

The D20M Shell command swlic-report lists the status of the license. Each license group is 
listed.
For example:
D20M>swlic-report

License Report Utility v01.000

License Information

==============================================================

Target Unit             : D20MX

Serial Number           : 526-3003-000001

Customer                : Utility ABC

License created from    : D400 Utilities V1.0.1

License Version         : 01.000

Application License                                     Status

==============================================================

001 : D2X Classic Applications                  Trial Disabled

002 : Advanced Automation Applications          Trial Enabled

Unlock an application 
group

To unlock an application group, an unlock code must be purchased from GE. Please 
contact Customer Service for the unlock code.
Customer Service asks for the 'Hardware Identifier' of the D20MX that is to have the 
application group unlocked. This is a unique identifier for each D20MX and cannot be used 
with any other D20MX (that is, the license is non-transferrable).

View the hardware 
identifier

Use the D20M Shell command swlic-info to view the Hardware Identifier.
For example:

D20M>swlic-info 
System Information 
License Information Utility V01.000

====================================================================

Target Unit                     : D20MX 
Hardware Identifier             : 303064303163306237323461 
License File                    : /tffs0/swLicense/license.key: Good

Customer Service sends you either:

• An unlock code

• An new license file (license.key)

• Or a batch file (batch.lic) which can be used on multiple D20MXs
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Unlock code If Customer Service send an unlock code, use the D20M Shell command swlic-unlock -l 
<unlock code> to unlock the application group.
For example:

D20M>swlic-unlock -l 6E62385170303537533061626B66706643673D3D 
Unlock Key is Valid 
Info : License for '001' and been unlocked

This unlocks the application group 001.

License file If Customer Service sends a license file (license.key), use a SCP (Secure Copy) application, 
such as WinSCP, to copy the license file over the network to the /ram directory on the 
D20MX. 
Alternatively, use the D20M Shell RZ command to download the license file via Z-Modem 
through the console port. The RZ command automatically places the file in the /ram 
directory.

NOTE

The file must be named license.key. 

Use the D20M Shell command CL (Copy License) to process the license file. This command 
copies the license file to the correct location on the D20MX, and if there are no errors, the 
D20MX automatically restarts.
For example:

D20M>cl 
Found License file (/ram/license.key) - copying 
copying file /ram/license.key -> /tffs0/swLicense/license.key 
License file copied  -- rebooting ....

Batch file If Customer Service sends a batch file (batch.lic), use a SCP (Secure Copy) application, such 
as WinSCP, to copy the batch file over the network to the /ram directory on the D20MX.
Alternatively, use the D20M Shell RZ command to download the license file via Z-Modem 
through the console port. The RZ command automatically places the file in the /ram 
directory.

NOTE

The file must be named batch.lic.

Use the D20M Shell command CL (Copy License) to process the batch file. This command 
processes the /ram/batch.lic file, extracting the appropriate license block and creates a 
new license file (license.lic). If there are no errors, the D20MX automatically restarts.

NOTE

For the batch file to be processed, a license file must be in place. Use the command swlic-
info to verify a license file is in place.

For example:

D20M>cl 
Found Batch file (/ram/batch.lic) - processing 
copying file /ram/batch.lic -> /tffs0/swLicense/batch.lic 
Batch License Installation '/tffs0/swLicense/batch.lic' 
Searching for serial number '526-3003-000001'' 
License Found in Batch File 
copying file /ram/newlicense.key -> /tffs0/swLicense/license.key 
Success : Success  License file updated
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Configuring Serial Expansion Cards

A D20MX can be ordered with up to four serial expansion auxiliary cards. Each card 
provides 7 serial ports. Configure serial expansion cards as follows in SGConfig and 
ConfigPro.
If using SGConfig to configure serial expansion cards:

1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Open the SGConfig project containing the D20MX device.

2.1. Click the GE button.

2.2. Click the required SGConfig project in the Recent Projects list or select the 
Open Project menu item.

3. Add Serial Expansion Auxiliary cards from the D20MX Device Wizard:

3.1. Click the Project tab of the D20MX device configuration.

3.2. Click the D20MX device.

3.3. Click the ribbon Configure group > Edit > Properties.

3.4. Click Next until the Processor tab appears.

3.5. Click the VME Cards tab. The Serial Expansion card will be under Available VME 
Expansion Cards.

3.6. Click Select once for each serial expansion card in the D20MX hardware 
configuration

Result: 1 to 4 Serial Expansion Auxiliary Cards show up under Selected VME 
Expansion Cards 

4. Click Next and Finish.

Result: The D20MX Device Wizard closes.

If Using ConfigPro to configure serial expansion cards:

1. Start ConfigPro

Result: The ConfigPro splash screen starts.

2. Open the ConfigPro project containing the D20MX device.

3. Double click the project appearing in the Projects tab.

4. Right click on the device and select Properties.

Result: The D20 Device Properties dialog appears.

5. Click the VME Cards tab. The Serial Expansion card will be under the list named 
Available VME Expansion Cards. Even though these cards do not have the same part 
number as the D20MX Serial Expansion Auxiliary Card, they can be used to make the 
required serial ports available in ConfigPro. 

6. Click Select two times for each Serial Expansion Auxiliary Card installed on your 
D20MX.

Result: 2 to 8 VME Expansion Cards show up under Selected VME Expansion Cards. 

7. Click OK.

Result: The D20 Device Properties dialog closes.

After performing the above procedure in either SGConfig or ConfigPro, select the 
expansion serial ports using the naming convention shown in Table 21. Refer to the 
particular application configuration guide for which field selects the port name.
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Table 21: Port names used with SGConfig and ConfigPro

SGConfig Port Range ConfigPro Port Range Physical Com Ports

COM1 to COM7 COM1 to COM7 Port 1 to 7 on D20MX

CB-1 to CB-7 COM8, COM9, COMA to COME Port 1 to 7 on First Serial Expansion Card

CC-1 to CC-7 COMF to COML Port 1 to 7 on Second Serial Expansion Card

CD-1 to CD-7 COMM to COMS Port 1 to 7 on Third Serial Expansion Card

CE-1 to CE-7 COMT to COMZ Port 1 to 7 on Fourth Serial Expansion Card
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D20MX Substation Controller

Chapter 7: Using the D20MX 
Substation Controller

Using the D20MX Substation Controller

The D20 Substation Controller operation can be monitored and accessed through the:

• D20MX processor front panel LEDs

– Operational status LEDs

– LAN port status LEDs

– Fiber optic status port LEDs

• Power supply

• I/O peripherals

D20MX processor front panel LEDs 

Once the D20MX is powered up, the LED indicators on the front panel become active. The 
indicators provide status information on the operation of the D20MX.

Operational status LEDs
The status LEDs (see Table 22) indicate the unit’s operational status:

Table 22: D20MX - status LED operation

LED Display Label Color Status Description

PWR Green Power
Solid light when 5 V DC power is correctly supplied to the 
processor board.
OFF when 5 V DC is not present.

RDY Green Ready
Flashes when Initialization (boot-up and self-diagnostics) of 
the D20MX is complete and the unit is ready to process data.

IRIG PWR

RDY

IRIG PWR

RDY
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LAN port status LEDs
The LAN Port Status LEDs (see Table 23) provide a visual indication of the status for the 
Ethernet communication ports on the front of the D20MX. 

Table 23: D20MX - LAN port status LED operation

Fiber optic port status LED 
The fiber optic port status LEDs (see Table 24) provide a visual indication of the status for 
fiber optic ports 1 and 2.

Table 24: D20MX - Fiber optic port status LED operation

D20 power supply LEDs

On the chassis-mounted D20 power supplies, an LED indicator is available for each 
supply voltage. The indicators are illuminated green when that voltage is present.

IRIG Green Flashes when an IRIG-B format time synchronization signal 
has been supplied to the unit and has been used to set the 
D20 system clock.
 
Note: When removing IRIG-B signal, the LED keeps blinking 
for up to a minute before turning off. 

Green Normally off; reserved for future expansion.

LED Display Label Color Status Description

IRIG PWR

RDY

IRIG PWR

RDY

IRIG PWR

RDY

LED Display Label Color Status Description

LINK Orange for 1000BASE-T.
Green for 10/100BASE-T

Link 1, Link 2
Solid light when an active device is 
connected to the Ethernet port.

ACT Yellow Activity 1, Activity 2
Flashes when data is transmitted or 
received on the channel.

LINK ACT

LINK ACT

LED Display Label Color Status Description

LINK 1
LINK 2

Green Link 1, Link 2
Solid light when an active device is connected to the fiber 
optic port.

ACT 1
ACT 2

Yellow Activity 1, Activity 2
Flashes when data is transmitted or received on the 
channel.

ACT 1 ACT 2

LINK 2LINK 1

ACT 1 ACT 2

LINK 2LINK 1
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I/O peripheral LEDs

The WESDAC/WESTERM Peripheral pairs have a common section made up of components 
on the WESDAC and WESTERM boards. There are seven LED indicators on this common 
section.
Table 25 lists and describes the I/O peripherals - common LEDs.

Table 25: I/O peripherals - common LEDs

LED Name Designation Normal RUN Not Initialized

DS1 Power On On On

DS2 MPU Run Flash 10/sec See Next Table

DS3 Tx1 Flickers Constantly Depends on Nature of Fault

DS4 Rx1 Flickers Constantly Depends on Nature of Fault

DS5 Tx2 Configuration Dependent Depends on Nature of Fault

DS6 Rx2 Configuration Dependent Depends on Nature of Fault

DS7 Fault Off See Next Table
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D20MX Substation Controller

Chapter 8: Servicing the D20MX 
Substation Controller

Servicing the D20MX Substation Controller

This chapter describes how to:

• Inspect the unit

• Remove the D20MX processor

• Change fuses

Performing periodic inspection 

Periodic inspection is recommended to ensure that:

• The device has sustained no accidental physical damage

• Connectors and cables are intact and firmly attached

Performing maintenance

The D20 does not require scheduled maintenance. 
However, small metallic particles (such as wire clippings) can fall through the ventilation 
holes on the top of the unit, possibly damaging or interfering with the safe and reliable 
operation of the D20.

Ensure that the D20 is protected from falling debris during maintenance. If you cover the 
unit for maintenance, remove cover before operating to provide adequate cooling airflow.
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Removing the D20MX processor module 

The D20MX can be removed from a D20 Substation Controller non-VME (GE part number 
500-0305), a D20 Substation Controller VME (GE part number 500-0280) D20 chassis.

Ensure that you are sufficiently grounded to prevent ESD damage to the D20MX or other 
components. See section: “Grounding the D20MX” on page 52.

To remove the D20MX 
from a D20 chassis

1. Power down the D20 and disconnect the power supply.

2. Disconnect all communication cables from the front panel of the D20MX and the 
backplane of the D20 chassis.

3. Loosen the front panel retaining screws.

4. Remove the blank plates located above and below the D20MX.

5. Slide the D20MX partially out.

6. For the D20MX Non-VME with Dual 100Base-FX Fiber Optic Card (526-3005LF) only:

6.1. Disconnect the 975-1236 cable (connecting the fiber optic daughter card) from 
connectors J3 and J4 on the D20MX processor module.

6.2. Loosen the D20MX fiber card front panel retaining screws.

6.3. Carefully slide out the D20MX fiber card partially.

6.4. Remove the 975-1236 cable through the middle slot in the chassis.

6.5. Store the D20MX fiber card in static-protective packaging.

7. Grasp the D20MX by the front handles and slide the processor module all the way out 
of the D20 chassis.

Allow the D20MX to cool before removing. The heatsink of the D20MX may be extremely 
hot during and immediately after operation. Use caution when removing the processor 
module from the chassis to avoid being burned. 

8. Store the D20MX in static-protective packaging.
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Fuses

The fuses listed in section are standard fuses that are factory-installed, unless otherwise 
specified.
Fuse ratings may differ due to:

• Unique customer-specific configurations or requirements, or

• Product specification changes

When changing fuses, always check the original fuse for value and type, and ensure the 
replacement fuse you use is of that same value and type. Do not assume that installed fuse 
is of the correct value.

Replacing D20 fuses
Field-replaceable fuses for the standard D20 chassis-mounted Power Supplies are listed in 
Table 26.

Table 26: D20 field-replaceable fuses

Power Supply Fuse Fuse Function Replacement Fuse Fuse Part Number

580-2004 F1 +DC Input LITTLEFUSE 
0326012.MXP

940-0425: Fuse, SLO-
BLO, 12A/250V

F2 -DC Input LITTLEFUSE 
0326012.MXP

940-0425: Fuse, SLO-
BLO, 12A/250V

580-2005 F1 +DC Input LITTLEFUSE 
0326012.MXP

940-0425: Fuse, SLO-
BLO, 12A/250V

F2 -DC Input LITTLEFUSE 
0326012.MXP

940-0425: Fuse, SLO-
BLO, 12A/250V

580-2006 F1 Line/+DC Input LITTLEFUSE 
0313004.MXP

940-0424: Fuse, SLO-
BLO, 4A/250V

F2 Neutral/-DC Input LITTLEFUSE 
0313004.MXP

940-0424: Fuse, SLO-
BLO, 4A/250V

580-2007 F1 Line/+DC Input LITTLEFUSE 
0313004.MXP

940-0424: Fuse, SLO-
BLO, 4A/250V

F2 Neutral/-DC Input LITTLEFUSE 
0313004.MXP

940-0424: Fuse, SLO-
BLO, 4A/250V
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 Generating a System Default Configuration for the D20MX

In the event that it is necessary to generate a system default configuration for the D20MX 
(for example, the username, password or both are unavailable), this chapter provides the 
procedure. 

Prerequisites

Prerequisites for generating a system default configuration for the D20MX:

• A Windows PC with SGConfig 8.1 or higher software.

• A NULL modem cable (GE Energy part number 977-0529) connecting the RS-232 
connector on the front panel of the D20MX to the serial communications port of a PC 
or terminal.

Generate a system default configuration for the 
D20MX

To generate a system default configuration for the D20MX:

1. Set up Tera Term on a PC. See “Set up Tera Term on a PC” on page 78.

2. Restart the D20MX by turning the power off and on.

Result: The startup messages appear.

3. When the message “Press Ctrl-F to reset to factory defaults” appears, enter Ctrl-F 
within 3 seconds.

Result: The prompt: “Do you wish to reset to Factory Defaults (yes/no)?:” appears

4. Enter yes.

Be sure to enter the whole word “yes”, not just “y”.

Result: This causes the configuration to be defaulted and the password file to be 
deleted. The system reboots and eventually the “User:” prompt appears.
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5. Login with the username recover and password system.

Result: The D20M> prompt appears.

6. You may now synchronize a configuration to the D20MX using SGConfig.



D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL GE INFORMATION 117

D20MX Substation Controller

Chapter 10: Removing Configuration 
Data and Sensitive Information from 
the D20MX

Removing Configuration Data and Sensitive Information from the D20MX

In the event that it is necessary to remove the configuration data and sensitive information 
from the D20MX (for example, disposal purposes), this chapter provides the procedure.
It may also be necessary to remove data from a PC that has run ConfigPro or SGConfig for 
the purpose of configuring a D20MX processor. Again, this chapter provides the data 
removal procedure. 

Remove configuration data and sensitive 
information from the D20MX

Prerequisites
Prerequisites for removing configuration data and sensitive information from the D20MX:

• A Windows PC with SGConfig 8.1 or higher software.

• A NULL modem cable (GE Energy part number 977-0529) connecting the RS-232 
connector on the front panel of the D20MX to the serial communications port of a PC 
or terminal.

Removal Procedure
To remove configuration data and sensitive information from the flash file system and 
NVRAM of the D20MX:

NOTE

If you wish only to return the D20MX to a system default state and do not need to 
securely wipe previous configuration information from the flash file system, refer to 
Chapter 9, Generating a System Default Configuration for the D20MX.

1. Set up Tera Term on a PC. See “Set up Tera Term on a PC” on page 78.

2. Restart the D20MX by turning the power off and on.

Result: The startup messages appear.

3. Wait for the following messages to appear and press Ctrl-E:
Application version: v1.50- 

Firmware: SAN0001.150/SAN0002.150
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Press Ctrl-F to reset to factory defaults.

 3 2 1

UNAUTHORIZED ACCESS TO THIS DEVICE IS PROHIBITED
You must have explicit permission to access or configure this device.

All activities may be logged. Violations of policy governing this device

may result in disciplinary action and may be reported to law enforcement.

There is no right to privacy in accessing this device.

Press Ctrl-E to enter debug mode

1 2 3

Result: You are prompted to login.

4. Login as a user with maintenance access or higher (e.g., Engineer role).

Result: You are logged in and the D20M Shell is started.

Result: You are prompted to continue. 
Please Wait... 1 
Press Enter to Continue...

5. Press Enter.

Result: The D20M Shell prompt appears.

6. Type the command SFD (Secure Factory Default) and press Enter.

D20M> SFD

Result: The SFD command runs.

Result: You are prompted to continue. 
This command permanently deletes the configuration. 
Are you sure you wish to continue?[y]

7. If you wish to continue, type y and press Enter.

Result: The SFD command will continue.

Result: The SFD command:

(A)   Shuts down certain tasks,
(B)   Clears NVRAM, 
(C)   Sets up JMON commands to resume the SFD command in case there is a 
power failure during the procedure, 
(D)   Erases the '/user' volume (customer files), 
(E)   Removes the JMON command, 
(F)   Reformats the '/user' volume, 
(G)   Checks the'/tffs0' volume, and reboots.  

A) Shutting down tasks...
WARNING: Could not shut down 'B003'
WARNING: Could not shut down 'ROOT'
 Done
B) Clearing NVRAM... Done
deleting file /user/pkey_db/default_rsa
deleting file /user/pkey_db/default_dsa
deleting directory /user/pkey_db
C) Setting Power-fail JMON commands...
    Set 'AUTOBOOT_WARM_CMD_00' = 'fle 1 512 896'
    Set 'AUTOBOOT_WARM_CMD_01' = 'setenv AUTOBOOT_COLD_CMD_00 efn'
    Set 'AUTOBOOT_WARM_CMD_02' = 'saveenv'
    Set 'AUTOBOOT_WARM_CMD_03' = 'boot'
    Set 'AUTOBOOT_WARM_CMD_04' = ''
    Set 'AUTOBOOT_COLD_CMD_00' = 'warmboot'
 .. Done
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D) Erasing '/user' Volume...
Erasing 384 blocks.
  1)      0K     256K     512K     768K
  5)   1024K    1280K    1536K    1792K
. . . .
377)  96256K   96512K   96768K   97024K
381)  97280K   97536K   97792K   98048K
Erase Complete.
Erase time:06:04.617s
 .. Done
E) Removing Power-fail JMON commands...
    Set 'AUTOBOOT_COLD_CMD_00' = 'efn'
    Set 'AUTOBOOT_WARM_CMD_00' = ''
    Set 'AUTOBOOT_WARM_CMD_01' = ''
    Set 'AUTOBOOT_WARM_CMD_02' = ''
    Set 'AUTOBOOT_WARM_CMD_03' = ''
 .. Done
F) Reformatting '/user'...
* Steps 1 of 3) TFFS Formatting (*This takes approximately 7 
minutes)...
* Steps 2 of 3) Mounting '/user'...
. . . .
* Steps 3 of 3) HRFS Formatting ...
. . . .
No errors detected.
Volume OK.
 .. Done
G) Volume '/tffs0' already formatted as DOS: No change required
*** Phase 1) Set Customer File location: '/user'
*** Phase 2) Rebooting...

Result: The sensitive customer files have been completely erased from the file system. 
And the NVRAM has been cleared. A default configuration has been generated and 
installed.

Result: The D20MX reboots. Since the configuration has been defaulted, the D20MX is 
in debug mode.

Removing configuration data on a PC

If ConfigPro or SGConfig have been used to configure the D20MX processor, configuration 
data resides on the data storage media (e.g., hard drives, memory cards, etc.) of the PC 
running ConfigPro or SGConfig. 
The D20MX configuration data can be removed from the PC by either:

• Recommended:   Physically removing and destroying the data storage media, or 

• Using a program to securely wipe (that is, completely erase) the data storage media 
(that is, not just reformat or remove the names of the files from the file allocation 
table). 
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Troubleshooting

This chapter describes how to troubleshoot:

• Serial communications

• Firmware version mismatches

• D20MX Shell commands

• D20MX Logs

Troubleshooting serial communications

This section describes how to troubleshoot serial communications using SA COM.
A serial analyzer captures and displays serial communications in hexadecimal format to 
assist in troubleshooting communications between an IED or SCADA master and the D20. 
GE Digital Energy has incorporated this powerful feature into the firmware of the D20MX 
via the SA COM (Serial Analyze Communications) command, allowing for the capture of 
serial communications from any of the serial ports.

Serial analyzer
A serial analyzer displays every character (including framing and parity errors) of the raw 
communication between an RTU and IEDs in the field or a SCADA master station. Test sets 
do not always display all of the data, as they normally parse the data and if there is a 
problem, that message is ignored.
Normally a serial analyzer is used to verify communications between two or more devices 
to see if a correct response is sent for a particular request. The captured messages can 
then be parsed and examined for their integrity. Any problems with the request or 
response can then be analyzed. In the case of when a device fails or does not respond, the 
serial analyzer may have captured the message that triggered the problem. It will also 
show the quality of the communications link by displaying any noise, framing errors (FR), 
parity errors (PA) or echoes in the message.
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Prerequisites
The following items are required:

• A NULL modem cable (GE part number 977-0529) connecting the RS-232 connector 
on the front panel of the D20MX to the serial communications port of the PC.

• Windows* PC running a terminal emulator (e.g., TeraTerm Pro) that has a log-to-file 
feature.

Procedure
The procedure below assumes that TeraTerm Pro is being used as the terminal emulator. 
The steps may differ slightly if a different terminal emulator program is used.
To capture a serial analysis file:

1. Connect the computer's serial communications port to the WESMAINT port of the D20 
using the WESMAINT cable. 

2. Select Serial and the appropriate COM port for the computer, and then click OK.

3. Press Enter and a log in screen is shown. Type in your user name and password and 
press Enter.

4. The Main Menu is shown. Use the down arrow key to select option 2. System Functions 
and then press Enter (or press the number 2 key on the keyboard).

5. The System Functions menu is shown. Use the down arrow to select option 3. SHELL 
and then press Enter (or press the number 3 key on the keyboard).

6. Before starting to capture a serial analysis file, it is recommended to increase the 
WESMAINT baud rate so that the display buffer does not overflow. A display buffer 
overflow will occur when the data is coming in faster than WESMAINT can display it .

A communications port running at a higher baud rate than the WESMAINT port 
usually causes this. Examples of buffer overflow are shown at the end of this 
document.

To change the baud rate, type baud xxxxx (where xxxxx is the desired baud rate for 
your device) at the system prompt and press Enter. Type baud by itself and the 
available baud rates are displayed.

The recommended baud rate is 115200.

7. Change the baud rate in the terminal emulator to match the baud rate selected in the 
previous step. If using TeraTerm, click Setup > Serial port and then change the baud 
rate and change the flow control to none. Click OK and press Enter to get the system 
prompt to appear.

8. Before starting to log data, a log file must be created. 

If using TeraTerm:

8.1. Click File menu > Log. 

8.2. Type in or select a file to log to. 



CHAPTER 11: TROUBLESHOOTING

D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL GE INFORMATION 123

8.3. Select a folder to store it in so it can easily be located later. 

8.4. Click Open when finished.

9. Type sa comx (where comx is the communications port name you want to monitor) 
and then press Enter. The naming convention is described in “Port names used with 
SGConfig and ConfigPro” on page 105.

Result: The D20 messages always appear in inverse text (white text on a black 
background) and the master request or the slave response always appears in regular 
text (black text on a white background).

In this example the D20 is acting as the slave and information is being sent out from 
the D20 in inverse text. To stop the capture when the appropriate data has been 
captured, press CTRL-C to return to the system prompt. 

10. When the data capture is finished, close the log file in TeraTerm by clicking Close. 

11. The log file can now be found in the folder it was stored in and can be opened using a 
text editor. The file can be parsed by copying this information into a computer-based 
automated parser or done manually by using a protocol description document.

NOTE

If using Notepad to view the contents of the log file, all of the communications traffic 
is shown in non-formatted text.

D20/D200 response Master

D20 responseMaster



124 GE INFORMATION D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL

CHAPTER 11: TROUBLESHOOTING

Advanced Analyzer Options
The SA command has several options for advanced communication analysis.

• Sync on receive (/SR): When a transition from sending bytes to receiving occurs, the 
received bytes start on a new line.

• Sync on Transmit (/ST): When a transition from receiving bytes to sending bytes 
occurs, the sent bytes start on a new line.

• Driver Events (/D): Display serial I/O driver events such as the RTS, CTS or DCD signal 
line transitions. Discarded bytes due to DCD squelching. See the D20MX Shell Users 
guide for a complete listing of driver events.

• Display the bytes in ASCII (/A): The data is displayed as ASCII characters instead of 
hexadecimal values.

• Display Width (/Wnn): Set the width of the display, where nn is from 5 to 50 (default is 
25). Will have to adjust the width of the TeraTerm window.

Buffer Overflow
The below screen shows good serial communications data at the top of the screen and 
transitions to show buffer overflows at the bottom of the screen. When the buffer 
overflows the message 'SA Buffer Overflow - data lost. Increase console baud rate.' is 
displayed. 
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Troubleshooting firmware version mismatches

The D20MX checks the application version in the firmware against the Firmware Type 
(Application Definition) version every time it boots. If a discrepancy is detected a message 
is logged in the kernel error log. If the application with a version discrepancy is disabled, 
only a WARNING message is logged. If the application is enabled, then a FATAL message is 
logged and the D20MX enters disabled mode. All applications in the configuration are 
checked; the check does not stop at the first FATAL application.
The message includes the:

• Application number (e.g., A009N), 

• Firmware/Application Definition version (e.g., CFG:811) and 

• Application version (e.g., FW:812).

If the application version (FW) shows '<ukn>', then the firmware in the D20MX does not 
contain that application, yet there is a configuration for it .
Use the D20M Shell command EL to view these messages.
Example warning messages:
D20MX> EL

05/28/2015 11:19:01>WARNING: ApplDef ver mismatch:'A009N' (CFG:811, FW:812)

05/28/2015 11:19:01>WARNING: ApplDef ver mismatch:'A064' (CFG:110, FW:<ukn>)

05/28/2015 11:19:01>WARNING: ApplDef ver mismatch:'A199-0N' (CFG:111, FW:112)

05/28/2015 11:19:01>* FATAL: ApplDef ver mismatch:'B152-1N' (CFG:300, FW:<ukn>)

In this example the D20MX entered disabled mode because there a FATAL mismatch 
occurred with 'B152-1N'.
To resolve any FATAL or WARNING issues, either update the configuration to match the 
firmware or update the firmware to match the configuration. 
To update the:

• Configuration, refer to the procedure “To transfer a D20 or D200 device configuration 
to the D20MX:” on page 92. 

• Firmware, refer to the procedure “Download image files to the D20MX” on page 77.

D20MX Shell commands

This section outlines some of the D20MX Shell commands that can be used when working 
with the D20MX processor. Instructions in this chapter are excerpts from the D20MX Shell 
User's Guide.
Refer to the D20MX Shell User's Guide (SWM0074) for information about other commands 
not listed here.

Changing the baud rate
The D20MX Shell has the ability to change the communication speed of the WESMAINT 
port. This is useful when downloading large files. 
Example:   A 1 MB code file may take upwards of 40 minutes to download at 9600 bps (the 
default). At 38400 bps, the transfer is only 10 - 15 minutes.

NOTE

Most PCs cannot exceed 115,200 bps, and some terminal programs (Windows Terminal for 
example) may have other restrictions. Check the program's User's Guide for help.
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SET BAUD RATE command
The SET BAUD RATE command changes the data rate of the WESMAINT port to a user-
supplied value. 

Speed changes made using the SET BAUD RATE command are not saved in NVRAM; the 
monitor returns to 9600 bps after a restart. It is recommended that this command only be 
used to speed up a serial download, and not to redefine the operational state.

Supported data speeds
The supported data rates, in bps, are:

• 900

• 1050

• 1200

• 1800

• 2000

• 2400

• 3600

• 4800

• 7200

• 9600

• 14400

• 19200

• 28800

• 38400

• 57600

• 115200

Command Format BAUD baud_rate

Variables None

Parameters baud_rate =   the new data rate for the port, in bps.

Example Type BAUD 4800 and press ENTER.

Result: The monitor switches to communicate at 4800 bps.

Special Considerations See Notice below. 
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D20MX logging

The D20MX provides two logs that are useful for troubleshooting issues:

• WESMAINT Error Log

• Kernel Error Log.

WESMAINT error log
The WESMAINT Error Log stores informational, error, warning, and fatal error messages 
generated by the system. Refer to B014-1NUG WESMAINT II+ for the D20MX User's Guide 
for more information. 
Most messages logged to the WESMAINT Error Log by an application are described in the 
application's Configuration Guide For information on messages not available in a 
Configuration Guide, refer to Appendix H, WESMAINT Error Log Messages.

Kernel error log
The Kernel Error Log stores low-level system messages typically required only by GE Digital 
EnergyTechnical Support to assist with problem diagnosis. 
View the Kernel Error Log by typing el in the D20MX Shell. Also refer to SWM0080 D20MX 
Shell User's Guide.
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 Default Role-Based Access Control Model 

Configured roles in the D20MX

When you configure the D20MX to use RADIUS, the D20MX must be configured with a set 
of roles in the B014 RADIUS Roles Table (B014RADR) of the WESMAINT II+ application (Refer 
to the B014-1NCG WESMAINT II+ for the D20MX Configuration Guide for more information). 
The role is identified by a role ID, which is an integer number provided by the RADIUS 
server. 
The D20MX Default configurations D20MX01-XX and D20MX02-XX include a default role-
based access control model that meets the general rules shown in Table 27. 

Table 27: General access control rules

The Shell access level roles are provided in Table 28

Table 28: Shell access level

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

Can Change Passwords Yes No No No

Can Clear the Login Buffer No No No No

Can Change SCADA Settings Yes Yes No No

Can Download Firmware Yes Yes No No

Can Perform Operational Control (e.g. breaker 
operation)

Yes Yes Yes No

Can View Operational Data Yes Yes Yes Yes

Can Access Low Level “C” Shell Yes No No No

Description Administrator 
(2)

Engineer  
(1)

Operator 
(3)

Observer 
(0)

Access Level Read/Write Maintenance Read Only Read Only
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The specific flags defined in the Application Control field of the RADIUS Roles table are 
provided in the tables listed in Table 29.

Table 29: List of configured roles

Table Number Access Flags For... Associated 
Application #

Table 30 Modify WESMAINT 14

Table 31 Read

Table 32 Modify  D20AC WESMAINT II+ Display Screens 32045

Table 33 Read

Table 34 Modify Prologic display 36

Table 35 Read

Table 36 Modify DNP DPA Configuration Display 32021

Table 37 Read

Table 38 Modify Internet Statistics Display 162

Table 39 Read

Table 40 Modify DNP Serial Data Link Display 32013

Table 41 Read

Table 42 Modify Modbus DCA Display 59

Table 43 Read

Table 44 Modify Modbus DPA Display 68

Table 45 Read

Table 46 Modify File Upload Interface 32071

Table 47 Read

Table 48 Modify SOE Logger 27

Table 49 Read

Table 50 Modify SEL DCA 78

Table 51 Read

Table 52 Modify IEC 60870-5-101/104 DPA 101

Table 53 Read

Table 54 Modify Landis & Gyr 8979 DPA 185

Table 55 Read

Table 56 Modify Harris 6000/XA-21 DPA 199

Table 57 Read

Table 58 Modify IEC 60870-5 FT1.2 Balanced Data Link 32085

Table 59 Read

Table 60 Modify Modify access flags for DNP V1.00 Data Link 17

Table 61 Read

Table 62 Modify Quantum Meter Scanner DCA 18

Table 63 Read

Table 64 Modify CDC Type 1 DPA 23

Table 65 Read

Table 66 Modify PID DTA 41

Table 67 Read

Table 68 Modify MODBUS TCP DCA 131

Table 69 Read
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Table 30: Modify access flags for WESMAINT (Application number: 14) 

Table 31: Read access flags for WESMAINT (Application number: 14)

Table 70 Modify MODBUS TCP DPA 135

Table 71 Read

Table 72 Modify LogicLinx DTA 32082

Table 73 Read

Table 74 Modify PML 3710 DCA Display 74

Table 75 Read

Table 76 Modify Courier DCA Display 98

Table 77 Read

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Time and Date display Yes Yes Yes No

1 Peripheral Status display Yes Yes Yes No

2 Peripheral Status Detail display Yes Yes No No

3 COS Buffer display Yes Yes Yes No

4 SHELL Yes Yes Yes No

5 Digital Inputs display Yes Yes Yes No

6 Digital Inputs Detail display Yes Yes Yes No

7 Digital Outputs display Yes Yes Yes No

8 Digital Outputs Detail display Yes Yes Yes No

9 Analog Inputs display Yes Yes Yes No

10 Analog Inputs Detail display Yes Yes Yes No

11 Analog Outputs display Yes Yes Yes No

12 Analog Outputs Detail display Yes Yes Yes No

13 Transition Counter display Yes Yes Yes No

14 Transition Counter Detailed display Yes Yes Yes No

15 SOE Buffer display Yes Yes Yes No

16 USER LOG display Yes No No No

17 Database Synch display Yes Yes Yes No

18 Switch-over display Yes Yes Yes No

19 System Status display Yes Yes No No

20 Communication Status display Yes Yes No No

21 Complex Object display Yes Yes No No

22 Complex Object Detail display Yes Yes No No

23 Generic Data display Yes Yes No No

24 Generic Data Detail display Yes Yes No No

25 - 31 Not used. Yes Yes No No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Time and Date display Yes Yes Yes Yes

1 Peripheral Status display Yes Yes Yes Yes

2 Peripheral Status Detail display Yes Yes Yes Yes

3 COS Buffer display Yes Yes Yes Yes

Table Number Access Flags For... Associated 
Application #
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Table 32: Modify access flags for D20AC WESMAINT II+ display screens (Application 
number: 32045)

Table 33: Read access flags for D20AC WESMAINT II+ display screens (Application num-
ber: 32045)

Table 34: Modify access flags for Prologic display (Application number: 36)

4 SHELL Yes Yes Yes Yes

5 Digital Inputs display Yes Yes Yes Yes

6 Digital Inputs Detail display Yes Yes Yes No

7 Digital Outputs display Yes Yes Yes Yes

8 Digital Outputs Detail display Yes Yes Yes No

9 Analog Inputs display Yes Yes Yes Yes

10 Analog Inputs Detail display Yes Yes Yes No

11 Analog Outputs display Yes Yes Yes Yes

12 Analog Outputs Detail display Yes Yes Yes No

13 Transition Counter display Yes Yes Yes Yes

14 Transition Counter Detailed display Yes Yes Yes No

15 SOE Buffer display Yes Yes Yes Yes

16 USER LOG display Yes Yes No No

17 Database Synch display Yes Yes Yes No

18 Switch-over display Yes Yes Yes No

19 System Status display Yes Yes Yes Yes

20 Communication Status display Yes Yes Yes Yes

21 Complex Object display Yes Yes No No

22 Complex Object Detail display Yes Yes No No

23 Generic Data display Yes Yes No No

24 Generic Data Detail display Yes Yes No No

25-31 Not used. Yes Yes No No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operato
r (3)

Observer 
(0)

0 D20 AC Main Menu Yes Yes Yes Yes

1 Circuit Display Page Yes Yes Yes Yes

2 Circuit Configuration Page Yes Yes Yes Yes

3 D20 AC Configuration Page Yes Yes Yes Yes

4 – 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)
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Table 35: Read access flags for Prologic display (Application number: 36)

Table 36: Modify access flags for DNP DPA configuration display (Application number: 
32021)

Table 37: Read access flags for DNP DPA configuration display (Application number: 
32021)

Table 38: Modify access flags for internet statistics display (Application number: 162)

Table 39: Read access flags for internet statistics display (Application number: 162)

Table 40: Modify access flags for DNP serial data link display (Application number: 
32013)

Table 41: Read access flags for DNP serial data link display (Application number: 32013)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Connect to Prologic Editor Yes Yes Yes No

1 Request Control of Port Yes Yes Yes No

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-23 Not Used Yes Yes Yes No

24 Modify Points / Detail Displays Yes Yes Yes No

25-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 DNP DPA Display Yes Yes Yes Yes

1-22 Not Used Yes Yes Yes No

23 Configuration Pages Yes Yes Yes Yes

24 Detail Pages Yes Yes Yes No

25 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No
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Table 42: Modify access flags for Modbus DCA display (Application number: 59)

Table 43: Read access flags for Modbus DCA display (Application number: 59)

Table 44: Modify access flags for Modbus DPA display (Application number: 68)

Table 45: Read access flags for Modbus DPA display (Application number: 68)

Table 46: Modify access flags for file upload interface (Application number: 32071)

Table 47: Read access flags for file upload interface (Application number: 32071)

Table 48: Modify access flags for SOE Logger (Application number: 27)

Table 49: Read access flags for SOE Logger (Application number: 27)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

1 - 31 Not Used Yes Yes yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No
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Table 50: Modify access flags for SEL DCA (Application number: 78)

Table 51: Read access flags for SEL DCA (Application number: 78))

Table 52: Modify access flags for IEC 60870-5-101/104 DPA (Application number: 101)

Table 53: Read access flags for IEC 60870-5-101/104 DPA (Application number: 101)

Table 54: Modify access flags for Landis & Gyr 8979 DPA (Application number: 185)

Table 55: Read access flags for Landis & Gyr 8979 DPA (Application number: 185)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 1 Not Used Yes Yes Yes No

2 Gateway access to serial port Yes Yes Yes No

3 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

1 Not Used Yes Yes Yes No

2 Show relay level 1 password Yes Yes No No

3 Not Used Yes Yes Yes No

4 Show relay level 2 password Yes Yes No No

5 - 7 Not Used Yes Yes Yes No

8 Show MUX level 1 password Yes Yes No No

9-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 Force / Unforce Point, Delete All or 
Delete to Cursor in SOE Log Display

Yes Yes Yes No

2 Freeze Accumulator Yes Yes Yes No

3 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Main Display Yes Yes Yes Yes

1 Analog Input Display Yes Yes Yes Yes

2 ADC Reference Display Yes Yes Yes Yes

3 Indication, SOE or Digital Input Display Yes Yes Yes Yes

4 Accumulator Display Yes Yes Yes Yes
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Table 56: Modify access flags for Harris 6000/XA-21 DPA (Application number: 199)

Table 57: Read access flags for Harris 6000/XA-21 DPA (Application number: 199)

Table 58: Modify access flags for IEC 60870-5 FT1.2 Balanced Data Link (Application 
number: 32085)

5 SOE Log Display Yes Yes Yes Yes

6 Analog Output Display Yes Yes Yes Yes

7 Digital Output Display Yes Yes Yes Yes

8 LRU Configuration Display Yes Yes Yes Yes

9 Cross References Display Yes Yes Yes Yes

10 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 Not Used Yes Yes Yes No

2 Not Used Yes Yes Yes No

3 Force Digital Output (Digital Output 
Display)

Yes Yes Yes No

4 Not Used Yes Yes Yes No

5 Not Used Yes Yes Yes No

6 Force Analog Output (Analog Output 
Display)

Yes Yes Yes No

7 Force R/L Output (R/L Outputs Display) Yes Yes Yes No

8 Delete All COS (COS Display) Yes Yes Yes No

9 Delete All SOE (SOE Display) Yes Yes Yes No

10 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Main Display Yes Yes Yes Yes

1 Port Assignment and Cross References 
Displays

Yes Yes Yes Yes

2 Current Status Display Yes Yes Yes Yes

3 Digital Output Display Yes Yes Yes Yes

4 Accumulator Display Yes Yes Yes Yes

5 Analog Input Display Yes Yes Yes Yes

6 Analog Output Display Yes Yes Yes Yes

7 R/L Outputs Display Yes Yes Yes Yes

8 COS Display Yes Yes Yes Yes

9 SOE Display Yes Yes Yes Yes

10 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]
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Table 59: Read access flags for IEC 60870-5 FT1.2 Balanced Data Link (Application num-
ber: 32085)

Table 60: Modify access flags for DNP V1.00 Data Link (Application number: 17)

Table 61: Read access flags for DNP V1.0 Data Link (Application number: 17)

Table 62: Modify access flags for Quantum Meter Scanner DCA (Application number: 18)

Table 63: Read access flags for Quantum Meter Scanner DCA (Application number: 18)

Table 64: Modify access flags for CDC Type 1 DPA (Application number: 23)

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Update counters in the DNP Comm. 
Statistics Display

Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 DNP Comm. Statistics Display Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 1 Not Used Yes Yes Yes No

2 Update counters in Quantum Meter 
Status Display

Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Quantum Function Menu Yes Yes Yes Yes

1 Quantum Meter Data Display Yes Yes Yes Yes

2 Quantum Meter Status Display Yes Yes Yes Yes

3 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No
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Table 65: Read access flags for CDC Type 1 DPA (Application number: 23)

Table 66: Modify access flags for PID DTA (Application number: 41)

Table 67: Read access flags for PID DTA (Application number: 41))

Table 68: Modify access flags for the MODBUS TCP DCA (Application number: 131)

Table 69: Read access flags for the MODBUS TCP DCA (Application number: 131)

Table 70: Modify access flags for the MODBUS TCP DPA (Application number: 135)

Table 71: Read access flags for the MODBUS TCP DPA (Application number: 135)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Main Menu Yes Yes Yes No

1 - 8 Not Used Yes Yes Yes No

9 Accumulators Display, 
Analog Inputs Display,
Direct Analog Outputs Display, 
SBO Analog Outputs Display, 
Direct Controls Display, 
SBO Controls Display,
Status Inputs Display, 
Direct Setpoints Display, and 
SBO Setpoints Display

Yes Yes Yes No

10 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any page Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No
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Table 72: Modify access flags for the LogicLinx DTA (Application number: 32082)

Table 73: Read access flags for the LogicLinx DTA (Application number: 32082)

Table 74: Modify access flags for PML 3710 DCA (Application number: 74)

Table 75: Read access flags for PML 3710 DCA (Application number: 74)

Table 76: Modify access flags for Courier DCA (Application number: 98)

Table 77: Read access flags for Courier DCA (Application number: 98)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 SSH Port Forward Connect Yes Yes No No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Wesmaint Connect Yes Yes No No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No
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Appendix B: Standards & Protection

Standards & Protection

This Appendix lists the standards with which the D20 have been tested for compliance.

Compliance standards

Compliance standards are listed for the following categories:

• Emission standards; see Table 78

• Immunity standards; see Table 79

• Safety publications; see Table 80

• Environmental standards; see Table 81

Table 78: Emission standards

Table 79: Immunity standards

Standard Name Description D20 Test Specification

EN55011 (CISPR 11)1 ISM RF equipment – Electromagnetic 
disturbance characteristics

Radiated Emissions 30 MHz to 1 GHz
Conducted Emissions 150 kHz – 
30 MHz

Standard Name Description D20 Test Specification

IEC 61000-4-2 Electrostatic discharge (ESD) 
immunity test

Contact Discharge: 8 kV
Air Discharge: 15 kV
HCP and VCP: 8 kV 

IEC 61000-4-3 
IEC 61850-3: clause 5.7.2

Radiated, radio-frequency 
electromagnetic field immunity test

80 MHz to 1 GHz: 10V/m
1.4 GHz to 2 GHz: 3V/m
2 GHz to 3 GHz: 1V/m

IEC 61000-4-4 
IEC 61850-3: clause 5.7.1.4

Electrical fast transient/burst 
immunity test

Direct Couple: 4 kV/5 kHz
Capacitive Clamp: 2 kV/5 kHz

IEC 61000-4-5 Surge immunity test Power port 2kV                                    
Signal port 2kV

IEC 61000-4-6 Immunity to conducted disturbances, 
induced by radio-frequency fields

150 kHz to 80 MHz: 10Vrms
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Table 80: Safety publications

Table 81: Environmental standards

1 To comply, the ferrite clamp (460-0073) supplied must be installed on the power cable.

IEC 60255-22-1 1 MHz burst immunity test Pass

IEC 61000-4-8 Power frequency magnetic field 
immunity test

100A/m @ 180s
1000A/m @ 3s

IEC 61000-4-12 Ring wave Pass

IEC 61000-4-11 Voltage dips, short interruptions and 
voltage variations immunity tests

Pass

IEC 61000-4-16
IEC 61850-3: clause 5.7.1.3

Test for immunity to conducted, 
common mode disturbances in the 
frequency range 0 Hz to 150 kHz

30Vrms, 300Vrms

IEC 61000-4-17 Ripple on DC input power port 
immunity test

Pass

IEC 61000-4-29+ Voltage dips, short interruptions and 
voltage variations on DC input power 
port immunity test 
This standard only applies when using 
high voltage DC as the source 
(100 V DC to300 V DC).

Pass

Standard Name Description D20 Test Specification

IEC 61010-1 Safety requirements for electrical 
equipment for measurement, control and 
laboratory use - General requirements

IEC 60255-5 Insulation coordination for measuring 
relays and protection equipment- 
Requirements and tests

Dielectric and Resistance 
measurements not applicable 
due to design (TVS in circuit)

Standard Name Description D20 Test Specification

IEC 60068-2-1 Cold 96 hours powered at - 20 °C

IEC 60068-2-2 Dry Heat 96 hours powered at + 70 °C

IEC 60068-2-6 Vibration (sinusoidal) A logarithmic sweep from 10 Hz to 150 Hz to 
10 Hz at 1 oct/min for 1 sweep cycle in the 3 
orthogonal axes.
Acceleration level 1 g

IEC 60068-2-27 Shock - Operating Response 
Test
Shock - Non-Operating 
Withstand Test

-   Operating Response Test: Acceleration 
level: 5 g's
-   Non-Operating Withstand Test: 
Acceleration level: 15 g's
3 pulses per polarity per axis for a total of 18 
pulses

IEC 60068-2-29 Bump – Non operating test 10g peak, 1000 pulses per polarity per axis 
for a total of 6000 pulses

IEC 60068-2-30 Damp heat, cyclic (12 h + 12 h 
cycle)

96 hours humidity at +25 °C / +55 °C at 95% 
RH

IEC 60068-2-31 Drop and topple 50 mm drop on 4 edges and 4 faces

IEC 60068-2-78 Humidity Testing 96 hours steady state humidity at 40 °C and 
93% RH

Standard Name Description D20 Test Specification
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Questions

Frequently Asked Questions

This appendix answers some frequently and commonly asked D20MX questions:

• Why is a D20MX RTU important?

• How does configuration storage work in the D20MX?

• Why does the D20MX use the Vxworks Operating System instead of pSOS?

• Is the D20MX hardware backward compatible?

• Are the PCOMMON versions compatible with the D20MX?

• What is the recommended operating temperature range of the D20MX?

• What software application is used to configure a D20MX configuration?

• Can you migrate an old D20 configuration to D20MX?

• What comprises a typical D20MX firmware upgrade?

• How do you upgrade the low-level firmware components of a D20MX?

• Can you migrate an old D20 configuration to D20MX?

• What comprises a typical D20MX firmware upgrade?

• How do you upgrade the low-level firmware components of a D20MX?

• What comprises a typical D20MX firmware upgrade?

• Is Active Directory integration possible?

• How are communications authenticated?

• How are communication authorized?

• Are communications encrypted?

• If remote management/configuration is possible, how is it secured?

• Describe steps taken to harden the system?
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Questions and answers

Q: Why is a D20MX RTU important?

A: The D20MX is being introduced for the following reasons:

– Some electronic components used in the D20 products have reached their end-
of-life; For example, the 68EC030 CPU in the D20ME II and D20ME boards.

– VXworks is the new operating system for the D20MX; this is more robust for D20 
applications.

– The D20MX offers Cyber Security features that are intended for critical 
infrastructure protection within the power system. This is required for Electric 
Reliability Compliance.

– The D20MX is a modern platform that is capable of handling current and future 
processing needs, particularly for security. 

– The D20MX has 1 GB of RAM, compared to 1 MB RAM in the D20ME. 

– The D20MX has 16 MB of built-in NVRAM, compared to the 512 KB of NVRAM 
available in its predecessor. Subsequently, there is no need for additional memory 
expansion modules. 

– The firmware flash memory size in the D20MX is 128 MB, compared to the 2 MB of 
its predecessor. 

– The D20MX uses a Super Capacitor which allows the system clock to be saved for 
14-days even after power off.

Q: How does configuration storage work in the D20MX?

A: The Super capacitor strictly allows the retention of the system clock time for 14-days. 
At power-up, the configuration resides in the RAM. At power-down, configuration 
resides in the flash. This is possible due to the seamless transaction between the RAM 
and flash. This arrangement protects the D20MX configuration from being lost, even 
after power-down for an indefinite period of time.

Q: Why does the D20MX use the Vxworks Operating System instead of pSOS?

A: Vxworks is designed for mission critical systems. It is purpose-fit , extremely robust 
and fast. It is industry-focused and designed from the ground-up to be a real-time 
operating system. It is the new operating system of choice for numerous embedded 
systems that require a high level of robustness.

A: Embedded systems manufacturers are moving away from the pSOS operating 
system since on-going support for this operating system is very limited.

Q: Is the D20MX hardware backward compatible?

A: The D20MX hardware is compatible with the I/O modules installed in the field.

A: Due to aging printed circuit board assembly and mechanical constraints, only certain 
chassis from 2002 and onward can be used with a D20MX. This comprises the 
following chassis:

– D20 VME chassis 500-0280 Release 08 or higher 

For the VME chassis 500-0280, the zero volt cable supplied with the D20MX KIT, 
must be connected from the zero volt TB2 terminal block on the 517-0225 to zero 
volt on the 517-0123. Review the hardware manual for the steps involved. Part 
number for the zero volt wire cable is 975-1237.

– D20 Non-VME chassis 500-0305 Release 18 or higher
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Q: Are the PCOMMON versions compatible with the D20MX? 

A: The following PCOMMON versions are compatible with the D20MX:

– P022 v3.06, v3.05 and 3.00: PCOMMON for D20C 
 Note: v3.06 is required if fiber optic repeaters / splitters are used.

– P010 v3.06, 3.05, 3.01 and 3.00: PCOMMON for D20A, D20S and D20K

– P087 v1.04, 1.03 and 1.02: pBOOT for D20AC

A: Also see the PCOMMON versions compatible with the D20MX in Table 13 on page 57.

Q: What is the recommended operating temperature range of the D20MX?

A: The operating temperature range is 0°C to +70°C. 

Note:   Do not operate the D20MX above 60°C for extended periods of time as this 
shortens the life of the super capacitor and reduces the backup time of the real time 
clock.

Q: What software application is used to configure a D20MX configuration?

A: The SGConfig (version 8.1 or higher) offline configuration tool is used to configure the 
D20MX. SGConfig is similar to ConfigPro which is used to program its predecessor.

Q: Can you migrate an old D20 configuration to D20MX?

A: ConfigPro is partly used to get the D20 device configuration ready for migration into 
the SGConfig tool.

A: It is recommended to migrate a project rather than a device to prevent partial loss of 
configuration data related to Ethernet/LAN.

A: For detailed migration steps, see section “Transfer D20/D200 configurations to the 
D20MX” on page 91.

Q: What comprises a typical D20MX firmware upgrade?

A: Typically a firmware upgrade of the D20MX involves only the operating system and 
application firmware images, which are transferred by SFTP.

Q: How do you upgrade the low-level firmware components of a D20MX?

A: To upgrade the low-level firmware components (i.e., Bootrom, FPGA or JMON) of a 
D20MX run a TFTP client from the JMON prompt of the D20MX. Upgrading of these 
low-level firmware components is seldom required. 

Q: What comprises a typical D20MX firmware upgrade?

A: Typically a firmware upgrade of the D20MX involves only the operating system and 
application firmware images, which are transferred by SFTP.

Q: Is Active Directory integration possible?

A: Yes. Since the D20MX supports RADIUS, the D20MX can be integrated with Active 
Directory through the Microsoft RADIUS Servers: Network Policy Server when using 
Windows Server 2008 or 2012 or Internet Authentication Service when using 
Windows Server 2003. Refer to SWM0076 or SWM0075 for details.
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Q: How are communications authenticated?

A: Network Communications

RADIUS or the local password store provides authentication for the following network 
access types: Wesmaint II+ / console access, LogicLinx debugging and configuration, 
firmware transfer. 

Network SCADA protocols are currently not authenticated, but this is a limitation of the 
protocol rather than the D20MX. Protocols such as DNP SAv5 which do provide 
authentication are on the road-map for the D20MX.

A: Serial Communications

RADIUS or the local password store provides authentication for the following serial 
access types: Wesmaint II+ / console access, LogicLinx debugging and configuration/
firmware transfer. 

Serial SCADA protocols are currently not authenticated, but this is a limitation of the 
protocol rather than the D20MX. Protocols such as DNP SAv5 which do provide 
authentication are on the road-map for the D20MX.

Q: How are communication authorized?

A: Network Communications

RADIUS or the local configuration user database provide authorization for the 
following network access types: Wesmaint II+ / console access, LogicLinx debugging, 
and configuration/firmware transfer. Authorization is provided for four roles: 
Administrator, Engineer, Operator and Observer.

Authorization for network SCADA protocols is currently not provided, but this is a 
limitation of the protocol rather than the D20MX. Protocols such as DNP SAv5 which 
do provide authorization are on the road-map for the D20MX.

A: Serial Communications

RADIUS or the local configuration user database provide authorization for the 
following serial access types: Wesmaint II+ / console access, LogicLinx debugging and 
configuration/firmware transfer. Authorization is provided for four roles: Administrator, 
Engineer, Operator and Observer.

Authorization for serial SCADA protocols is currently not authenticated, but this is a 
limitation of the protocol rather than the D20MX. Protocols such as DNP SAv5 which 
do provide authorization are on the road-map for the D20MX.

Q: Are communications encrypted?

A: Network communication for the following network access types are encrypted: 
Wesmaint II+ / console access, LogicLinx debugging, and configuration/firmware 
transfer. RADIUS authentication messages are also encrypted if PEAP/EAP-TTLS is 
used. 

Q: If remote management/configuration is possible, how is it secured?

A: Remote management/configuration is possible. It is secured by means of SSH, with 
Authentication/Authorization as previously described.



APPENDIX C: FREQUENTLY ASKED QUESTIONS

D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL GE INFORMATION 147

Q: Describe steps taken to harden the system?

A: The system has been hardened by:

– Performing Coverity static analysis and correcting issues on key applications.

– Running Spirent and Wurldtech network security test suites on every release. 
(Fiber D20MX model is Achilles L1 certified.)

– Running Automatak DNP / Modbus Fuzzers on every release.

– Regularly performing Impact assessments on published vulnerabilities. If 
impacted, open/closed source is updated to address vulnerabilities and provided 
in next D20MX release.

– Enabling Operating System features that promote security such as kernel 
hardening.
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Appendix D: Using ConfigPro with 
D20MX

Using ConfigPro with D20MX

While SGConfig is recommended for configuring and transferring a D20 configuration to 
the D20MX, it is also possible to configure the D20MX using ConfigPro.
This appendix describes how to transfer a D20 configuration to the D20MX using 
ConfigPro. 
Refer to the “Application definition files and default configurations” on page 172 to see 
how application definition files and factory default configuration files can be installed.
Using ConfigPro to configure and transfer a D20 configuration to a D20MX is done by:

• “Transferring D20 configurations to the D20MX” on page 150

• “Downloading a D20MX configuration” on page 163
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Transferring D20 configurations to the D20MX

To transfer a D20 configuration to the D20MX using ConfigPro:

1. Create a D20MX device.

1.1. Right-click the D20 device. 

1.2. Select Copy….
Result: The Select Project and Page to Copy Device to window appears.

1.3. In the Device Name field, rename the device as a D20MX device.
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2. Generate a report of the applications in the original D20 device configuration and 
determine the unused applications.

2.1. Right-click on the created D20MX device and select Reports > Application List .
Result: The Select Reports dialog appears with the Application List report 
selected.

2.2. Click Setup.
Result: The Print Setup dialog appears.

2.3. Select a printer in the Name field if the Name field is empty. 
Result: A printer is selected in the Name field.

2.4. Click OK and OK.
Result: A new tab named Application List opens and contains the Application 
List report for the original D20 device.

2.5. Compare the Application List report with Table 2 D20MX application definitions 
on page 16. With the exception of LAN Redundancy Manager (B119-1N), note 
the applications that appear in Table 2 but not in the report. You may want to 
print Table 2 and mark these applications. These applications are referred to as 
“unused” applications in the steps to follow.

2.6. Click the Door icon to close the Application List report.
Result: The project containing the created D20MX device reappears.

3. Edit the device properties of the created D20MX device so that it uses an appropriate 
D20MX SAN firmware file and it has similar device properties to the desired D20MX 
factory default configuration. 

The D20MX SAN firmware files exist in two forms:

– SAN0001 contains the latest versions of all applications and should be used in all 
new configurations.

– SAN0002 contains older versions of the Mailbox DTA [B009] and DNP v3.00 DPA 
[B021] and is required for systems with older applications. If transferring 
configurations containing B009 versions less than or equal to 310 and B021 
versions less than or equal to 912, use the file SAN0002 firmware. For more 
details, see Table 2, “D20MX applications,” on page 19.

3.1. Select the factory-based D20MX configuration file to be restored. 

3.1.1. Right-click the D20MX device. 

3.1.2. Select Archive > Restore.
Result: The Select a Device Zip file to Restore window appears.
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3.1.3. Navigate to the factory default configuration files which were staged 
previously. 
The listed factory-default configuration files with a .zip extension were 
built with ConfigPro.

3.2. Select a project location to which the configuration file is to be restored. 
Note: The D20MX factory default configuration files are ConfigPro 5 based. If 
using ConfigPro 6 or 7, when prompted to upgrade, select Yes. 

If a message indicates that a nested loop [project] is to be created, choose a 
different Project directory as required: e.g., C: drive in the screen capture that 
follows. 
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3.3. Open the restored factory default configuration file.

3.3.1. Navigate to the project directory where the factory default configuration 
was restored.

3.3.2. Open the file. 

3.3.3. Use the Projects and Windows tab to switch screen content. The 
Windows tab allows access to different projects. 

As shown above, the device properties of the factory default 
configuration MX01 uses SAN0001. 
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3.3.4. Right-click on the factory default configuration's main page and select 
Firmware.

3.3.5. Select the required SAN firmware and click Copy to transfer this firmware 
to the project location in step 1.

This is the location of the copy of the D20 device being modified. In 
step 1, this D20 device was copied and renamed as a D20MX device.
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Result: The D20MX device location now has a firmware library that 
contains the SAN firmware transferred from the previous step.

3.4. Select the D20MX device created in step 1 [copied and renamed D20 device], 
which is to use the intended SAN firmware in the firmware library.

3.4.1. Right-click on the D20MX device.

3.4.2. Select the Processor tab > Firmware tab > Use Firmware Type checkbox 
to choose the SAN0001 firmware. 
Result: The Select a Firmware Type window appears. Click OK.

3.4.3. Confirm the SAN0001/SAN0002 firmware is now associated to the 
D20MX device (from step 1).
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3.5. Manually set the D20MX processor card. 
Note: In the same device properties, the General tab does not include a D20MX 
processor card.

3.5.1. Manually set the memory model in the D20MX device being modified by 
selecting the Processor tab > Memory Model tab > Set Manually option.

Use the memory model settings from the factory default configuration as 
a reference, See the table below.

NOTE

Step 3.6 is applicable if the device configuration were a “LAN-based Device” 
configuration. LAN-based device in the device properties must first be selected under 
the main General tab. It is impossible to have a LAN-based device unless the project 
itself is a LAN-based project with all network addresses and settings clearly defined 
for LAN A and optionally B. Step 3.6 assumes that the reader is familiar with the 
complete ConfigPro LAN settings configuration steps and that these steps have 
already been considered. It points out the D20MX factory default LAN-settings.

3.6. Set the LAN Settings.
Default LAN-Based Important Settings:    Notice that the D20MX factory 
default configurations are LAN-based. This is because the hardware of the 
D20MX RTU has built-in LAN functionality by default. Subsequently, no extra 
Media Interface Card or EME card is needed. 

 D20MX Processor Memory Model - Set Manually

EPROM Base 60000000 [HEX] EPROM Size 10000000 [HEX]

NVRAM Base 50010000 [HEX] NVRAM Size 00FF0000 [HEX]

RAM Base 00000000 [HEX] RAM Size 40000000 [HEX]

No D20MX card 
choice from this list
 
Need to set a man-
ual memory map



APPENDIX D: USING CONFIGPRO WITH D20MX

D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL GE INFORMATION 157

3.6.1. For LAN-based D20MX configurations, ensure that the BOOTP Settings 
option is disabled; select the Not Used option.

3.6.2. The Services settings highlighted below are used for remote connection 
into the RTU. If not included in the Services settings, the defaults for 
WesmaintSSH and CommandSSH are 22 and 922 respectively. If 
included, these ports can be changed to customized numbers:

– WesmaintSSH allows remote access to the wesmaint menu. 

– CommandSSH allows remote access to SFTP and the D20M shell. 

These are both TCP connections.

4. Click OK when the D20MX device properties are set.

Result: The applications present in the SAN firmware are applied to this new D20MX 
device. 
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5. Carefully configure the applications of interest before generating the tables for the 
D20MX device. Disable unused applications. as determined from step 2.

5.1. In the D20MX device from step 1, disable the unused applications identified in 
step 2. 
In addition, disable B119-1N LAN Redundancy Manager if the device is not 
LAN-based.

5.2. Configure the Wesmaint II+ [B014-1N] and System Point Database [B008-1] 
applications. 

5.3. Configure the new Wesmaint II [B014-1N] application referring to its 
configuration guide. There are new tables and security settings that are 
required to be configured. For complete details, refer to the D20MX 
Documentation CD or extracted zip file for the B014-1N configuration guide.

5.3.1. While in the D20MX device created in step 1, double-click and go to the 
System Point Database tab which contains the Wesmaint II+ application. 
Right-click on the RADIUS Role Table [B014RADR] and import the 
B014RADR settings. 
Navigate to the DVD/CD drive or the ISO Image sub-folder nested two 
levels into the folder extracted from the D20MX Documentation CD zip 
file. Then navigate to Configuration Files > DefaultTableSettings > 
B014-1 Wesmaint II+. Select the file named B014RADR.CSV, and click 
Select .
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5.4. Configure the LAN Redundancy Manager (B119-1N) application.
Note: If the LAN Redundancy Manager (B119-1N) application in the Data 
Translation Applications tab is enabled, its pseudo point descriptions must be 
correctly set. Complete the following steps to ensure this. 

5.4.1. Go to the D20MX device being modified. Double-click the device. 
Navigate to the System point database Applications tab. Double-click 
the System Point Database application. Select the LAN Redundancy 
Manager from the list of applications. Click Descriptors. Click the Import 
icon.
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5.4.2. Click OK. Then, navigate to the DVD/CD drive or the ISO Image sub-folder 
nested two levels into the folder extracted from the D20MX 
Documentation CD zip file. Then, navigate to Configuration Files > 
DefaultPointDescriptions > B119-1N LAN Redundancy Manager. Select 
DIDESC.TXT and click Select .

5.4.3. Confirm the pseudo point descriptions changed as shown below. Click OK 
to accept the change and to close each window.

5.4.4. Carefully configure all other enabled applications based on their 
respective configuration guides. This is required before a configuration 
can be successfully generated without errors. 
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5.4.5. Right-click the device and generate all the tables of the device. Carefully 
review and resolve all error and warnings. 
Note: A red dot on a device indicates that the device's tables need to be 
generated. Unresolved errors makes the red dot remains

5.4.6. Open up the device and go to the Wesmaint II+ application to compare 
the RADIUS Role [RADR] tables in the factory default D20MX device with 
that in the newly modified D20MX device. Compare the first two columns 
[Role ID and Role Name] as shown below to confirm the import was 
successful. If not, repeat the import process.

6. Generate the device configuration, after a configuration has been properly 
configured. 

Result: If there are no errors or warnings, the red dot on the device should not appear 
and the generated device is ready to be downloaded into the D20MX RTU. 

7. The transfer of a D20 configuration into a D20MX configuration is complete. 
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Configuration file in project directory

NOTE

In step 5.4.5, a D20MXDEVICE.SHX file was created after generating the tables of this 
D20MX device created. This file can be found within the device directory in windows 
explorer. 

The D20MXDEVICE.SHX file is the file downloaded into the D20MX during the configuration 
download process.
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Downloading a D20MX configuration

A D20MX configuration can be downloaded either through a:

• Local [Serial] Transfer of Configuration, or a

• Remote [Secure] Transfer of Configuration

Local [serial] transfer of configuration
The local transfer of configuration can be done by either:

• “Option 1 - use ConfigPro terminal emulator and the F7 key” on page 163

• “Option 2 - Use a non-ConfigPro terminal emulator and a “dl” command” on page 166

Option 1 - use 
ConfigPro terminal 

emulator and the F7 
key

Serial configuration download to the D20MX is done from within ConfigPro similar to a 
D20. 
To use a serial connection to download a configuration to the D20MX, using the ConfigPro 
terminal emulator and F7 key:

1. Connect a cable; either a: 

– NULL modem cable (GE Energy part number 977-0529) from the RS-232 
connector at the front panel of the D20MX to the serial communication port of the 
PC. 

OR

– Wesmaint cable [977-0300] could be used to connect the Wesmaint port at the 
back of the D20MX chassis to the serial communication port of the PC.

2. Set up the terminal emulator with the D20MX communications parameters.

2.1. From ConfigPro, select Device > Communications > Communications 
Options….
Result: The Communications Options window appears.
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2.2. Set the communication options:

– Baud Rate: baud rate of the D20MX (9600 or 19200 bps - see “RS-232” 
on page 63 if you need to change the baud rate).

– Parity: None

– Data Bits: 8

– Stop Bits; 1

2.3. Connect to the D20MX device. 

2.3.1. Right-click or click the device icon. 

2.3.2. Select Device > Communications > Terminal Emulator.

2.3.3. Login to the D20MX terminal using the login and password. When logging 
into the D20MX for the first time, use the default login and password 
[Login: admin | Password: changeme].
Result:   The D20M prompt appears.

2.3.4. Confirm that access is allowed by pressing the Enter key a couple of 
times.

2.4. Download [sync] the configuration from ConfigPro to the D20MX by pressing 
the F7 key on the key board. 

2.5. Optionally you can set up the terminal emulator for faster download speed:

2.5.1. Login to the D20MX device through the ConfigPro Terminal Emulator.
Result: The D20M prompt appears.

2.5.2. Type baud 57600 and press Enter. 
Result: The D20MX baud rate changes to 57600.

2.5.3. Disconnect the D20MX from ConfigPro by selecting Communications > 
Disconnect .

2.5.4. Open the communication properties by selecting Device > 
Communications > Communications Options…. 
Result: The Communications Options window appears.
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2.5.5. Change the baud rate to match 57600 by selecting the Software 
Transmit and Software Receive options and then clicking OK.

2.5.6. Reconnect to and login to the D20MX. See step 2.3 [Connect to the 
D20MX device].

2.5.7. Download [sync] the configuration from ConfigPro to the D20MX by 
pressing the F7 key. 
Result: The Download Configuration File progress bar appears.

2.6. Restart the D20MX device when the download is complete by clicking Boot .

NOTE

Booting the D20MX resets it to its previous baud rate. If the baud rate in the 
D20MX is not the same as that in the communication properties, the command 
prompt shows the following characters. 

If this is the case, change the ConfigPro communication properties to match 
the baud rate of the D20MX.
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Option 2 - Use a non-
ConfigPro terminal 

emulator and a “dl” 
command

A D20MXDEVICE.SHX file is created when the tables of the D20MX device are generated. 
See section “Configuration file in project directory” on page 162 or see step 8 [Locate the 
D20MXDEVICE.SHX file] within this section.
Serially transfer the D20MXDEVICE.SHX file using Tera term (a terminal emulator) to the 
D20MX RTU using the dl command; this is similar to the download process of a D20ME 
firmware configuration. This download process is done at the D20M prompt. 
To download a configuration to the D20MX, using a non-ConfigPro terminal emulator and 
a “dl” command:

1. Connect a NULL modem cable (GE Energy part number 977-0529) from the RS-232 
connector located at the front panel of the D20MX to the serial communications port 
of the PC or terminal. 

2. Set-up a VT100 terminal emulator [e.g., Tera term Pro] with the following serial 
communication parameter values:

NOTE

To determine the computer port used, on the computer's desk top, right-click on the 
My Computer short-cut icon and go to Manage. Go to Device Manager > Ports as 
shown below. 

3. Login to the D20MX device. The factory default configuration for the D20MX comes 
with one default user account with: Username: admin; Password: changeme. 

Parameter Value

Port COM1 or COM2, or as required by the computer being used.

Baud Rate Baud rate of the D20MX (9600 or 19200 bps - see “RS-232” on page 63 
if you need to change the baud rate).

Data 8 bit

Parity none

Stop 1 bit

Flow Control Xon/Xoff

Transmit delay 0   msec/char; 0 msec/line
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4. Navigate to the D20M prompt; this is called a SHELL prompt - an equivalent of the 68K 
monitor prompt. 

5. Press the Enter key a couple of time to display and confirm the required prompt; that 
is, D20M. 

6. Type sp to suspend the processor, then type dl to download and press Enter.

7. The D20MXDEVICE.SHX file located in the project directory below can simply be 
dragged and dropped in the Tera term window. 
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8. Locate the D20MXDEVICE.SHX file. 

8.1. Open Windows explorer.

8.2. Navigate to the project directory where this D20MX device is located. 
Note: The file name D20MXDEVICE represents the device name.

9. Drag and drop the D20MXDEVICE.SHX file onto the Tera term window. 

NOTE

Once a configuration download has been completed, it is recommended that the default 
user account information be changed as soon as possible. Refer to the B014-1NCG 
WESMAINT II+ for the D20MX - Configuration Guide for details on how to modify user 
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accounts and how to change the password of a user. The D20MX configuration can be 
defaulted by pressing CTRL-F on a terminal connected over the front RS232 port during 
startup. In addition, if the D20MX detects a corrupt configuration on startup, it generates a 
system default configuration. 
The system default configuration comes with one user account: username: recover; 
password: system. Login with this username and synchronize a configuration to the 
D20MX over the front RS232 port. 

NOTE

The D20MX can only be accessed over the front RS232 port with the system default 
configuration. 
If you synchronize a configuration with any of the following errors: “there are no 
usernames configured in the B014 User table”; “the B014 User table is disabled”, or “the 
B014 application definition does not match the firmware version”, then the applications do 
not start and you have only serial access in debug mode.

Remote [secure] transfer of configuration
Since Telnet and TFTP file transfer do not provide a secure means to connect or transfer 
data to the D20MX RTU, they are not supported within the D20MX. 
The D20MX now supports both SSH and SFTP means of connection. The D20MX RTU must 
be equipped with a valid IP configuration that allows computer PC connectivity. 
WinSCP is an example of a commonly used tool that allows connectivity to the D20MX 
remotely. This can be found on the web. WinSCP downloads are available at: 

http://winscp.net/eng/download.php 
To transfer the configuration file:

1. Set your computer IP address to be in the same domain [IP address and Subnet mask] 
as the D20MX.

2. Close any currently opened terminal session to the D20MX.

3. Start WinSCP.
Result: The WinSCP Login window appears.
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4. Login to WinSCP using the D20MX IP address and port number 922 or the configured 
CommandSSH port.

NOTE

In the D20MX configuration, port 922 has been created in the Services section of the 
Device LAN Properties as CommandSSH.

5. If the following window appears, click Yes.

6. Make a copy of the generated configuration file D20MXDEVICE.SHX and rename it to 
device.shx. 

7. Transfer the device.shx file by dragging it from your computer local drive into the 
D20MX's ram. 
Result: The Copy window appears.
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8. Click Copy.

9. Login to the D20M prompt of the D20MX RTU - this is the SHELL [option 3] menu. 

10. Suspend the processor by typing sp and pressing Enter. 

11. Copy the configuration by typing cc and pressing Enter. 

12. Select the configuration file by tying sc and pressing Enter.

13. Restart the D20MX device by typing boot and pressing Enter. 
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Application definition files and default 
configurations

The D20MX Documentation CD or extracted zip file contains numerous folders and files. 
The three main folders for the purpose of this document are highlighted below. 

The D20MX Documentation CD or extracted zip file contains all of the following:

•  Configuration guides, including the Wesmaint II+ user and configuration guides. 

• Factory Default Configuration files: Application Definitions/D20MXv1_3Appldefs. The 
ConfigPro sub-folder contains the factory default zipped ConfigPro files.

Staging factory default configuration files
To stage the factory default configuration files so that they may be accessed by ConfigPro:

1. Press the Windows Key  and E at the same time. 

Result: The Windows Explorer window appears.

2. Navigate to a folder to which you have write permissions.

Result: The content of the folder appears.

3. Click the New folder button in Windows Explorer

Result: A new folder is created with the name “New folder” and the cursor is positioned 
to allow renaming of the folder.

4. Rename the folder to D20MXVXX.

Result: The folder is renamed to D20MXVXX.

5. Access the D20MX Documentation CD files by either:

5.1. Insert the D20MX Documentation CD in to the computer’s DVD/CD drive, or

5.2. Extract the D20MX Documentation CD zip file on to the root of your C: drive and 
double click the readme.html file under the ISO-Image sub-folder, which is 
nested two levels deep into the extracted folder.

Result: The Documentation CD home page appears in your default Web Browser.

Result: Alternately for step 5.1, the home page does not appear in your default Web 
Browser. In this case, navigate to the CD in Windows Explorer, and double-click the 
readme.html file on the root of the CD.
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6. Under the D20MX Factory Default Configuration Files section, click on the link 
named ConfigPro.

Result: The Factory Default Configuration Files folder appears.

7. Using Windows Explorer, copy/paste the files as shown in the following table. To copy 
a file, select it and press Ctrl-C. To paste a file, click on the Windows Explorer window 
showing the new D20MXVXX folder and press Ctrl-V.

Result: The files shown in the above table appear in the new D20MXvXX folder of the 
Windows Explorer window.

Installing application definitions: archived
To install the application definitions:

1. From ConfigPro, initiate the Application Installer by selecting Tools > Application 
Installer.

Result: The ConfigPro Application Installer - Welcome window appears.

Navigate to folder on D20MX Documentation CD 
or Folder extracted from Zip File

Copy/Paste the following files to the 
new folder D20MXVXX

MX01-XX.zip MX01-XX.zip

MX02-XX.zip MX02-XX.zip
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2. Select the Install all applications from archive option and click Next .
Result: The ConfigPro Application Installer - Select Archive window appears.

3. Select the source directory where the application archive is stored.

3.1. Navigate to the source directory: Go to the D20MX Documentation CD or 
extracted zip file folder > Configuration Files sub-folder > Application 
Definitions folder. 

3.2. Select the D20MXv1.5Appldefs.zip file. 

3.3. Click Select . 

4. Click Next .
Result: The ConfigPro Application Installer - Select Destination Directory window 
appears.
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5. Select the destination directory into which the application definitions are to be copied. 
To determine the destination directory, in ConfigPro, go to File > Preferences > 
Directories. This is the path highlighted in the screen capture below 
[C:\WESSYS\ApplDef]
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6. Click Next .
Result: The ConfigPro Application Installer - Installation Complete window appears.

7. Click Finish.

Installing application definitions: non-archived
In the D20MX Documentation CD or extracted zip file, the DEFNs folder contains the 
APPLDEF sub-folder with all the application definition files.
To install missing application definition files:

1. From ConfigPro select Tools > Application Installer.
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Result: The ConfigPro Application Installer wizard appears.

2. Choose either of the following options:

– Install all the applications required in a project

– Install a number of applications YOU select.

3. Click Next .
Result: The ConfigPro Application Installer - Select Source Directory window appears.

4. Select a Source director [this is the DEFNs/ APPLDEF path within the D20MX 
Documentation CD or extracted zip file]. 



178 GE INFORMATION D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL

APPENDIX D: USING CONFIGPRO WITH D20MX

5. Select the DAL100.DB file and click Select . The Definitions Found field should indicate 
Yes. 

6. Click Next .
Result: The ConfigPro Application Installer - Select a ConfigPro Project window 
appears.

7. Select the ConfigPro project that requires these application definitions. 

8. Click Next .
Result: The ConfigPro Application Installer - Select Destination Directory window 
appears.
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9. Select the destination directory into which the application definitions are to be copied. 
To determine the destination directory, in ConfigPro, go to File > Preferences > 
Directories. This is the path highlighted in the screen capture below 
[C:\WESSYS\ApplDef]

10. Click Next .
Result: The ConfigPro Application Installer - Installation Complete window appears.

11. Click Finish.
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D20MX Substation Controller

Appendix E: Secure Connection for 
LogicLinx

Secure Connection for LogicLinx

This appendix provides the procedure to set up a secure connection to the D20MX for use 
with the LogicLinx editor in either ConfigPro or SGConfig. 
It is recommended that you use this procedure since it allows for strong security using the 
authentication, authorization and accounting model supported by other access points of 
the D20MX. 

Secure connection with SGConfig v8.1 or higher

To set up a secure connection to the D20MX for use with the LogicLinx editor using 
SGConfig v8.1 or higher:

1. Configure B014-1N Wesmaint II+ to grant the necessary privileges to allow the user to 
make connections to the LogicLinx application on the D20MX.

See “Wesmaint user configuration” on page 182.

2. Configure B082-0N LogicLinx to require a secure connection.

See “LogicLinx (B082-0N) configuration” on page 184.

3. Establish the secure tunnel using the LogicLinx Editor > LogicLinx Editor (Debug) 
command in SGConfig. Refer to the SGConfig online help for details on the LogicLinx 
Editor.
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Secure connection with ConfigPro

When using ConfigPro, the Windows* application 'PuTTY' (also known as “putty”) is used to 
establish an SSH tunnel from the LogicLinx editor running on the Windows PC to the 
LogicLinx application (B082) running on the D20MX. The establishment of an SSH Tunnel is 
also known as 'port forwarding'. At the time this procedure was published, the PuTTY 
Windows installer could be downloaded from:

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
To set up a secure connection to the D20MX for use with the LogicLinx editor using 
ConfigPro:

1. Configure B014-1N Wesmaint II+ to grant the necessary privileges to allow the user to 
make connections to the LogicLinx application on the D20MX. 

Refer to section “Wesmaint user configuration” on page 182.

2. Configure B082-0N LogicLinx to require a secure connection. 

Refer to section: “LogicLinx (B082-0N) configuration” on page 184.

3. Establish the secure tunnel using PuTTY. 

Refer to section “PuTTY configuration” on page 185.

4. Configure the LogicLinx editor to use the secure tunnel. 

Refer to section “LogicLinx Editor configuration” on page 189.

Wesmaint user configuration

In this procedure, a new local user “tom” is created and granted privileges to make 
connections to the LogicLinx application on the D20MX. If you are using remote 
authentication with RADIUS, the required privileges are available in the default settings of 
the Administrator or Engineer role.
To grant the necessary privileges to allow a local user to make connections to the 
LogicLinx application on the D20MX:

1.  View the Engineer role information from the RADIUS role table. 

In the Wesmaint II+ application:

1.1. Open the RADIUS Role table.

1.2. Select the row containing the role name “Engineer”.

1.3. Scroll right until you see the “Application Control” column. 

1.4. Double click the Application Control field for the Engineer role.

Result: A dialog showing the access flags for the Engineer role appears.
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2. Copy the access flags from the Engineer role:

2.1. Select all of the rows up to the first row with a 0 in the Application Control field. 

2.2. Press Ctrl-C to copy the rows. 

Result: The access flags for the Engineer role as shown in the following screen are 
stored in the Windows clipboard.

3. View the access flags for a new local user:

3.1. Open the User Configuration table.

3.2. Add a new row and scroll left until you see the Application Control column.

3.3. Double-click the Application Control field.

Result: A dialog showing the access flags for the new user appears.

4. Select the first row and press Ctrl-V to paste the application control flags from the 
Engineer role to the new local user.

Result: A dialog showing the Paste Options appears.

5. Click OK.

Result: The access flags for the Engineer role now appear in the new user's access flag 
list.

6. Click OK.

Result: The User Configuration table reappears.

7. For the Monitor Access Level field, select Maintenance. 

8. For the User Name field, type the name of the user, for example: tom. 

9. Click OK and OK.

Result: The Wesmaint User Configuration is closed.
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LogicLinx (B082-0N) configuration

To configure B082-0N LogicLinx to require a secure connection:

1. In the Logic Linx (B082-0N V400) Communication Types configuration table set:

a)    Communications Type:     Ethernet

b)    SSH Tunnel:     Tunnel Enabled

c)    Port Number:    1100

NOTE

The Port Number may be any unused port number on the D20MX between 1 and 
65535.

Result: The LogicLinx configuration appears as shown in the following screen.

2. Generate and synchronize this configuration to the target D20MX.
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PuTTY configuration

To establish a secure tunnel using PuTTY:

1. Start PuTTY.

2. In the PuTTY Configuration dialog box, select Connection > SSH > Tunnels.

2.1. Under Port forwarding leave Local ports … and Remote ports… unchecked.

2.2. Under Add new forwarding port: in the Source Port box type 1100, or any free 
TCP port number on your PC.

2.3. In the Destination box, type the IP address 127.0.0.1:1100, where 1100 is the 
port number set in the LogicLinx configuration (refer to step 1 in the: “LogicLinx 
(B082-0N) configuration” section). 

2.4. Click the IPv4 radio button.
Result: The PuTTY Configuration dialog box appears as in the following screen: 
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2.5. Click the Add button.
Result: The PuTTY Configuration dialog box appears as in the following screen:

3. In the PuTTY Configuration dialog box, select Connection.

3.1. In the Seconds between keepalives ... box, type 10.
Result: The PuTTY Configuration dialog box appears as in the following screen:

4. In the PuTTY Configuration dialog box, select Session. 

4.1. In the Host Name box type the address of the target D20MX, for example: 
192.168.230.100.
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4.2. In the Port box type the configured commandSSH port number on the D20MX 
(for example, 922).

4.3. Under Connection Type, select SSH.

4.4. Type a name in the Saved Sessions box (for example, PortFrw) and click Save.
You may use the saved session the next time a secure connection is needed 
and avoid having to re-enter the PuTTY configuration settings.
Result: The PuTTY Configuration dialog box appears as in the following screen:

4.5. Click the Open button.
Result: A Terminal window appears.
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5. Login as tom.

Result: The Login Banner appears and the D20M> prompt appears as shown in the 
following screen:

NOTE

Leave the PuTTY window open throughout a debugger session or back-to-back 
debugger sessions. Once you are all finished running the debugger, close the PuTTY 
window to close down the SSH tunnel. 

NOTE

When Tom logs in, a connection event is added to the User Log:. For example:

6 13/12/18 11:15:46 <Net OK > tom (SSH) - 
originip="192.168.230.120" originMac="D8:9D:B9:00:0B:9C"
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LogicLinx Editor configuration

To configure the LogicLinx editor to use the secure connection:

1. Start ConfigPro or SGConfig using “Run As Administrator”.

2. Open the Project containing the target D20MX device.

3. If using ConfigPro, open the target D20MX device.

4. Start the LogicLinx editor:

4.1. If using ConfigPro, right click on the LogicLinx icon under the Data Translation 
Applications tab and select Tools > LogicLinx Editor.

4.2. If using SGConfig, click LogicLinx under the Automation Applications node of 
the Applications List, and then click the LogicLinx Editor icon.
Result: The LogicLinx - Project Management window appears.

5. Double click the program icon or its name (e.g. main).

Result: The LogicLinx Programs window appears.

6. Click the Link Setup  icon.

Result: The PC-PLC link parameters dialog appears.

7. Set the Communication port box to ETHERNET.

Result: The PC-PLC link parameters dialog appears as in the following screen:

8. Change the Ethernet link parameters:

8.1. Click the Setup button.

8.2. Type 127.0.0.1 into the Internet address box.

8.3. Type the port number you entered in step 2.2.of section “PuTTY configuration” 
into the Port number box (for example: 1100).
Result: The ETHERNET link parameters dialog appears as shown in the following 
screen:

8.4. Click OK.

9. Connect the debugger by clicking the Debug  icon.

Result: The LogicLinx Debugger window appears and is connected to the target 
D20MX.
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NOTE

When Tom connects to the target D20MX, a port forward event is added to the User 
Log:. For example:

7 13/12/18 11:15:50 <SPF OK > tom (SSH) - Destination Port 
FW:127.0.0.1:1100
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D20MX Substation Controller

Appendix F: D20 Spare Cross-
Reference

D20 Spare Cross-Reference

This appendix cross references the old part numbers with the new smart catalogue 
numbers. For the most part, the smart catalogue numbers represented here only indicate 
the prefix or base-line for the complete smart order code. For the complete smart order 
code, you need to specify the selections for the various sub-components. 
Visit the online store for the appropriate spare parts and the rules governing sub-
component selections:

• D20MX Processor spare parts

• D20K Control Output Module spare parts

• D20S Status Input Module spare parts

• D20A Analog Input Module spare parts

• D20C Combination I/O Module spare parts 

• D20KI Interposer Relay Panel spare parts 

This appendix provides spare cross-reference tables for the following modules:

• “D20 spare parts modules, spare cross-reference” on page 191

• “D20A analog input modules, spare cross-reference” on page 193

• “D20C combination modules, spare cross-reference” on page 194

• “D20K control modules, spare cross-reference” on page 197

• “D20S status modules, spare cross-reference” on page 198

D20 spare parts modules, spare cross-reference

Spare part numbers are listed for:
• “Processors” on page 192
• “Modems” on page 192
• “Termination.” on page 192
• “Power supply” on page 192
• “Chassis” on page 192
In the below tables > Smart Part Number Prefix column:

X-X represents Firmware and Bootrom Choice respectively
U-U represents “Not Needed”
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Processors

Modems

NOTE

The 520-0120, 520-0120-CC, 520-0090 and 520-0090-CC modems are currently not 
supported by the D20MX

Termination.

Power supply

Chassis

Description Part Number Smart Catalog Number Prefix

D20MX CPU non VME 2x10/100/1000 BaseTX 526-3001 D20Mx-P-A-X-X

D20MX CPU non VME 2x100 BaseFX (Front Access) 526-3003 D20Mx-P-C-X-X

D20MX CPU non VME 2x100 BaseFX (Rear Access) 526-3005 D20Mx-P-G-X-X

Description Part Number Smart Catalog Number Prefix

WESDAC D20 202/V.23 Modem, bin mount 520-0120 D20ME-M-A-U-U

WESDAC D20 202/V.23 Modem, bin mount, 
conformal coated 

520-0120-CC D20ME-M-B-U-U

Modem, Telenetics 14.4K 2 wire Dialup, Bin mount 580-0771 D20ME-M-C-U-U

Modem, Telenetics 14.4K 4 wire Leased line, bin 
mount 

580-0772 D20ME-M-D-U-U

WESDAC 202/V.23 Modem, 19 inch rack mount 520-0090 D20ME-M-E-U-U

WESDAC 202/V.23 Modem, 19 inch rack mount, 
conformal coated 

520-0090-CC D20ME-M-F-U-U

Description Part Number Smart Catalog Number Prefix

WESTERM D20 termination Panel, Panel Mount, 15 
inch ribbon I/F cable 

517-0225 D20ME-T-A-U-U

WESTERM D20 termination Panel, Panel Mount, 15 
inch ribbon I/F cable, conformal coated 

517-0225-CC D20ME-T-D-U-U

WESTERM D20 termination Panel, Chassis Mount 517-0230 D20ME-T-B-U-U

WESTERM D20 termination Panel, Panel Mount, 24 
inch ribbon I/F cable

517-0300 D20ME-T-C-U-U

Description Part Number Smart Catalog Number Prefix

D20 Power Supply, 20-60VDC Input, 24V ISO Output 580-2004 D20ME-S-A-U-U

D20 Power Supply, 20-60VDC Input, 48V ISO Output 580-2005 D20ME-S-B-U-U

D20 Power Supply, 100-300VDC/85-264VAC Input, 
24V ISO Output 

580-2006 D20ME-S-C-U-U

D20 Power Supply, 100-300VDC/85-264VAC Input, 
48V ISO Output

580-2007 D20ME-S-D-U-U

Description Part Number Smart Catalog 
Number Prefix

D20 Chassis assembly non-VME 3U, single slot 500-0305 D20ME-C-A-U-U

D20 Chassis assembly VME 3U 500-0280 & Cover Plates D20ME-C-B-U-U

D20 Chassis assembly non-VME 3U, single slot, 
Conformal Coated 

500-0305-CC D20ME-C-C-U-U

D20 Chassis assembly VME 3U, Conformal Coated 500-0280-CC & Cover Plates D20ME-C-D-U-U
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D20A analog input modules, spare cross-reference

Legacy and new part numbers are listed for:

• “D20A WESTERM modules” on page 193

• “D20A WESDAC modules” on page 193

• “DNP3A WESDAC modules” on page 194

• “D20A adapter modules” on page 194

D20A WESTERM modules 

D20A WESDAC modules

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

517-0163 WESTERM D20A Type 1 Version 1 D20A-TL-P-U D20A 32 inputs, LV Power input (20-60VDC or D.20), 
compression termination

517-0163-CC WESTERM D20A Type 1 Version 1 
Conformal Coated

D20A-TL-P-C D20A 32 inputs, LV Power input (20-60VDC or D.20), 
compression termination, conformal coated

517-0240 WESTERM D20 AZ D20A-TH-P-U D20AZ 32 inputs, HV Power input (40-150VDC), 
compression termination

517-0240-CC WESTERM D20 AZ Conformal 
Coated

D20A-TH-P-C D20AZ 32 inputs, HV Power input (40-150VDC), 
compression termination, conformal coated

517-0240-ECC WESTERM D20 AZ - Epoxy 
Conformal Coated

D20A-TH-P-E D20AZ 32 inputs, HV Power input (40-150VDC), 
compression termination, epoxy conformal coated

517-0328 WESTERM D20AB D20A-TL-B-U D20AB 32 inputs, LV Power input (20-60VDC or D.20), 
barrier termination

517-0328-CC WESTERM D20AB Conformal 
Coated

D20A-TL-B-C D20AB 32 inputs, LV Power input (20-60VDC or D.20), 
barrier termination, conformal coated

517-0178 WESTERM D20 AD D20A-TL-D-U D20AD 32 inputs, LV Power input (20-60VDC or D.20), 
DB25 termination

517-0178-CC WESTERM D20 AD Conformal 
Coated

D20A-TL-D-C D20AD 32 inputs, LV Power input (20-60VDC or D.20), 
DB25 termination, conformal coated

517-0251 WESTERM D20 OAD D20A-TM-D-U D20OAD 32 inputs, LV Power Input (40-150VDC), DB25 
termination, redundant D.20 link and PS input

517-0216 WESTERM D20AX W/TB Plugs D20A-TL-X-U D20AX 32 inputs, LV Power input (20-60VDC or D.20), 
compression disconnect termination

517-0216-CC WESTERM D20AX W/TB Plugs 
Conformal Coated

D20A-TL-X-C D20AX 32 inputs, LV Power input (20-60VDC or D.20), 
compression disconnect termination, conformal 
coated

517-0364 WESTERM D20AZ Break Away W/
TBS

D20A-TH-X-U D20AZ 32 inputs, HV Power input (40-150VDC), 
compression disconnect termination

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

511-0101 WESDAC D20A Type 1 Version 1 D20A-DL-U-U WESDAC D20A LV

511-0101-CC WESDAC D20A Type 1 Version 1 
Conformal Coated

D20A-DL-U-C WESDAC D20A LV Conformal Coated

511-0103 WESDAC D20A HV2 D20A-DH-U-U WESDAC D20A HV

511-0103-CC WESDAC D20A HV2 Conformal 
Coated

D20A-DH-U-C WESDAC D20A HV Conformal Coated

511-0103-ECC WESTERM D20SX W/TB Plugs D20A-DH-U-E WESDAC D20A HV Epoxy Conformal Coated
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DNP3A WESDAC modules

D20A adapter modules

D20C combination modules, spare cross-reference

Legacy and new part numbers are listed for:

• “D20C WESTERM Modules” on page 195

• “D20C WESDAC modules” on page 195

• “DNP3C WESDAC modules” on page 195

• “D20C digital input adapter modules” on page 195

• “D20C first slot of analog adapter modules” on page 196

• “D20C second slot of analog adapter modules” on page 196

• “D20C output adapters” on page 197

• “D20C WESDAC daughter cards” on page 197

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

511-0301 DNP I/O Module - DC Analog Input D20A-3L-U-U WESDAC D20A LV, DNP3 Communications

511-0301 DNP I/O Module - DC Analog Input 
Conformal Coated

D20A-3L-U-C WESDAC D20A LV, DNP3 Communications, 
Conformal Coated

511-0303 DNP I/O Module - DC Analog Input HV D20A-3H-U-U WESDAC D20A HV, DNP3 Communications

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

530-0004 Analog Adaptor, I/P Voltage D20A-U-U-U-U-U-1-U-U Voltage Input adaptor - /+ 1, +/- 5, +/- 10 VDC (Set of 32: 
530-0004)

530-0005 Analog Adaptor, I/P 1MA/1V D20A-U-U-U-U-U-2-U-U 1 mA / 1V current input adaptor (Set of 32: 530-0005)

530-0045 Analog Adaptor, I/P 2MA/1V D20A-U-U-U-U-U-3-U-U 10 mA / 5V current input adaptor (Set of 32: 530-0045)

530-0050 1MA/5V I/P Analog Adaptor D20A-U-U-U-U-U-4-U-U 1 mA / 5V current input adaptor (Set of 32: 530-0050)

530-0025 1.2MA/1V I/P Analog Adaptor D20A-U-U-U-U-U-5-U-U  1.2 mA / 1V current input adaptor (Set of 32: 530-0025)

530-0051 Analog Adaptor, I/P (2MA/5V) D20A-U-U-U-U-U-6-U-U 2 mA / 5V current input adaptor (Set of 32: 530-0051)

530-0052 Analog Adaptor, I/P 20MA/5V D20A-U-U-U-U-U-7-U-U 20 mA / 5V current input adaptor (Set of 32: 530-0052)

530-0090 Analog Adaptor, I/P 1MA/5V D20A-U-U-U-U-U-9-U-U 1 mA / 5V current input adaptor, high precision (Set of 32: 
530-0090)

530-0095 Analog Adaptor, I/P 1.5MA/5V D20A-U-U-U-U-U-A-U-U 1.5 mA / 5V current input adaptor (Set of 32: 530-0095)

530-0108 Analog Adaptor, 2MA/5V I/P 
0.01%

D20A-U-U-U-U-U-B-U-U 2 mA / 5V current input adaptor, high precision 0.01% (Set 
of 32: 530-0108)

530-0003 Analog Adaptor, I/P 20MA/1V D20A-U-U-U-U-U-C-U-U 20mA/1V current input adaptor (Set of 32: 530-0003)

530-0030 1.5MA/1V I/P Analog Adaptor D20A-U-U-U-U-U-D-U-U 1.5 mA / 1V current input adaptor (Set of 32: 530-0030) 

530-0073 5MA/1V I/P Analog Adaptor D20A-U-U-U-U-U-G-U-U 5mA/1V current input adaptor (Set of 32: 530-0073)

530-0085  2.5MA/5V I/P Analog Adaptor )D20A-U-U-U-U-U-J-U-U 2.5mA/5V current input adaptor (Set of 32: 530-0085)

530-0091  1.1MA/5V I/P Analog Adaptor D20A-U-U-U-U-U-N-U-U 1.1mA/5V current input adaptor (Set of 32: 530-0091)

530-0094 Analog Adaptor, I/P 1.25MA/5V D20A-U-U-U-U-U-P-U-U 1.25mA/5V current input adaptor (Set of 32: 530-0094)

530-0131 Analog Adaptor 12.8MA/5V D20A-U-U-U-U-U-Q-U-U 12.8mA/5V current input adaptor (Set of 32: 530-0131)

530-0086 50MA/5V I/P Analog Adaptor D20A-U-U-U-U-U-H-U-U 50mA/5V current input adaptor (Set of 32: 530-0086)
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D20C WESTERM Modules

D20C WESDAC modules

DNP3C WESDAC modules

D20C digital input adapter modules

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

517-0169 WESTERM D20C Type 1 Version 1 D20CS-T-1 D20C LV (20-60VDC or D.20 Power), Compression 
Termination & DB25 for Interposer relays

517-0180 WESTERM D20 CD D20CS-T-2 D20CD LV (20-60VDC or D.20 Power), DB25 
Termination

517-0326 WESTERM D20 CB D20CS-T-3 D20CB LV (20-60VDC or D.20 Power), Barrier 
Termination & DB25 for Interposer relays

517-0217 WESTERM D20 CX W/TB Plugs D20CS-T-4 D20CX LV (20-60VDC or D.20 Power), Compression 
Disconnect Termination & DB25 for Interposer relays

517-0333 WESTERM D20 CDI, 48V D20CS-T-6 D20CDI LV (20-60VDC or D.20 Power), 48V Isolated 
Common & DB25 for Interposer relays 

517-0263 WESTERM D20 CDI, 130V D20CS-T-7 D20CDI LV (20-60VDC or D.20 Power), 130V Isolated 
Common & DB25 for Interposer relays (

517-0239 WESTERM D20 C4Z, 48V DI D20CS-T-8 D20C4Z HV 48V DI Compression Termination Analog 
Input Only

517-0325 WESTERM D20 C4Z2, 48V DI D20CS-T-5 D20C4Z HV 48V DI Compression Disconnect 
Termination

517-0253 WESTERM D20 C4Z 110V DI D20CS-T-9 D20C4Z HV 110V DI Compression Termination Analog 
Input Only

517-0362 WESTERM D20 C4Z2 24V DI D20CS-T-A D20C4Z2 HV 24V DI Compression Termination Analog 
Input & Output Allowed

517-0363 WESTERM D20 C4Z2 with Plugs, 
48V DI

D20CS-T-C D20C4Z2 HV 48V DI Compression Disconnect 
Termination

517-0267 WESTERM D20 C4Z2 (220V) D20CS-T-D D20C4Z2 HV 220V DI Compression Disconnect 
Termination

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

504-0002 WESDAC D20C+ D20CS-D-1 WESDAC D20C LV

504-0003 WESDAC D20C HV D20CS-D-2 WESDAC D20C HV

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

504-0302 DNP I/O LV Module - Combination D20CS-3-1 WESDAC D20C LV, DNP3 Communications

504-0303 DNP I/O HV Module - Combination D20CS-3-2 WESDAC D20C HV, DNP3 Communications

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

245-0031 D20 C 12V Digital Input Adapter D20CS-U-U-U-1-U-U-U-U-U-U-U 12V Digital Input Adapter [245-0031]

245-0030 (4x), 
245-0029 (2x)

D20 C 24V Digital Input Adapter D20CS-U-U-U-2-U-U-U-U-U-U-U 24V Digital Input Adapter [245-0030 (4x), 245-
0029 (2x)]

245-0004 D20 C 48V Digital Input Adapter D20CS-U-U-U-3-U-U-U-U-U-U-U 48V Digital Input Adapter [245-0004]

530-0133 D20 C 130V Digital Input Adapter 
for LV

D20CS-U-U-U-4-U-U-U-U-U-U-U 130V Digital Input Adapter for LV [530-0133]

245-0012 D20 C 220V Digital Input Adapter 
for HV

D20CS-U-U-U-5-U-U-U-U-U-U-U 130V Digital Input Adapter for HV [245-0012]
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D20C first slot of analog adapter modules

D20C second slot of analog adapter modules

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

530-0004 D20C Voltage Input Adapter D20CS-U-U-U-U-1-U-U-U-U-U-U Voltage Input Adapter [530-0004]

530-0087 0.1mA to 5V Current Input Adapter D20CS-U-U-U-U-2-U-U-U-U-U-U 0.1mA to 5V Current Input Adapter [530-0087]

530-0088 0.3mA to 5V Current Input Adapter D20CS-U-U-U-U-3-U-U-U-U-U-U 0.3mA to 5V Current Input Adapter [530-0088]

530-0089 0.5mA to 5V Current Input Adapter D20CS-U-U-U-U-4-U-U-U-U-U-U 0.5mA to 5V Current Input Adapter [530-0089]

530-0050 1 mA to 5V Current Input Adapter D20CS-U-U-U-U-5-U-U-U-U-U-U 1 mA to 5V Current Input Adapter [530-0050]

530-0090 1 mA to 5V Current Input Adapter 
[High Precision]

D20CS-U-U-U-U-6-U-U-U-U-U-U 1 mA to 5V Current Input Adapter [High 
Precision] [530-0090]

530-0091 1.1 mA to 5V Current Input Adapter D20CS-U-U-U-U-7-U-U-U-U-U-U 1.1 mA to 5V Current Input Adapter [530-0091]

530-0094 1.25 mA to 5V Current Input Adapter D20CS-U-U-U-U-8-U-U-U-U-U-U 1.25 mA to 5V Current Input Adapter [530-0094]

530-0095 1.5 mA to 5V Current Input Adapter D20CS-U-U-U-U-9-U-U-U-U-U-U 1.5 mA to 5V Current Input Adapter [530-0095]

530-0051 2 mA to 5V Current Input Adapter D20CS-U-U-U-U-A-U-U-U-U-U-U 2 mA to 5V Current Input Adapter [530-0051]

530-0108 2 mA to 5V Current Input Adapter 
[High Precision]

D20CS-U-U-U-U-B-U-U-U-U-U-U 2 mA to 5V Current Input Adapter [High 
Precision] [530-0108]

530-0086 2.5 mA to 5V Current Input Adapter D20CS-U-U-U-U-C-U-U-U-U-U-U 2.5 mA to 5V Current Input Adapter [530-0085]

530-0045 2mA to 1V Current Input Adapter D20CS-U-U-U-U-D-U-U-U-U-U-U 2mA to 1V Current Input Adapter [530-0045]

530-0131 12.8 mA to 5V Current Input Adapter D20CS-U-U-U-U-E-U-U-U-U-U-U 12.8 mA to 5V Current Input Adapter [530-0131]

530-0052 20 mA to 5V Current Input Adapter D20CS-U-U-U-U-F-U-U-U-U-U-U 20 mA to 5V Current Input Adapter [530-0052]

530-0086 50 mA to 5V Current Input Adapter D20CS-U-U-U-U-G-U-U-U-U-U-U 50 mA to 5V Current Input Adapter [530-0086]

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

530-0004 D20C Voltage Input Adapter D20CS-U-U-U-U-U-1-U-U-U-U-U Voltage Input Adapter [530-0004

530-0087 0.1mA to 5V Current Input Adapter D20CS-U-U-U-U-U-2-U-U-U-U-U 0.1mA to 5V Current Input Adapter [530-0087]

530-0088 0.3mA to 5V Current Input Adapter D20CS-U-U-U-U-U-3-U-U-U-U-U 0.3mA to 5V Current Input Adapter [530-0088]

530-0089 0.5mA to 5V Current Input Adapter D20CS-U-U-U-U-U-4-U-U-U-U-U 0.5mA to 5V Current Input Adapter [530-0089]

530-0050 1 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-5-U-U-U-U-U 1 mA to 5V Current Input Adapter [530-0050]

530-0090 1 mA to 5V Current Input Adapter 
[High Precision]

D20CS-U-U-U-U-U-6-U-U-U-U-U 1 mA to 5V Current Input Adapter [High 
Precision] [530-0090]

530-0091 1.1 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-7-U-U-U-U-U 1.1 mA to 5V Current Input Adapter [530-0091]

530-0094 1.25 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-8-U-U-U-U-U 1.25 mA to 5V Current Input Adapter [530-0094]

530-0095 1.5 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-9-U-U-U-U-U 1.5 mA to 5V Current Input Adapter [530-0095]

530-0051 2 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-A-U-U-U-U-U 2 mA to 5V Current Input Adapter [530-0051]

530-0108 2 mA to 5V Current Input Adapter 
[High Precision]

D20CS-U-U-U-U-U-B-U-U-U-U-U 2 mA to 5V Current Input Adapter [High 
Precision] [530-0108]

530-0086 2.5 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-C-U-U-U-U-U .5 mA to 5V Current Input Adapter [530-0086]

530-0045 2mA to 1V Current Input Adapter D20CS-U-U-U-U-U-D-U-U-U-U-U 2mA to 1V Current Input Adapter [530-0045]

530-0131 12.8 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-E-U-U-U-U-U 12.8 mA to 5V Current Input Adapter [530-0131]

530-0052 20 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-F-U-U-U-U-U 20 mA to 5V Current Input Adapter [530-0052]

530-0086 50 mA to 5V Current Input Adapter D20CS-U-U-U-U-U-G-U-U-U-U-U 50 mA to 5V Current Input Adapter [530-0086]
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D20C output adapters

D20C WESDAC daughter cards

D20K control modules, spare cross-reference

Legacy and new part numbers are listed for:

• “D20K WESTERM modules” on page 197

• “D20K WESDAC modules” on page 198

• “DNP3k WESDAC modules” on page 198

D20K WESTERM modules

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

530-0083 Voltage Output Adapter D20CS-U-U-U-U-U-H-U-U-U-U-U Voltage Output Adapter [530-0083]

530-0079 1mA Current Output Adapter D20CS-U-U-U-U-U-I-U-U-U-U-U 1mA Current Output Adapter [530-0079]

530-0080 5mA Current Output Adapter D20CS-U-U-U-U-U-J-U-U-U-U-U 5mA Current Output Adapter [530-0080]

530-0081 10mA Current Output Adapter D20CS-U-U-U-U-U-K-U-U-U-U-U 10mA Current Output Adapter [530-0081]

530-0082 20mA Current Output Adapter D20CS-U-U-U-U-U-L-U-U-U-U-U 20mA Current Output Adapter [530-0082]

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

540-0162 WESDAC D20C D.20 Wesmaint 
Interface (LV)

D20CS-U-U-U-U-U-U-U-U-U-U-A WESDAC D20C LV Wesmaint Interface Module 
[540-0162]

540-0209 WESDAC D20C D.20 Wesmaint 
Interface (HV)

D20CS-U-U-U-U-U-U-U-U-U-U-B WESDAC D20C HV Wesmaint Interface Module 
[540-0209

540-0166 WESDAC D20C Analog I/O D20CS-U-U-U-U-U-U-U-U-U-U-C WESDAC D20C LV 8 Analog Input / 8 Analog 
Output Expansion Module [540-0166]

540-0159 WESDAC D20C Analog I/P (LV) D20CS-U-U-U-U-U-U-U-U-U-U-D WESDAC D20C LV 16 Analog Input Expansion 
Module [540-0159]

540-0205 WESDAC D20C Analog I/P (HV) D20CS-U-U-U-U-U-U-U-U-U-U-E WESDAC D20C HV 16 Analog Input Expansion 
Module [540-0205]

540-0227 WESDAC D20 CHV Analog I/O DB D20CS-U-U-U-U-U-U-U-U-U-U-F WESDAC D20C HV 8 Analog Input / 8 Analog 
Output Expansion Module [540-0227]

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

517-0164 WESTERM D20K Type 1 Version 1 D20K-TL-P-UU D20K LV (20-60VDC or D.20 Power), Compression 
Termination

517-0164-CC WESTERM D20K Type 1 Version 1 
(Conformal Coated)

D20K-TL-P-CU D20K LV (20-60VDC or D.20 Power), Compression 
Termination, Conformal Coated

517-0143 WESTERM D20 KR D20K-TL-D-UU D20KR LV (20-60VDC or D.20 Power), DB25 
Termination

517-0143-CC WESTERM D20 KR (Conformal 
Coated)

D20K-TL-D-CU D20KR LV (20-60VDC or D.20 Power), DB25 
Termination, Conformal Coated

517-0218 WESTERM D20KX W/TB Plugs D20K-TL-X-UU D20KX LV (20-60VDC or D.20 Power), Compression 
Disconnect Termination

517-0218-CC WESTERM D20KX W/TB Plugs 
(Conformal Coated)

D20K-TL-X-CU D20KX LV (20-60VDC or D.20 Power), Compression 
Disconnect Termination, Conformal Coated

517-0242 WESTERM D20 K4Z D20K-TH-P-UU D20K4Z HV (40-150VDC or D.20 Power), Compression 
Termination
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D20K WESDAC modules

DNP3k WESDAC modules

D20S status modules, spare cross-reference

Legacy and new part numbers are listed for:

• “D20S WESTERM modules” on page 198

• “D20S WESDAC modules” on page 199

• “DNP3S WESDAC modules” on page 200

• “D20S RNET adapter pack” on page 200

D20S WESTERM modules

517-0242-CC WESTERM D20 K4Z (Conformal 
Coated)

D20K-TH-P-CU D20K4Z HV (40-150VDC or D.20 Power), Compression 
termination, Conformal Coated

517-0242 - ECC WESTERM D20 K4Z - Epoxy 
Conformal Coat

D20K-TH-P-EU D20K4Z HV (40-150VDC or D.20 Power), Compression 
Termination, Epoxy Conformal Coated

517-0220 WESTERM D20KR Type 2 D20K-TL-D-UW D20KR TYPE 2 LV (20-60VDC or D.20 Power), DB25 
Termination with Wire-Wrap adapter option

517-0250 WESTERM D20 OKR D20K-TL-D-UR D20 OKR LV (20-60VDC or D.20 input), Compression 
Termination, redundant D.20 and PS Input

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

508-0101 WESDAC D20K Type 1 Version 1 D20K-DL-U-UU WESDAC D20K LV

508-0101-CC WESDAC D20K Type 1 Version 1 
(Conformal Coated)

D20K-DL-U-CU WESDAC D20K LV, Conformal Coated

508-0102 WESDAC D20K HV D20K-DH-U-UU WESDAC D20K HV

508-0102-CC WESDAC D20K HV (Conformal Coated) D20K-DH-U-CU WESDAC D20K HV, Conformal Coated

508-0102-ECC WESDAC D20 KHV - Epoxy Conformal 
Coat

D20K-DH-U-EU WESDAC D20K HV, Epoxy Conformal 
Coated

Legacy Part Number Description New Part Number - Smart 
Catalog Number Prefix

Description

508-0301 DNP I/O Module - Control D20K-3L-U-UU WESDAC D20K LV, DNP3 Communications

508-0301-CC DNP I/O Module - Control 
(Conformal Coated)

D20K-3L-U-CU WESDAC D20K LV, DNP3 Communications, 
Conformal Coated

508-0302 DNP I/O Module - Control HV D20K-3H-U-UU WESDAC D20K HV, DNP3 Communications

508-0302-CC DNP I/O Module - Control HV 
(Conformal Coated)

D20K-3H-U-CU WESDAC D20K HV, DNP3 Communications, 
Conformal Coated

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description

517-0165 WESTERM D20S Type 1 Version 1 D20S-TL-P-U-S D20S LV (20-60VDC or D.20 Power) Compression 
Termination

517-0165-CC WESTERM D20S Type 1 Version 1 
- Conformal Coated

D20S-TL-P-C-S) D20S LV (20-60VDC or D.20 Power) Compression 
Termination, Conformal Coated

517-0165-ECC WESTERM D20S Type 1 Version 1 
- Epoxy Conformal Coated

D20S-TL-P-E-S D20S LV (20-60VDC or D.20 Power) Compression 
Termination, Epoxy Conformal Coated
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D20S WESDAC modules

517-0179 WESTERM D20 SD D20S-TL-D-U-S D20SD LV (20-60VDC or D.20 Power) DB25 
Termination

517-0179-CC WESTERM D20 SD - Conformal 
Coated

D20S-TL-D-C-S D20SD LV (20-60VDC or D.20 Power) DB25 
Termination, Conformal Coated

517-0179-ECC WESTERM D20 SD - Epoxy 
Conformal Coated

D20S-TL-D-E-S D20SD LV (20-60VDC or D.20 Power) DB25 
Termination, Epoxy Conformal Coated

517-0219 WESTERM D20SX W/TB Plugs D20S-TL-X-U-S D20SX LV (20-60VDC or D.20 Power) Compression/
Disconnect Termination

517-0219-CC WESTERM D20SX W/TB Plugs - 
Conformal Coated

D20S-TL-X-C-S D20SX LV (20-60VDC or D.20 Power) Compression/
Disconnect Termination Conformal Coated

517-0219-ECC WESTERM D20SX W/TB Plugs - 
Epoxy Conformal Coated

D20S-TL-X-E-S D20SX LV (20-60VDC or D.20 Power) Compression/
Disconnect Termination Epoxy Conformal Coated

517-0327 WESTERM D20SB D20S-TL-B-U-S D20SB LV (20-60VDC or D.20 Power) Barrier 
Termination

517-0327-CC WESTERM D20SB - Conformal 
Coated

D20S-TL-B-C-S D20SB LV (20-60VDC or D.20 Power) Barrier 
Termination, Conformal Coated

517-0327-ECC WESTERM D20SB - Epoxy 
Conformal Coated

D20S-TL-B-E-S D20SB LV (20-60VDC or D.20 Power) Barrier 
Termination, Epoxy Conformal Coated

517-0330 WESTERM D20 SDI, 24V D20S-TL-D-U-I-024 D20SDI-24 LV (20-60VDC or D.20 Power) DB25 
Termination

517-0331 WESTERM D20 SDI, 48V D20S-TL-D-U-I-048 D20SDI-48 LV (20-60VDC or D.20 Power) DB25 
Termination

517-0262 WESTERM D20 SDI, 125V D20S-TL-D-U-I-125 D20SDI-125 LV (20-60VDC or D.20 Power) DB25 
Termination

517-0252 WESTERM D20 OSD D20S-TM-D-U-G-048 D20 OSD LV (20-60VDC or D.20 Power), DB25 
Termination, Redundant D.20 and PS Input

517-0241 WESTERM D20 SZ 48V D20S-TH-P-U-G-048 D20SZ HV (40-150 VDC Power) Compression 
Termination

517-0241-CC WESTERM D20 SZ 48V - 
Conformal Coated

D20S-TH-P-C-G-048 D20SZ HV (40-150 VDC Power) Compression 
Termination, Conformal Coated

517-0249 WESTERM D20 SZ 110V D20S-TH-P-U-G-110 D20SZ HV (40-150 VDC Power) Compression 
Termination

517-0249-ECC WESTERM D20 SZ 110V - Epoxy 
Conformal Coated

D20S-TH-P-E-G-110 D20SZ HV (40-150 VDC Power) Compression 
Termination, Epoxy Conformal Coated

517-0266 WESTERM D20 SZ2 (110/220V) D20S--THP-U-S D20SZ HV (40-150 VDC Power) Compression 
Termination

517-0366 WESTERM D20 SZ with Plugs(48V) D20S-TH-X-U-G-048 D20SZ HV (40-150 VDC Power) Compression/
Disconnect Termination

517-0377 WESTERM D20 SZ with Plugs 
(24V)

D20S-TH-X-U-G-024 D20SZ HV (40-150 VDC Power) Compression 
Termination

Legacy Part Number Description New Part Number - Smart 
Catalog Number Prefix

Description

507-0101 WESDAC D20S Type 1 Version 1 D20S-DL-U-U-U WESDAC D20S LV

507-0101-CC WESDAC D20S Type 1 Version 1- 
Conformal Coated

D20S-DL-U-U-C WESDAC D20S LV Conformal Coated

507-0103 WESDAC D20S HV2 D20S-DH-U-U-U WESDAC D20S HV

507-0103-CC WESDAC D20S HV2 - Conformal 
Coated

D20S-DH-U-U-C WESDAC D20S HV Conformal Coated

507-0103-ECC WESDAC D20S HV2 - Epoxy 
Conformal Coated

D20S-DH-U-U-E WESDAC D20S HV Epoxy Conformal 
Coated

Legacy Part 
Number

Description New Part Number - Smart 
Catalog Number Prefix

Description
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DNP3S WESDAC modules

D20S RNET adapter pack

Legacy Part Number Description New Part Number - Smart 
Catalog Number Prefix

Description

507-0301 DNP I/O Module - Digital Input D20S-3L-U-U-U WESDAC D20S LV, DNP3 Communications

507-0301-CC DNP I/O Module - Digital Input - 
Conformal Coated

D20S-3L-U-U-C WESDAC D20S LV, DNP3 Communications, 
Conformal Coated

507-0303 DNP I/O Module - Digital Input HV D20S-3H-U-U-U WESDAC D20S HV, DNP3 Communications

507-0303-CC DNP I/O Module - Digital Input HV 
- Conformal Coated

D20S-3H-U-U-C WESDAC D20S HV, DNP3 Communications, 
Conformal Coated

Legacy Part Number Description New Part Number - Smart 
Catalog Number Prefix

Description

245-0009 12V Digital Input Adapter D20S-U-U-U-U-U-012-U-U-U 12 V Digital Input Adapter - Set of 25

245-0030 24V Digital Input Adapter D20S-U-U-U-U-U-024-U-U-U 24 V Digital Input Adapter - Set of 17

245-0029 24V Digital Input Adapter D20S-U-U-U-U-U-024-U-U-U 24 V Digital Input Adapter - Set of 8

245-0004 48V Digital Input Adapter D20S-U-U-U-U-U-048-U-U-U 48 V Digital Input Adapter - Set of 25

245-0012 110V Digital Input Adapter D20S-U-U-U-U-U-110-U-U-U 110 V Digital Input Adapter - Set of 24

530-0133 125V Digital Input Adapter D20S-U-U-U-U-U-125-U-U-U 125 V Digital Input Adapter - Set of 25

530-0133 220V Digital Input Adapter D20S-U-U-U-U-U-220-U-U-U 220 V Digital Input Adapter - Set of 24
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Appendix G: Product Combinations

Product Combinations

The D20MX is available in three versions:

• 526-3001LF: D20MX CPU, 2 x 10/100/1000 Base TX Front Access ports (RJ45)

• 526-3003LF: D20MX CPU, 2 x 100 Base FX Front access ports (ST Connectors)

• 526-3005LF: D20MX CPU, 2 x 100 Base FX Rear Access ports (ST Connectors)

This appendix describes the compatibility of the D20MX (3 versions) with the D20 products.

Module compatibility

Only one D20MX processor module can be installed in a D20. Additional D20MX processor 
modules are not required and are not compatible.
The D20MX does not require and is not compatible with D20ME Memory Expansion and 
Media Interface Modules.
Use the following tables to check the compatibility of the components you want to 
combine:

• “D20 VME Chassis Compatibility” on page 202

• “D20 Non-VME Chassis Compatibility” on page 202

• “Modem Compatibility” on page 202

• “D20A Analog Input Module Compatibility” on page 202

• “D20S Status Input Module Compatibility” on page 203

• “D20K Control Output Module Compatibility” on page 203

• “D20C Combination Input/Output Module Compatibility” on page 203

• “D20AC Input Module Compatibility” on page 203
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Table 82: D20 VME Chassis Compatibility

NOTE

* 0V cable required from Westerm to Backplane

Table 83: D20 Non-VME Chassis Compatibility

Table 84: Modem Compatibility

Table 85: D20A Analog Input Module Compatibility

Component GE Item # Description Compatible 
Releases

Chassis 500-0280* Chassis Assembly D20 M (VME 3U) REL 16A or higher

Backplane 517-0123 WESTERM D20 M VME REL 03 or higher

WESTERM 517-0225 WESTERM D20M+, Panel Mount REL 09 or higher

517-0230 WESTERM D20 Assembly, Chassis Mount  All

Power Supply 580-2004 D20 Power Supply, 20-60VDC IN, 24V ISO Out  All

580-2005 D20 Power Supply, 20-60VDC In, 48V ISO Out  All

580-2006 D20 PS, 85-300VDC/85-264VAC In, 24V ISO Out  All

580-2007 D20 PS, 85-300VDC or 85-264VAC In, 48V ISO Out  All

Component GE Item # Description Compatible 
Releases

Chassis 500-0305 Chassis, D20M+ Single Slot REL 26 or higher

Westerm 517-0224 WESTERM D20M+, Single Slot REL 15 or higher

Power Supply 580-2004 D20 Power Supply, 20 to 60VDC In, 24V ISO Out  All

580-2005 D20 Power Supply, 20 to 60VDC In, 48V ISO Out  All

580-2006 D20 Power Supply, 85 to 300VDC or 85 to 264VAC 
In, 24V ISO Out

 All

580-2007 D20 Power Supply, 85 to 300VDC or 85 to 264VAC 
In, 48V ISO Out

 All

Component GE Item # Description Compatible Unit

BIN 520-0120 WESDAC D20 202/V.23 Modem  None

BIN 580-0771 Modem, Telenetics 14.4K DIALUP All

Stand-alone 580-2062 WESTERMO IND Telemodem, TD-34 LV Dial-up PASS

Component GE Item # Description Compatible 
Releases

WESDAC 511-0101 WESDAC D20A Type 1 Version 1 REL 21 or higher

WESTERM 517-0163 WESTERM D20A Type 1 Version 1  All

517-0178 WESTERM D20 AD  All

2nd D.20 card 540-0207 WESDAC D20 ASK D.20 Interface  All

PCOMMON 306 PCOMMON v3.06  All

305 PCOMMON v3.05  All

301 PCOMMON v3.01  All

300 PCOMMON v3.00  All
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Table 86: D20S Status Input Module Compatibility

Table 87: D20K Control Output Module Compatibility

Table 88: D20C Combination Input/Output Module Compatibility

Table 89: D20AC Input Module Compatibility

Component GE Item # Description Compatible 
Releases

WESDAC 507-0101 WESDAC D20S Type 1 Version 1 REL 18 or higher

WESTERM 517-0165 WESTERM D20S Type 1 Version 1  All

2nd D.20 card 540-0207 WESDAC D20 ASK D.20 Interface  All

PCOMMON 306 PCOMMON v3.06  All

305 PCOMMON v3.05  All

301 PCOMMON v3.01  All

300 PCOMMON v3.00  All

Component GE Item # Description Compatible 
Releases

WESDAC 508-0101 WESDAC D20K Type 1 Version 1 REL 17 or higher

WESTERM
2nd D.20 card

517-0164 WESTERM D20K Type 1 Version 1  All

540-0207 WESDAC D20 ASK D.20 Interface  All

PCOMMON 306 PCOMMON v3.06  All

305 PCOMMON v3.05  All

301 PCOMMON v3.01  All

300 PCOMMON v3.00  All

Component GE Item # Description Compatible 
Releases

WESDAC 504-0002 WESDAC D20C+ REL 20 or higher

WESTERM 517-0180 WESTERM D20 CD  All

2nd D.20 card 540-0209 WESDAC D20C D.20/WESMAINT Interface  All

PCOMMON 305 PCOMMON v3.05  All

300 PCOMMON v3.00  All

Component GE Item # Description Compatible 
Releases

WESDAC 511-0106 WESDAC D20 AC 20 to 60V All

WESTERM 517-0370 WESTERM D20 AC 3V/3I All

2nd D.20 card 540-0207 WESDAC D20 ASK D.20 Interface All

pBOOT 104 pBOOT 1.04 All

103 pBOOT 1.03 All

102 pBOOT 1.02 All



204 GE INFORMATION D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL

APPENDIX G: PRODUCT COMBINATIONS



D20MX SUBSTATION CONTROLLER INSTRUCTION MANUAL GE INFORMATION 205

D20MX Substation Controller

Appendix H: WESMAINT Error Log 
Messages

WESMAINT Error Log Messages

This appendix describes all WESMAINT messages logged by the system that are not 
described in any application Configuration Guide. This appendix includes error messages 
for the Internet Protocol Stack (B100) and ROOT; where ROOT is the process that launches 
D20MX applications.
Messages are displayed by the WESMAINT logger in the following format:

<P-NAME>: <MESSAGE>
where:

P-NAME is the process name as displayed by the SHELL.
MESSAGE is the actual message as described in the following tables.

For the Internet Protocol Stack, the process name is either B100 or ROOT. 
For ROOT, this process name is ROOT. 
Messages logged to the WESMAINT Error Log are classified in three categories: 

• Informational messages

• Fatal error messages 

• Warnings

Use the following tables to find the cause and remedy for these messages:

• Table 90, “Internet Protocol Stack error messages: cause and remedy”

• Table 91, “ROOT error messages: cause and remedy”
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Table 90: Internet Protocol Stack error messages: cause and remedy

Message Cause Remedy

Error Messages

E3: Unable to 
create interface 
table <x>

The Internet Protocol Stack was unable to 
create the Interface Current Table (B100CURR) 
in NVRAM. The table create attempt failed with 
a system error code of <x>.

Contact GE Digital Energy 
Technical Support and report 
this error.

E4: Memory alloc 
failure <Size=<x>>

The application was unable to allocate <x> 
bytes of RAM for the run-time structures 
required.

Contact GE Digital Energy 
Technical Support and report 
this error.

E18: Interface x 
cannot be added - 
table full.

The Internet Protocol Stack needed to add 
interface "x" to the B100CURR table, but the 
table was full. The table was designed to handle 
a maximum of eight interfaces.

Contact GE Digital Energy 
Technical Support and report 
this error.

E24: x route dst y 
socket err <z>

The Internet Protocol Stack failed to perform 
the operation "x" (ADD or DEL) to the route 
indicated by "y" due to a socket() function error 
<z>.

Contact GE Digital Energy 
Technical Support and report 
this error.

E25: x route dest y 
- send err <z>

The Internet Protocol Stack failed to perform 
the operation "x" (ADD or DEL) to the route 
indicated by y due to a send() function error <z>. 

Contact GE Digital Energy 
Technical Support and report 
this error.

E30: x route dest y 
- mesg err <code>.

The Internet Protocol Stack failed to perform 
the operation "x" (ADD or DEL) to the route 
indicated by y due to error indicated by routing 
message response <z>.

Contact GE Digital Energy 
Technical Support and report 
this error.

E31: x route dest y 
- recv err <code>

The Internet Protocol Stack failed to perform 
the operation "x" (ADD or DEL) to the route 
indicated by y due to a recv() function error <z>. 

Change the IP address for the 
Ethernet interface as 
indicated in the "Cause" 
paragraph.

Warning Messages

W11: Configured 
interface <x> does 
not exist

Table B100_IF has a configured interface type 
which is not supported by any network 
interface drivers present on this host, OR has a 
configured interface type which is supported, 
but has a unit number which exceeds the 
maximum number of units supported by the 
network interface driver.

Contact GE Digital Energy 
Technical Support and report 
this error.

W12: Configured 
interface <x> has 
invalid name

Table B100_IF has a configured interface type 
which is not 2 characters in length, or a unit 
number which is outside the range of 1 to 99.

Contact GE Digital Energy 
Technical Support and report 
this error.

Information Messages

I7: Device <x>:  
IP=<y>  
Netmask=<z>

The interface named <x> has been successfully 
assigned an IP address and netmask.

N/A

I8: BOOTP is not 
supported

A configuration with BOOTP Client enabled was 
downloaded to the D20MX.

In the BOOTP Settings of the 
D20 device properties, ensure 
Not Used is checked.
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Table 91: ROOT error messages: cause and remedy

Message Cause Remedy

Error Messages

E301: Licensed 
application <x> 
NOT started - 
Group:<y>

Licensed application is configured but not 
started, because correct software license is 
not available. Where <x> is application 
name and <y> is Group ID

1)   Disable the application in the 
configuration.
2)   Enable the trial period for the 
group. See “Software (feature) 
licensing” on page 101.
3)   Purchase a license for the 
group (Contact GE Digital Energy 
Technical Support for further 
information)

E302a: <x> 
Licensed 
application was 
NOT started

Applications are not started due to 
licensing issues, where x is the number of 
applications

E302 errors will be preceded by 
one or more E301 errors. Once all 
E301 errors have been resolved, 
the E302 error will no longer occur.

E302b: System not 
operating correctly

System is not operating correctly because 
correct software license is not available. 
Even applications that are not licensed 
may fail to start.

Warning Messages

W1: Pri & Sec F/W 
differ. Type 
COMMIT or REVERT 
in SHELL

There are different firmware versions in 
primary and secondary storage locations

Type commit in the D20M Shell to 
commit the firmware to secondary 
storage. See “Committing new 
firmware” on page 82.
Type revert in the D20M Shell to 
recover the previous version of the 
firmware. See “Reverting to old 
firmware” on page 83.

W001: IP of <x> 
same as CCUA
or
W001: IP of <x> 
same as CCUB

When transferring a redundant D20 in a 
ConfigPro or SGConfig project 
configuration to a D20MX the new D20MX 
standby IP addresses conflict with other 
devices in the project, where <x> is the host 
name of the device with a conflicting IP 
address.

Disable the standby IP addresses 
or reassign them. See “IP 
addresses” on page 60.
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Appendix H: List of Acronyms

List of Acronyms

Acronym Definitions

This Appendix lists and defines the acronyms used in this manual.

Table 92: Acronym list

Acronym Definition

A Amperes, unit of measure

AEL Accessible Emission Limit

ANSI American National Standards Institute

ASCII American Standard Code for Information Interchange

ASDU Application Service Data Units

AWG American Wire Gauge, unit of measure

bps bits per second, unit of measure

CCU Central Control Unit

CE Mark Mandatory conformity mark for products placed on the market in the 
European Economic Area (EEA)

CISPR Special international committee on radio interference

COM1/COM2 Communications port

CPU Central Processing Unit

CTS Clear To Send

dBm decibel-milliwatt, unit of measure - an electrical power unit in decibel (dB)

DCA Data Collection Application

DCD Data Carrier Detect

DNP Distributed Network Protocol

DoC Declaration of Conformity: States which CE mark directive(s) has been met and 
includes a signature of a company official indicating the company's 
responsibility for its CE mark compliance claim.

DPA Data Processing Application

DST Daylight Saving Time
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DTA Data Transmission Application

DTE Data Terminal Equipment

EIA Electronic Industries Alliance

EMC Electromagnetic Capability

EMI Electromagnetic Interference

EPLD Erasable Programmable Logic Device 

EPUP Environmental Protection Use Period

ESD ElectroStatic Discharge

EU European Union

FEFI Far End Fault

FPGA Field-Programmable Gate Array

GE General Electric

GFO Glass Fiber Optic

GOF glass optical fiber

HCS Hard Clad Silica

HDLC High-level Data Link Control

HMI Human Machine Interface (also called Graphical User Interface – GUI)

HSP Hardware Support Package

Hz Hertz, unit of measure for frequency

I/O Input/Output

IEC International Electrotechnical Commission Standards

IED Intelligent Electronic Device

ILS Instrument Landing System

in-lb inch-pound, unit of measure for energy

IRIG-B Inter Range Instrumentation Group (IRIG) - an American standardized network 
time code format

kbps kilo bits per second, unit of measure

LAN Local Area Network

lb pound, unit of measure for weight

LC Lucent connector; A type of fiber-optic cable connector

LED Light Emitting Diode

LLA Loss Link Alert

LRU Logical Remote Unit

LV Low Voltage

LVD Low Voltage Directives (CE Mark)

Mb Mega bits, unit of measure

MB Mega bytes, unit of measure

Mbps Mega bits per second, unit of measure

MBps Mega bytes per second, unit of measure

MCV Maximum Concentration Values

MD5 Message Digest 5 (check data integrity)

MDI Medium Dependent Interface

MDIX Medium Dependent Interface, Crossover

ms milliseconds, unit of measure

Nm Newton-meter, measure of energy

NTP Network Time Protocol

NVRAM Non-Volatile Random Access Memory

Acronym Definition
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PC Personal Computer

PCBA Printed Circuit Board Assembly

PFO Plastic Fiber Optic

PG&E Pacific Gas and Electric

PID Proportional, Integral and Derivative

PIM Privileged Identity Management

PPM Parts Per Million

pSOS Type of operating system

RMA Return Merchandise Authorization

RoHS Restriction of Hazardous Substances

RTC Real Time Clock

RTS Request To Send

RTU Remote Terminal Unit

RU Rack Unit

Rx Receive

RXD Receive Data

SA COM  Serial Analyze Communications

SCADA Supervisory Control and Data Acquisition

SCP Secure Copy application

SEL Schweitzer Engineering Laboratories

SNTP Simple Network Time Protocol

SOE Sequence Of Events

SQL™ Structured Query Language

SRU Sub-Remote Unit

ST Straight Tip connector; A type of fiber-optic cable connector

STP Spanning Tree Protocol

TIA Telecommunication Industries Association

Tx Transmit

TXD Transmit Data

UART Universal Asynchronous Receiver-Transmitter

UPC Universal Protocol Converter

UTC Universal Time Coordination

UTP Unshielded Twisted Pair

VA Volt Amps, unit of measure

V AC Volts, Alternating Current, unit of measure

V DC Volts, Direct Current, unit of measure

VME Versa Module Eurocard

WinSCP Windows Secure CoPy

Acronym Definition
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Appendix I: Miscellaneous

Miscellaneous

This appendix provides the warranty and revision history.

Warranty

For products shipped as of 1 October 2013, GE Digital Energy warrants most of its GE 
manufactured products for 10 years. For warranty details including any limitations and 
disclaimers, see the GE Digital Energy Terms and Conditions at  
https://www.gedigitalenergy.com/multilin/warranty.htm

For products shipped before 1 October 2013, the standard 24-month warranty applies.

Revision history

Version Revision Date  Change Description

1.00 0 October 17, 2012 Original release of this document. 

1 November 6, 2012 Updated D20 applications table and added Firmware/FPGA versions 
table.

2 November 23, 2012 Added sections for: Update to the SAN0001 firmware option, Transfer 
D20/D200 configurations to the D20MX, and Updating D20/D200 
Configurations to use the D20MX firmware definition with ConfigPro.
Added an Appendix for Resetting a read/write user password.

3 January 11, 2013 Updated procedures for configuring redundant D20MX devices in the 
Software Configuration chapter.

1.10 0 March 1, 2013 Updated the D20MX applications table.
Added Migrate D20MX application definitions to SGConfig section.

1.20 0 July 15, 2013 Updated the D20MX application tables, order code table, upgrade kit 
order code table, procedures in Chapter 5, and Added Appendix D. 

1.21 0 September 13, 2013 Updated for firmware version 1.21. 

https://www.gedigitalenergy.com/multilin/warranty.htm
https://www.gedigitalenergy.com/multilin/warranty.htm
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1.30 0 January 7, 2013 Renamed to the D20MX Instruction manual.
Added Chapter 8: Removing Configuration Data and Sensitive 
Information from the D20MX.
Added Appendix E: Secure Connection for LogicLinx.
Updated for firmware version 1.30. 

1.31 0 March 13, 2014 Updated for firmware version 1.31. 

1.32 0 May 7, 2014 Updated for firmware version 1.32. 

1 May 16, 2014 Updated for firmware version 1.32 revision 1. 

1.3x 0 July 10, 2014 Updated for firmware version 1.33 revision 0. 

1.4x 0 Sep 2, 2014 Updated for firmware version 1.40 revision 0. 

1 Sep 11, 2014 Changed Note in Twisted Pair Ethernet connection for STP.

2 Feb 27, 2015 Added content to the Grounding the D20MX section regarding 
potential electrical surge or ESD damage.
Added content to the RS-232 section regarding use of both the front 
and rear RS-232 ports.
Updated Appendix: Default Role-based Access Control Module for 
Read Access tables > Not Used bits for some applications. 

1.5x 0 July  6, 201 Updated for firmware version 1.5x revision 0. 
Added serial expansion.

Version Revision Date  Change Description
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